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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Welcome to this Guide
Welcome to HP ALMLabManagement. LabManagement allows users tomanage the lab resources
and systems they use for Functional and Performance testing in ALM.

This guide describes how to use the LabManagement project. It provides descriptive and
conceptual information, step-by-step guidance to help you work with the project, and explanations
of reference-orientedmaterial.

How This Guide is Organized
TheHP ALM LabManagement Guide contains the following parts:

Part Description

"LabManagement
Administration" on
page 21

Describes how to perform LabManagement Administration.

Relevant tasks: "How to Create LabManagement Administrators" on
page 21 and "How toWork with LabManagement Administration" on
page 22.

"Project Settings" on
page 29

Describes how to define andmanage project settings.

Relevant task: "How to Create a Project" on page 30

"Maintenance Tasks"
on page 49

Describes how tomanage the automated tasks that monitor the key
system components.

"Lab Resources" on
page 55

Describes how to define andmanage testing hosts, host pools, MI
Listeners, and arrange for timeslot testing.

Relevant task: "How toManage Lab Resources" on page 57

"PC Test Runs" on
page 105

Describes how to view information for PC test runs.

"Usage Reports" on
page 113

Describes how to view and analyze information about Performance
Center site users and resource usage.

Relevant task: "How to View Reports and Set Report Filter Criteria" on
page 114

"System Health" on
page 137

Describes how tomonitor the health of the components of the system.

Relevant task: "Maintenance Tasks Overview" on page 49

"PC Licenses" on
page 141

Describes how to define and view PC licenses.

Relevant task: "How toWork with LabManagement Administration" on
page 22
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Part Description

"Diagnostics
Management" on
page 149

Describes how to view diagnostic information about the performance of
complex environments.

Relevant task: "How to Add HP Diagnostics Servers" on page 152

"PatchManagement"
on page 167

Describes how to upload and install patches on hosts.

Relevant task: "How to Upload Patches to ALM" on page 167

"AUT Host
Management" on
page 175

Describes how to create,view, andmanage AUT hosts and AUT host
pools.

Relevant task: "How to Import AUT Host Data from Excel" on page 175

"Project
Management" on
page 195

Describes how tomigrate a LabManagement system from a staging to a
production environment.

Relevant task: "How toMigrate a LabManagement System from a
Staging to a Production Environment " on page 196

"PC Servers" on
page 199

Describes how to create, view, andmanage Performance Center
servers.

Relevant task: "How toManage Performance Center Servers" on page
199

"CDA Servers" on
page 215

Describes how to create, view, andmanage CDA servers.

Relevant task: "How toManage CDA Servers" on page 215.

Documentation Library
The Documentation Library is an online help system that describes how to use ALM. You can
access the Documentation Library in the following ways:

l Click Documentation Library in the ALM Helpmenu to open the Documentation Library home
page. The home page provides quick links to themain help topics.

l Click Help on this page in the Helpmenu to open the Documentation Library to the topic that
describes the current page.

Documentation Library Guides
The Documentation Library consists of the following guides and references, available online, in
PDF format, or both. PDFs can be read and printed using Adobe Reader, which can be downloaded
from the AdobeWeb site (http://www.adobe.com).

Reference Description

Using this Documentation
Library

Explains how to use the Documentation Library and how it is
organized.
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Reference Description

What’s New? Describes the newest features in the latest version of ALM.

To access, select Help > What's New.

Product Feature Movies Short movies that demonstrate themain product features.

To access, select Help > Product Feature Movies.

Readme Provides last-minute news and information about ALM.

HP Application
Lifecycle
Management
(ALM) Guides Description

HP ALM User
Guide

Explains how to use ALM to organize and execute all phases of the
application lifecycle management process. It describes how to specify
releases, define requirements, plan tests, run tests, and track defects.

HP ALM
Administrator
Guide

Explains how to create andmaintain projects using Site Administration,
and how to customize projects using Project Customization.

HP ALM Lab
Management
Guide

Explains how to use LabManagement to manage lab resources used for
functional and performance testing on remote hosts.

HP ALM Tutorial A self-paced guide teaching you how to use ALM tomanage the application
lifecycle management process.

HP ALM
Installation Guide

Describes the installation and configuration processes for setting up ALM
Server.

Business
Process Testing
User Guide

Explains how to use Business Process Testing to create business process
tests.

HP ALM
Performance
Center Guides Description

HP ALM
Performance
Center Quick
Start

A self-paced guide giving the Performance Center user a high level
overview of creating and running performance tests.

HP ALM
Performance
Center Guide

Explains to the Performance Center user how to create, schedule, run, and
monitor performance tests. Explains to the Performance Center
administrator how to configure andmanage Performance Center projects.
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HP ALM
Performance
Center Guides Description

HP ALM
Performance
Center
Installation Guide

Describes the installation processes for setting up Performance Center
Servers, Performance Center Hosts and other Performance Center
components.

HP ALM
Performance
Center
Troubleshooting
Guide

Provides information for troubleshooting problems while working with HP
ALM Performance Center.

HP ALM Extension
Guides Description

HP Enterprise
Integration Module for
SAP Applications User
Guide and Readme

Explains how to use the HP Enterprise Integrationmodule for SAP
SolutionManager to work with SAP SolutionManager business
blueprints in the HP ALM Requirements module.

HP IDE Connector
Customizer Readme

Explains how to use the IDE Connector Customizer to perform
customizations necessary for working with Tasktop HP ALMMylyn
Connector, including customizing field mappings between HP ALM
projects and the IDE.

HP Application
Lifecycle Intelligence
User Guide and
Readme

Explains how to use ALI's capabilities, reports, andmetrics to
provide complete ALM traceability.

HP ALM Best Practices Guides Description

HP ALM Agile Testing Best Practices
Guide

Provides best practices for implementing agile
testing principles.

HP ALM Business Process Models
Best Practices Guide

Provides best practices for working with the
Business Models module.

HP ALM Database Best Practices
Guide

Provides best practices for deploying ALM on
database servers.

HP ALM Entities Sharing Best
Practices Guide

Provides best practices for sharing entities.

HP ALM Project Planning and
Tracking Best Practices Guide

Provides best practices for managing and tracking
releases.

HP ALM Project Topology Best
Practices Guide

Provides best practices for structuring projects.
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HP ALM Best Practices Guides Description

HP ALM Upgrade Best Practices
Guide

Provides methodologies for preparing and planning
your ALM upgrade.

HP ALM Versioning and Baselining
Best Practices Guide

Provides best practices for implementing version
control and for creating baselines.

HP ALM Workflow Best Practices
Guide

Provides best practices for implementing workflows.

HP ALM Performance Center
Best Practices Guides Description

HP Performance Centers of
Excellence Best Practices

Provides best practices for successfully building and
operating Performance Centers of Excellence.

HP Performance Monitoring
Best Practices

Provides best practices for monitoring the performance of
applications under test.

HP ALM API
References Description

HP ALM
Project
Database
Reference

Provides a complete online reference for the project database tables and
fields.

HP ALM Open
Test
Architecture
API Reference

Provides a complete online reference for the ALM COM-based API. You can
use the ALM open test architecture to integrate your own configuration
management, defect tracking, and home-grown testing tools with an ALM
project.

HP ALM Site
Administration
API Reference

Provides a complete online reference for the Site Administration COM-based
API. You can use the Site Administration API to enable your application to
organize, manage, andmaintain ALM users, projects, domains, connections,
and site configuration parameters.

HP ALM REST
API Reference

Provides an online reference for the ALM REST-based API. You can use the
REST API to access and work with ALM data.

HP ALM COM
Custom Test
Type
Developer
Guide

Provides a complete online guide for creating your own testing tool and
integrating it into the ALM environment using native COM development tools.

HP ALM .NET
Custom Test
Type
Developer
Guide

Provides a complete online guide for creating your own testing tool and
integrating it into the ALM environment using a combination of DCOM and
.NET classes.
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Topic Types
The content in the abovementioned ALM guides is organized by topics. Threemain topic types are
in use: Concepts, Tasks, andReference.

Topic Type Description Usage

Concepts Background, descriptive, or conceptual
information.

Learn general information
about what a feature does.

Tasks Instructional Tasks. Step-by-step
guidance to help you work with the
application and accomplish your goals.

Task steps can be with or without
numbering:

l Numbered steps. Tasks that are
performed by following each step in
consecutive order.

l Non-numbered steps. A list of self-
contained operations that you can
perform in any order.

l Learn about the overall
workflow of a task.

l Follow the steps listed in a
numbered task to complete
a task.

l Perform independent
operations by completing
steps in a non-numbered
task.

Use-case Scenario Tasks. Examples of
how to perform a task for a specific
situation.

Learn how a task could be
performed in a realistic
scenario.

Reference General Reference. Detailed lists and
explanations of reference-orientedmaterial.

Look up a specific piece of
reference information relevant
to a particular context.

User Interface Reference. Specialized
reference topics that describe a particular
user interface in detail. Selecting Help on
this page from the Helpmenu in the product
generally open the user interface topics.

Look up specific information
about what to enter or how to
use one or more specific user
interface elements, such as a
window, dialog box, or wizard.

Troubleshooting
and Limitations

Troubleshooting and Limitations.
Specialized reference topics that describe
commonly encountered problems and their
solutions, and list limitations of a feature or
product area.

Increase your awareness of
important issues before
working with a feature, or if you
encounter usability problems in
the software.
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Additional Online Resources
The following additional online resources are available from the Helpmenu:

Resource Description

Troubleshooting
& Knowledge
Base

Opens the Troubleshooting page on the HP Software Support Web site where
you can search the Self-solve knowledge base. ChooseHelp >
Troubleshooting & Knowledge Base. The URL for this Web site is
http://h20230.www2.hp.com/troubleshooting.jsp.

HP Software
Support

Opens the HP Software Support Web site. This site enables you to browse
the Self-solve knowledge base. You can also post to and search user
discussion forums, submit support requests, download patches and updated
documentation, andmore. ChooseHelp > HP Software Support. The URL
for this Web site www.hp.com/go/hpsoftwaresupport.
l Most of the support areas require that you register as an HP Passport user

and sign in. Many also require a support contract.

l To findmore information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp

l To register for an HP Passport user ID, go to:
http://h20229.www2.hp.com/passport-registration.html

HP Software
Web site

Opens the HP SoftwareWeb site. This site provides you with themost up-to-
date information on HP Software products. This includes new software
releases, seminars and trade shows, customer support, andmore. Choose
Help > HP Software Web site. The URL for this Web site is
www.hp.com/go/software.

Add-ins Page Opens the Add-ins Page, which offers integration and synchronization
solutions with HP and third-party tools.

ALM Extension Guides
Extensions provide added functionality to HP ALM. If you have a license for an ALM extension, you
can utilize the added functionality by enabling the extension on a per project basis. For more details
on enabling extensions, refer to theHP Application Lifecycle Management Administrator Guide.

To view the list of extensions available with ALM 11.50, or to download documentation for ALM
extensions, visit the HP ALM Add-ins Page, accessible from themain ALM Helpmenu.
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Chapter 1

Lab Management at a Glance
This chapter includes:

LabManagement Overview 19

Lab Management Overview
HP ALM LabManagement allows you tomanage resources that you use for ALM testing.

In LabManagement, you use the Project Settings module in the Lab Settings group tomanage the
Lab settings of each of your ALM projects, including defining Host limit settings and assigning host
pools to a specific project. You use theMaintenance Tasks module tomonitor the tasks which
locate and repair failures in your system's key components.

You use themodules in the Lab Resources group to create andmaintain testing hosts, providing
ALM with the resources necessary for scheduling and executing Functional and Performance tests
on remote hosts. You assign each host a set of properties, including purposes, host system
attributes, and location. The host attributes for each testing host are fully customizable. For
Performance Center users, if there is a firewall between your hosts, you can also create an
MI Listener to enable transfer of information over the firewall. Once the testing hosts are created to
your specifications, you can organize them into host pools and assign a pool to an ALM project
using the Project Settings module.

The Timeslots module in LabManagement allows you to runmaintenance tasks on your testing
hosts, ensuring that your hosts are running efficiently.

For Performance Center users, you use themodules in thePerformance Center group tomonitor
the Performance Center aspects of your projects. You canmanage Application Under Test
(AUT) hosts and host pools, view the results of Performance test runs, maintain and view the
health PC servers and licenses, and install patches on PC hosts.

Use themodules in the Servers group to create and configure PC servers and CDA servers.
CDA servers are used for dynamic deployment and provisioning of your latest builds using the
cloud.
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Chapter 2

Lab Management Administration
This chapter includes:

Introduction to LabManagement Administration 21

How to Create LabManagement Administrators 21

How toWork with LabManagement Administration 22

LabManagement Administration User Interface 24

Introduction to Lab Management
Administration

LabManagement administration responsibilities includemanaging lab resources, such as hosts
and host pools, creating andmaintaining testing assets, and other administration tasks.

LabManagement administrators are defined in the ALM Site Administration site. For details on how
to create a LabManagement administrator user, see "How to Create LabManagement
Administrators" below.

For related task details, see "How toWork with LabManagement Administration" on next page.

How to Create Lab Management
Administrators

This task describes how to create a LabManagement administrator user, who is responsible for all
project administration tasks in LabManagement and in Site Administration.

Note:

l This task is a prerequisite for the task, "How toWork with LabManagement Administration"
on next page.

l This task is performed in Site Administration. For details about logging in to and using Site
Administration, refer to theHP Application Lifecycle Management Administrator Guide.

To create a Lab Management administrator user:

1. Log in to Site Administration.

2. In theSite Users tab, create a new user.

3. In the Lab Management tab, select the Lab Management Users tab. For user interface
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details, see "LabManagement Tab" on page 25.

4. Add the user you created above, and select theProject Administrator option for the new
user.

How to Work with Lab Management
Administration

This section lists the tasks that a LabManagement administrator can perform.

Some tasks are available only for projects with Performance Center licenses.

This task includes the following steps:

l "Prerequisites" below

l "Perform initial Performance Center configuration" below

l "Create Performance Center projects and define project settings" on next page

l "Manage andmaintain LabManagement lab resources" on next page

l "View andmanage performance test runs" on next page

l "View Performance Center usage reports" on next page

l "Upload application patches" on next page

l "Manage Performance Center Servers" on next page

l "Manage Performance Center and Performance Center host licenses" on next page

l "Manage Diagnostic Servers andMediators" on next page

l "Maintain system health" on next page

l "Change the Performance Center system user" on page 24

l "Update the Communication Security passphrase" on page 24

l "Update the secure host communication settings" on page 24

l "Configure general Performance Center settings" on page 24

Prerequisites
To perform any of these tasks, youmust be a LabManagement administrator. For details on how to
create a LabManagement administrator, see "How to Create LabManagement Administrators" on
previous page.

Perform initial Performance Center configuration
Immediately after installing the Performance Center components, the relevant component's
configuration tool opens, prompting you for initial configuration settings. If this configuration was
skipped, youmust configure the settings manually before you can start working with Performance
Center.

For details, refer to theHP ALM Performance Center Guide.
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Create Performance Center projects and define project settings
You create projects in Site Administration, and define the limits and other settings for the project in
LabManagement, in the Project Settings module. For details, see "How to Create a Project" on
page 30.

Manage and maintain Lab Management lab resources
Youmanage hosts, host pools, host locations, and relevant MI Listeners from the Lab Resources
modules. For details, see "How toManage Lab Resources" on page 57.

When you plan to perform maintenance tasks on the hosts—such as installing patches, rebooting
hosts, and so on—it is recommended to reserve these hosts in timeslots. This way, you can be
sure that they will be available for maintenance. For details, refer to theHP Application Lifecycle
Management User Guide.

View and manage performance test runs
The test runs from all the LabManagement in the system can be viewed andmanaged in the Test
Runs module. For details, see "PC Test Runs ModuleWindow" on page 106.

View Performance Center usage reports
Performance Center usage reports provide you with an overall analysis of Performance Center site
users, resource usage, concurrent resource usage vs. license limitations, timeslot usage, as well
as resource usage by duration and runs. For details, see "How to View Reports and Set Report
Filter Criteria" on page 114.

You can also export these reports to PDF and Excel format. For details, see "How to Export
Reports to PDF or Excel Formats " on page 115.

Upload application patches
Before you can install application patches on Performance Center Servers and hosts, youmust
upload the patches to the system. For details, see "How to Upload Patches to ALM" on page 167.

Manage Performance Center Servers
Youmanage Performance Center Servers in LabManagement from the PC Servers module. For
details, see "How toManage Performance Center Servers" on page 199.

Manage Performance Center and Performance Center host licenses
Youmanage the Performance Center license and Performance Center host license in Lab
Management from the Licenses module. For details, see "PC Licenses ModuleWindow" on page
144.

Manage Diagnostic Servers and Mediators
Integrating diagnostics modules with ALM enables monitoring and analysis of the performance of
complex applications under test. For details on setting up the diagnostics modules, see
"Diagnostics Management" on page 149.

Maintain system health
You track andmaintain the health of the system LabManagement from the System Health module.
For details, see "System Health Overview" on page 137.
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Change the Performance Center system user
You use the System Identity Utility, installed on the Performance Center Server, to change the
Performance Center system user on the Performance Center Server and hosts. For details, refer to
theHP ALM Performance Center Guide.

Update the Communication Security passphrase
You use the System Identity Utility, installed on the Performance Center Server, to update the
Communication Security passphrase on the Performance Center Server and hosts. For details,
refer to theHP ALM Performance Center Guide.

Update the secure host communication settings
Initially, you define secure communication settings on each Performance Center host or standalone
load generator using the Host Security Setup utility, installed locally on each host or load generator.
For details, refer to theHP ALM Performance Center Guide.

To update these settings on all the hosts and load generators simultaneously, you can use the Host
Security Manager, installed on the Performance Center Server. For details, refer to theHP ALM
Performance Center Guide.

Configure general Performance Center settings
Youmanage general Performance Center settings in LabManagement. On themasthead, select
Tools > Performance Center General Settings. For user interface details, see "General Settings
Dialog Box" on page 26.

Lab Management Administration User
Interface

This section includes:

LabManagement Tab 25

General Settings Dialog Box 26
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Lab Management Tab
The LabManagement tab in Site Administration enables you tomanage LAB_PROJECT project
details and define LabManagement users who are responsible for LabManagement administration
tasks.

To access In Site Administration, click the Lab Management tab.

Relevant tasks "How to Create LabManagement Administrators" on page 21

See also "Introduction to LabManagement Administration" on page 21

User interface elements are described below:

UI Elements Description

Edit Connection String. Edits the connection string for LabManagement. For
details on editing the connection string, refer to theHP Application Lifecycle
Management Administrator Guide.

Ping Project. Checks whether the project database is accessible from Site
Administration.

Maintain Project. Enables you to verify, repair, and upgrade projects. For
details, see theHP Application Lifecycle Management Administrator Guide.

Activate/Deactivate Project.When you deactivate LAB_PROJECT, users
cannot log in to LabManagement. Any users currently connected to the project
are forced to log out when you deactivate. LAB_PROJECT is not deleted from
the server.

In addition, users cannot connect to projects linked to LAB_PROJECT, and
currently connected users are disconnected.
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UI Elements Description

Restore Lab Project. Restores access to LAB_PROJECT and adds it to the
LabManagement tab in Site Administration. Restoring a LAB_PROJECT allows
you to use only LabManagement projects that were created in the restored LAB_
PROJECT.

For more details on the restore process, refer to theHP Application Lifecycle
Management Administrator Guide.

Remove Lab Project. Removes LAB_PROJECT from the LabManagement tab
in Site Administration. This does not delete LAB_PROJECT from the server and
you can restore it if necessary. If the project is still active, you are prompted to
deactivate it.

Removing LAB_PROJECT deactivates all associated LabManagement
projects. These projects can be enabled only by restoring this version of LAB_
PROJECT.

Lab
Management
Details tab

Enables you to view and edit LAB_PROJECT details for working with Lab
Management. For more information on the viewing and editing project details,
refer to theHP Application Lifecycle Management Administrator Guide.

Lab
Management
Users tab

Enables you to assign users who are responsible for LabManagement
administration. For more information, refer to theHP Application Lifecycle
Management Administrator Guide.

General Settings Dialog Box
This dialog box enables you to define general settings for Performance Center.

To access In LabManagement, on the ALMmasthead select Tools > Performance
Center General Settings

Important
information

The settings defined here are general settings for the Performance Center
system.

Relevant tasks "How toWork with LabManagement Administration" on page 22

See also "Introduction to LabManagement Administration" on page 21
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

PC Server > PC
Server Settings page

Enables you to define Performance Center Server cache setting:

l Unlimited cache size. The Performance Center Server cache size
is unlimited and the cache is not cleaned.

l Cache size. The Performance Center Server cache size in
gigabytes.

Data Processor >
Data Processor
Settings page

Enables you to define data processor settings:

l Data Processor Timeslot minimum length (minutes). The
minimum amount of time, in minutes, that a data processor timeslot
should be allotted.

l Timeout for pending data processor task (minutes). The
amount of time a data processing task should be allowed to remain
in a pending state.
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Chapter 3

Project Settings
This chapter includes:

Project Settings Overview 29

How to Create a Project 30

Project Settings User Interface 31

Project Settings Overview
Project settings include:

l General project details

l Using IP addresses as targets for performance testing

l VUDs Vusers allocation to the project and usage

l Timeslot settings for the project

l Controller settings for the project

For details about how to use Target IP Addresses, see "Using Target IP Addresses" below

Using Target IP Addresses
Target IP addresses are assigned so that the addresses of all hosts on a given network share a
common prefix. The common prefix defines the network portion of the IP address, and the
remainder defines the host portion (also referred to as the local portion).

The term network in this context refers to a logical network whichmight span one or more physical
networks. The network portion of an IP address identifies a site and the local portion identifies a
single host at that site.

Using Subnet Masks
A site using subnet addressingmust specify a 32-bit subnet mask for each network. Each bit in the
subnet mask is set to 1 if the network treats the corresponding bit in the IP address as part of the
network address or 0 if it treats the corresponding bit in the IP address as part of the host ID.

Consider, for example, the subnet mask

11111111 11111111 0000000 0000000

(or in decimal form, 255.255.0.0). This subnet mask specifies that the first two octets identify the
network and the last two octets identify the host on that network.
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The subnet mask 255.255.255.255 (or in binary form, 11111111 11111111 11111111 11111111),
which you add when defining individual IP addresses, specifies that all four octets in the IP address
identify the network and host as if there were no subnet mask. In practice, this means that null will
use the exact IP address to target performance tests.

How to Create a Project
This task describes how to create a project. You create projects in Site Administration, and define
project settings in LabManagement.

Note:

l This task is part of a higher level task. For details, see "How toWork with LabManagement
Administration" on page 22.

l Product Feature Movie. To view amovie that demonstrates how to create a performance
testing project, select Help > Product Feature Movies in the ALMmain window.

This task includes the following steps:

l "Log in to Site Administration" below

l "Create a project domain - optional" below

l "Create project administrator users" below

l "Create a new project" on next page

l "Assignmore project administrators to the project - optional" on next page

l "Define the project's settings" on next page

l "Add and customize the project users " on next page

1. Log in to Site Administration
Open yourWeb browser and type the ALM URL in the following format:

http://<ALM name>[<:port number>]/qcbin

In the HP Application Lifecycle Management window, click Site Administration.

Enter your Site Administrator user name and password and click Login.

2. Create a project domain - optional
Click theCreate Domain button and enter a name for the new domain, and click OK.

3. Create project administrator users
a. Select theSite Users tab, and click theNew User button. The New User dialog box

opens.

b. Enter the details of the project administrator user, and click OK.

c. Select the user, click Password and enter the password. Click OK.

For more details, seeHP Application Lifecycle Management Administrator Guide.
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4. Create a new project
a. Click theSite Projects tab, and select the domain in which you want to create the project.

b. Click theCreate Project button, and follow the steps to create the project. When
prompted:

o Add the project administrator users you created above.

o If it's not enabled already, select ALM Lab Extension.

For more details, see theHP Application Lifecycle Management Administrator Guide.

5. Assign more project administrators to the project - optional
To add additional project administrators:

a. Click theSite Projects tab.

b. In theProjects list on the left, select the project you created.

c. In the right pane, click theProject Users tab.

d. Add another user, and select Project Administrator.

6. Define the project's settings
Projects are created with default settings which you canmodify if desired. You define the
project settings in Lab Management as follows:

a. Log into Lab Management with your administrator user name and password.

b. On the Lab Management sidebar, under Lab Settings, select Project Settings.

c. Define at least the following settings: Host limit, Vuser limit, and Concurrent Run limit

For user interface details, see " Project Settings Details Dialog Box" on page 36.

Note: Project administrators can view the project settings in the project in ALM, and
canmodify some of the project settings. To access the project settings in ALM, on the
ALMmasthead, select Tools > Lab Settings.

7. Add and customize the project users
This step is performed by the project administrator. For details, seeHP Application Lifecycle
Management Administrator Guide.

Project Settings User Interface
This section includes:

Project Settings Module 32

Project Settings ModuleMenus and Buttons 33

Project Settings Module Fields 35

Project Settings Details Dialog Box 36

Performance Center Controller Options Dialog Box 42
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Project Settings Module
This module enables you to view andmanage all of the projects and their settings.

To access On the sidebar, under Lab Settings, select Project Settings.

Important
Information

This module displays a list of all of the projects in ALM.

Alternatively, you can access project settings from within a particular
project.

Relevant tasks "How to Create a Project" on page 30

See also "Project Settings Overview" on page 29

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Project Settings
module common UI
elements>

l Project Settings module fields. For field definitions, see "Project
Settings Module Fields" on page 35.

l Project Settings module menus and buttons. For command and
button descriptions, see " Project Settings ModuleMenus and
Buttons" on next page.

l ALM main menu and sidebar. For details on the Tools menu,
Helpmenu and sidebar, see theHP Application Lifecycle
Management User Guide.

<Project Settings
grid>

Displays a list of the projects in ALM and their project settings.

PC VUDs
transactions tab

Displays the PC VUDs transactions in each projects. For details, see "
Project Settings Details Dialog Box" on page 36.
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UI Elements Description

History tab Lists changes made to the currently selected project. For more details,
see theHP Application Lifecycle Management User Guide.

Project Settings Module Menus and Buttons
The Project Settings module enables you to view andmanage project settings.

To access l On the sidebar, under Lab Settings, select Project Settings.

l Project administrator: In ALM, on themasthead, select Tools >
Performance Center Project Settings.

Important
information

If you are a project administrator, you can view the current project's settings in
ALM. You can alsomodify some of the settings.

Menus and toolbars of the Project Settings module are described below:

UI
Elements
(A - Z)

Where Description

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view
to your private or the public folder. For details, see theHP Application
Lifecycle Management User Guide.

Copy URL Project
Settings
and
<right-
click
menu>

Copies a selected project and pastes its URL as a link. The project
itself is not copied. Instead, you can paste the address into another
location, such as an email or a document. Clicking the link opens up
ALM and takes you to the project file or folder. If you are not already
logged in, ALM first prompts for login details.

Export Project
Settings
and
<right-
click
menu>

Opens the Export Grid Data dialog box, enabling you to export the
project settings in the grid as a text file, Microsoft Excel worksheet,
Microsoft Word document, or HTML document.

Choose one of the following options:

l All. Exports all project settings in the grid.

l Selected. Exports selected project settings in the grid.

Find
View Opens the Find dialog box, enabling you to search for project settings

in themodule. For details about search options, see theHP Application
Lifecycle Management User Guide.

Go to
Project
Settings

Project
Settings

Opens theGo To Project Settings dialog box, enabling you to find a
specific project settings record by its ID number.
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UI
Elements
(A - Z)

Where Description

Grid Filters View and
<right-
click
menu>

Enables you filter the data according to an entry in the filter box. For
details about filtering options, see theHP Application Lifecycle
Management User Guide.

Information
Panel

View and
<right-
click
menu>

Shows/Hides the Information Panel in the lower area of themodule.

Organize
Favorites

Favorites Opens theOrganize Favorites dialog box, enabling you to organize the
list of favorite views by changing properties or deleting views. For
details, see theHP Application Lifecycle Management User Guide.

Project
Settings
Details

Project
Settings
and
<right-
click
menu>

Opens the Project Settings Details dialog box, enabling you to view
and edit details of the selected project.

Private Favorites Lists the favorite views that are accessible only to the user who
created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All View Refreshes the grid so that it displays themost up-to-date information.

Replace Edit and
<right-
click
menu>

In the Project Details grid, opens the Replace dialog box, enabling you
to replace a field value in the grid. For more details, see theHP
Application Lifecycle Management User Guide.

Select
Columns

View Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For more details, see
theHP Application Lifecycle Management User Guide.

For details about the project setting fields, see "Project Settings
Module Fields" on next page.

Set
Filter/Sort

View Enables you to filter and sort the project settings in the grid. Any
currently applied filters or sorting orders are displayed below the
toolbar. For more details, see theHP Application Lifecycle
Management User Guide.
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UI
Elements
(A - Z)

Where Description

Update
Selected

Edit and
<right-
click
menu>

Opens the Update Selected dialog box, enabling you to update a field
value for amultiple selection in the grid. For more details, see theHP
Application Lifecycle Management User Guide.

Project Settings Module Fields
This section describes the Project Settings module fields:

Field Description

AUT Pool The project's AUT host pool.

CDA Domain The domain of the CDA server.

CDA Server The name of the CDA server.

Concurrent
Run Limit

Themaximum number of concurrent test runs allowed within a project.

Diagnostics
Server

The Diagnostics Server defined for the project.

Domain
Name

The domain in which the project was created.

Host Limit The total number of hosts (Controller + load generators) reserved for a timeslot
may not exceed this limit.

ID The project's ID.

Pool The project's host pool.

Project The name of the project.

VUDs
Consumed

The number of VUDs consumed by the project.

VUDs Limit Themaximum number of VUDs available to the project.

VuGen
Working
Mode

Themode to use to upload scripts from VuGen:

l Runtime Files mode. Uploads only the necessary files to replay the script
correctly.

l User Defined mode. Uploads any available files including thumbnails
images.

Vuser Limit Themaximum number of Vusers a project can run at once. The total number
used by all of the project's concurrent performance tests must not exceed this
limit.
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Project Settings Details Dialog Box
This dialog box enables you to configure settings for a project.

To access In Lab Management:

1. On the sidebar, under Lab Settings, select Project Settings.

2. Right-click a project in the grid, and select Project Settings Details.

In ALM:

On the ALMmasthead, select Tools > Performance Center Project Settings.

Important
information

The Controller Options page is available only when logged in to a particular
project. You cannot set Controller options in LabManagement.

Relevant
tasks

"How to Create a Project" on page 30

See also "Project Settings Overview" on page 29

Common Elements
Common user interface elements are described below:

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse through the list of
projects.

Available from: LabManagement only

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.
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UI Elements Description

Spelling Options. Enables you to configure how to check the spelling.

Project The name of the project.

Details Page
This page displays the general details about the selected project. For details, see "Project Settings
Module Fields" on page 35.

PC Target IPs Page
This page enables you to define IP addresses to use as targets for performance testing.

Important
Information

Target IP can be defined on Performance Center hosts only, and not on
standalone load generators.

Relevant tasks "How to Create a Project" on page 30

See also "Using Target IP Addresses" on page 29

User interface elements are described below:

UI
Elements

Description

New. Opens the New Target IP dialog box, enabling you to define an IP to use as a
target for performance testing.

Edit. Opens the Target IP Details dialog box, enabling you to view and edit details of
the selected target IP.

Delete. Enables you to delete the selected target IPs.

Refresh. Refreshes the grid so that it displays themost up-to-date information.
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UI
Elements

Description

IP A target IP address.

Mask A 32-bit subnet mask for each network.

PC VUDs Transactions Page
This page enables you to follow the PC VUDs transactions in your projects.

User interface elements are described below:

UI Elements
(A - Z)

Description

Action The VUDs action performed. For details about the possible actions, see "VUDs
Actions" on next page.

In Use by
Run ID

The ID of the test run that is currently running the VUDs.

Owner Run
ID

The ID of the test run that originally issued the VUDs.

Post Date The date that the transaction occurred.

Responsible
user name

The user, or automated system process responsible for the transaction.

Token
Unique ID

Identifies all actions that belong to the same transaction.

Note: In one regular run that uses VUDs, there are 3 Actions: Issued,
Pending, and Expired. Each of these actions will have different transaction
ID, but the same Token ID.

Updated
inuse VUDs

The current number of VUDs that are running as a result of the transaction.
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UI Elements
(A - Z)

Description

Updated
Pending
VUDs

The current number of VUDs that are in the Pending state as a result of the
transaction.

Updated
project limit

The project's VUDs limit as a result of the transaction.

VUDs
number

The amount of VUDs involved in the Action.

VUDs
Tansaction
ID

The action ID.

VUDs Actions
The following table lists the possible VUDs actions.

UI
Elements
(A - Z)

Description

Allocated VUDs added to the project's VUDs limit by the administrator.

Deallocated VUDs removed from the project's VUDs limit by the administrator.

Expired VUD's removed from the license after their 24 hour active period has ended.

Note: VUDs that are involved in a performance test that exceeds 24 hours
continue to run until completion before expiring.

Issued VUDs added to a performance test.

Note:

l All VUDs involved in a performance test are considered to be issued from
the start of the test, irrespective of whether they have started running or
not.

l The amount of issued VUDs decreases the project's VUDs limit
accordingly.

l All unused VUDs are returned to the project's VUDs limit at the conclusion
of the test.
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UI
Elements
(A - Z)

Description

Pending VUDs which have completed a test run but are still available for further use as
their 24 hour active period has not yet ended.

Refunded VUDs which were issued but not used in the test. These VUDs are returned to the
project's VUDs limit andmay be reissued at a later date.

Reused Running VUDs that that are taken from VUDs in the Pending state.

Note: ALM Performance Center first reuses VUDs in the Pending state
before issuing new VUDs. For example, assume you define a performance
test that includes 100VUDs, where the current project limit is 200, and where
25VUDs are currently in the Pending state. ALM Performance Center first
reuses the 25Pending VUDs and only issues 75 from the license. The new
limit will be 125.

Timeslot Settings Page
This page enables you to configure timeslot settings.

User interface elements are described below:

UI
Elements

Description

Send
Alerts To

The users who should receive a timeslot alert:

l Timeslot creator. The user who reserved the timeslot.

l Timeslot modifier. The user who last modified the timeslot.

l Project administrators. Administrators of the project in which the timeslot was
reserved.
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UI
Elements

Description

Rules for
Alerts

The conditions under which timeslot alerts are sent (both conditions must hold):

l Send alerts for timeslots scheduled to start in the next <XX> hours. Sends
an alert when a timeslot is XX hours within its due time to start.

Default value: 72 hours

Minimum value: 12 hours

l Send alert if timeslot is in failure state for at least <XX> minutes. Sends an
alert when the timeslot has been invalid for XX minutes.

Default value: 30minutes

Maximum value: 360minutes (6 hours)

Autostart
Retries

If a performance test linked to a timeslot is scheduled to autostart but does not start
running, the system continues to try to autostart the test until it starts running
successfully.

TheAutostart Retries option enables you to specify when the system should stop
trying to autostart the test. In any event, retries are stopped if there are 30minutes or
less left of the timeslot.

Default value: 50%, that is the system stops retries when half the timeslot has
elapsed.

Maximum value: 99%;Minimum value: 1%

Note: The system tries to restart a performance test up to three times.

History Page
This page lists changes made to the project. For more details, see theHP Application Lifecycle
Management User Guide.
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Performance Center Controller Options Dialog Box
This dialog box enables you to configure global Controller options for your Performance Center
project.

To access On the ALMmasthead, select Tools > Performance Center Controller
Options.

Note: This page is accessible only from the ALM project itself, and not from
LabManagement.

Important
information

The Controller is themanager of a performance test. The Controller receives the
scripts, their runtime settings, and a list of the load generators to use. The
Controller issues instructions to the load generators including which scripts to run,
how many Vusers to run per script, and the timing at which to start running the
Vusers.

During the performance test, the Controller displays onlinemonitoring information.
At the conclusion of the test run, the Controller collates the data for analysis.

Before you run a performance test, you can configure load generator and Vuser
options for all your performance tests in the project. Although the default settings
correspond tomost environments, you canmodify the settings to customize the
test behavior.

The settings apply to all future test runs in the project and generally only need to be
set once. The settings apply globally to all the load generators in a performance
test.

Relevant
tasks

"How to Create a Project" on page 30

See also "Project Settings Overview" on page 29
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Run Options > Monitors
Enables you to activate the Transactionmonitor, configure the behavior of the transaction data, and
set the data sampling rate, debugging, and frequency settings for the onlinemonitors.

User interface elements are described below:

UI
Elements

Description

Transaction
Data

Configures the behavior of data for the Transaction, Data Point, andWeb
Resource online graphs.

l Enable Transaction Monitor. Select this option to activate the online Vuser
Transactionmonitor to beginmonitoring transactions at the start of a test run.

Sample information at frequency <>. Select the frequency, in seconds, at
which the onlinemonitor samples the data to produce the Transaction, Data
Point, andWebResource online graphs.

The higher the frequency, the less network traffic there is. The data is averaged
for the frequency period defined, and only one value is sent to the Controller.

Default value: 5 seconds.

Examples:

n For a small test, use a frequency of 1.

n For a large test, use a frequency of 3 - 5.

Note: You cannot modify these settings during a test run; youmust stop the
test run before deactivating themonitor or changing its frequency.

Send
information
in mode

Specifies how to send data back to the Controller.

l Summary. Sends a summary of the transaction data back to the Controller.

l Raw Data. Sends all the transaction data back to the Controller in raw form.
Sending raw data saves time because the data does not need to be processed.

Note:WhenRaw Data is selected, the volume of data being transferred to
the Controller may causemore network traffic. If the transfer speed is
significant to you, select Summary.
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UI
Elements

Description

Server
Resource
Monitors

Configures the behavior of the Server Resourcemonitors.

l Data Sampling Rate. The period of time (in seconds) between consecutive
data sampling. By default, the onlinemonitor samples the data at intervals of
three seconds. If you increase the sampling rate, the data is monitored less
frequently. This setting applies to all graphs.

Note:

l The sampling rate configured here is applied to all server monitors that you
subsequently activate. It is not applied to server monitors that have
already been activated. To apply the new sampling rate to activated server
monitors, save your performance test and reopen it.

l Each type of monitor has a different minimum sampling rate. If the default
sampling rate, or the rate set here is less than amonitor's minimum
sampling rate, themonitor samples data at its minimum sampling rate. For
example, theminimum sampling rate for the Oracle Monitor is 10 seconds.
If the data sampling rate is set here at less than 10 seconds, the Oracle
Monitor continues tomonitor data at 10 second intervals.

Debug l Display Debug Messages. The onlinemonitor provides debugging
capabilities. Select this option to display the debugmessages in the Output
window.

l Debug level. For the Network monitor, you can indicate the debug (detail) level
of messages sent to the log, ranging from 1-9.

Run Options > Run-Time Settings
Enables you to specify runtime settings for your test relating to Vuser quotas, stopping Vusers, and
random sequence seed, to prevent system overload, and to control the way in which Vusers stop
running.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Vusers
Quota

Vuser quotas prevent your system from overloading. The Vuser quotas apply to
Vusers on all load generators.

l Number of Vusers that may be initialized simultaneously on all load
generators. Limits the number of Vusers initialized at one time (when you
send an Initialize command).

Default value: 999
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UI Elements Description

When
Stopping
Vusers

Controls the way Vusers stop running when youmanually stop a test run:

l Wait for the current iteration to end before stopping. (Default option) The
Vuser completes the iteration it is running before stopping. The Vusers move
to theGradual Exiting status and exit the test run gradually.

l Wait for the current action to end before stopping. The Vuser completes
the action it is running before stopping. The Vusers move to theGradual
Exiting status and exit the test run gradually.

l Stop immediately. The Vusers stop running immediately, moving to the
Exiting status and exit the test run immediately.

Random
advance
mode of file
type
parameter

l Use random sequence with seed. Enables you to set a seed number for
random sequencing. Select this option if you discover a problem during the
test run and want to repeat the test using the same sequence of random
values.

l Use seed <#>. Each seed value represents one sequence of random values
used for test execution. Whenever you use this seed value, the same
sequence of values is assigned to the Vusers in the test.

This setting applies to parameterized Vuser scripts using the Randommethod for
assigning values from a data file. It also affects the random percentage of
recorded think time (see information about the Run-Time Settings dialog box in
theHP Virtual User Generator User Guide).

Run Options >Timeout
Enables you to set timeouts for various Performance Center commands. When a command is
issued by the Controller, you can set amaximum time for the load generator or Vuser to execute the
command. If the command is not completed within the time limit, the Controller issues an error
message.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Command
Timeout
(seconds)

Enable timeout checks. Enables load generator and Vuser timeout checks
described below.

Note: If this option is not selected, ALM waits an unlimited time for the load
generators to connect and disconnect, and for the Initialize, Start Vusers,
Duration, and Stop Vusers actions to be executed.

HP ALM LabManagement (11.50)Page 45 of 231



HP ALM Lab Management Guide
Chapter 3: Project Settings

UI
Elements

Description

Load
Generator

Load generator timeout limits:

l Connect operation (sec). The amount of time (in seconds) that elapses before
connecting to any load generator. If a connection is not successful within this
time, the status of the load generator changes to Failed.

Default connection timeout: 30 seconds

l Disconnect operation (sec). The amount of time that elapses before
disconnecting from any load generator. The load generator does not disconnect
within this time, the status of the load generator changes to Failed.

Default disconnection timeout: 120 seconds

Vusers Vuser timeout limits:

l Init stage (sec). The timeout value for the Initialize action.

Default time limit: 180 seconds

l Run stage (sec). The timeout value for the Start Vusers action.

Default time limit: 120 seconds

l Pause stage (sec). The timeout value for the Duration action.

Default time limit: 120 seconds

l Stop stage (sec). The timeout value for the Stop Vusers action.

Default time limit: 120 seconds

Note: Calculations consider the number of active Vusers and their influence on
the timeout values. For example, 1000 Vusers trying to initialize takemuch
longer than 10 Vusers. An internal value is added to the specified timeout value
based on the number of active Vusers.

Run Options > Debug Information
Enables you to select the type of information to trace during a test run. According to the selection
here, trace files are created and are used to gather information for debugging purposes.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Elements

Description

Enable
the
following
traces

The trace flags related to performance testing problems that you are encountering:

l General. Performs a general trace during the test run.

l File Transfer. Traces problems with the transfer of files during the test run.

l Incoming communication. Traces incoming communication during the test run.

l Outgoing communication. Traces outgoing communication during the test run.

Note: The Performance Center agent and the Controller create some temporary
files that collect information such as the parameter file sent to the Vuser, the
output compilation file, and the configuration file. The Performance Center agent
files are saved in brr folders in the TMP or TEMP directory of the agent
machine. The Controller files are saved in lrr folders in the TMP or TEMP
directory of the Controller machine. At the end of the test run, all of these files
are automatically deleted.

Run Options > General
Enables you to select amode for allocatingmultiple IP addresses when IP spoofing is enabled.

For details about the Test Options Dialog Box, see theHP ALM Performance Center Guide.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Multiple IP
Address Mode

The Controller can allocate an IP address one of the following ways:

l IP address allocation per process. Allocates IP addresses per process.

l IP address allocation per thread. Allocates IP addresses per thread,
resulting in amore varied range of IP addresses in a test run.

Examples:

l WebVusers require IP address allocation per process.

l WinSock Vuser IP addresses can be allocated per thread or per
process.

Run Results > Collate Settings
Enables you to specify behavior related to collation of the run results.

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Elements

Description

Output
Message
Database

l Add output.mdb to RawResults.zip if it is smaller than RawResults.zip
size (MB). Collator process adds output.mdb to RawResults.zip only if it is
smaller in size than theRawResults.zip file size specified.

l Always exclude output.mdb from RawResults.zip. Collator process always
excludes output.mdb from RawResults.zip.

Timeout l Collate timeout in minutes. Themaximum amount of time the collate process
should continue running without progress.

l Diagnostics collate timeout in minutes. Themaximum amount of time the
collate process should continue running without progress when collating results
with Diagnostics data.
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Maintenance Tasks
This chapter includes:

Maintenance Tasks Overview 49

Maintenance Tasks User Interface 50

Maintenance Tasks Overview
To run tests in ALM, the systemmust be up and functioning correctly. Periodic automated
maintenance tasks locate and repair any failures, thereby ensuring constant monitoring of the
system's key components.

The following table describes themaintenance tasks:

UI
Elements
(A - Z)

Description

Check
Host Task

Verifies the host installation, and updates the host status to eitherOperational or
Non-Operational.

Default frequency. Every 24 hours

Data
Processor
Task

Sets and updates a data processing queue for any of the following actions:
Analyzing a test run, recalculating the SLA, or adding test runs to a trend report.

Default frequency. Every minute

OFW
Status
Update
Task

Updates the real status (Operational orNon-Operational) of a host that is located
over a firewall.

Default frequency. Every 15minutes

Orphan
Run Task

Identifies orphan test runs during and outside of the active timeslot.

Default frequency. Every 15minutes
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UI
Elements
(A - Z)

Description

Resource
Recovery
Task

Performs predefined validation tests on Controllers and load generators that are in
theNon-Operational state. If the host passes the test, its status changes to
Operational.

l Controller validation tests. Tests the OTA connection, ability to run, and
available disk space.

l Load Generator validation tests. Tests the connection to Agent.

The task parameters should be within the following guidelines:

l MIN_APPLICATION_DIR_DISK_SPACE. Between 10 and 1000

l CHECK_LG_TIMEOUT. Between 1 and 15

l MAX_RETRIES. Between 1 and 1000

l RESULT_EXPIRY_DAYS. Between 1 and 1000

Default frequency. Every 15minutes

Note: For load generators over a firewall, this is performed by theOFW Status
Update task (see above).

Result
Cleaning
Task

Cleans test run results from Controllers or load generators in the following
instances:

l If the results have already been collated.

l There are old performance tests whose results were not collated.

l If the performance test was deleted.

Default frequency. Every 6 hours

Maintenance Tasks User Interface
This section includes:

Maintenance Tasks ModuleWindow 51

Maintenance Task Fields 51

Maintenance Task Menus and Buttons 52
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Maintenance Tasks Module Window
This module displays information about maintenance tasks performed by the system.

To access On the sidebar, under Lab Settings, selectMaintenance Tasks.

See also "Maintenance Tasks Overview" on page 49

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Maintenance
Task tab UI
elements>

l Maintenance Task fields. For field definitions, see "Maintenance Task
Fields" below.

l Maintenance Task menus and buttons. For command and button
descriptions, see "Maintenance Task Menus and Buttons" on next
page.

l ALM main menu and sidebar. For details on the Tools menu, Help
menu, and sidebar, see theHP Application Lifecycle Management User
Guide.

<Maintenance
tasks grid>

Displays a list of maintenance tasks. For details, see "Maintenance Tasks
Overview" on page 49.

Parameters tab Displays a description of the selectedmaintenance task.

Description tab Displays parameter information for the selectedmaintenance task.

Right-click the text box to display a toolbar for formatting and spell-
checking the text.

Maintenance Task Fields
The following fields are available in theMaintenance Tasks tab:
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Field (A - Z) Description

Description A description of themaintenance task.

ID Themaintenance task ID.

Name Themaintenance task name. For a list of themaintenance task types, see
"Maintenance Tasks Overview" on page 49.

Recurrence
(minutes)

Displays the frequency of themaintenance task.

Maintenance Task Menus and Buttons
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements
(A - Z)

Where Description

Copy URL Maintenance
Tasks and
<right-click
menu>

Copies a selectedmaintenance task and pastes its URL as a link.
The task itself is not copied. Instead, you can paste the address
into another location, such as an email or a document. Clicking the
link opens up ALM and takes you to the task file or folder. If you are
not already logged in, ALM first prompts for login details.

Export Maintenance
Tasks and
<right-click
menu>

Opens the Export Grid Data dialog box, enabling you to export the
tasks in the grid as a text file, Microsoft Excel worksheet,
Microsoft Word document, or HTML file.

Choose one of the following options:

l All. Exports all tasks in the grid.

l Selected. Exports the selected tasks in the grid.

Find View Opens the Find dialog box, enabling you to search for tasks in the
module. For details about search options, see theHP Application
Lifecycle Management User Guide.

Go to
Maintenance
Task

Maintenance
Tasks

Opens theGo ToMaintenance Task dialog box, enabling you to
find a specific task by its ID number. You can only go to tasks that
are available in the current filter.

Grid Filters View and
<right-click
menu>

Enables you filter the data according to an entry in the filter box. For
details about filtering options, see theHP Application Lifecycle
Management User Guide.

Information
Panel

View and
<right-click
menu>

Shows/hides the Information Panel in the lower area of themodule.
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UI Elements
(A - Z)

Where Description

Maintenance
Tasks
Details

Maintenance
Tasks and
<right-click
menu>

Opens theMaintenance Task Details dialog box, enabling you to
view and edit details of the task.

Refresh All View Refreshes the grid so that it displays themost up-to-date
information.

Replace Edit and
<right-click
menu>

In the grid, opens the Replace dialog box, enabling you to replace a
field value in the grid. For more details, see theHP Application
Lifecycle Management User Guide.

Select
Columns

View Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For more details,
see theHP Application Lifecycle Management User Guide.

For details about the System Health fields, see "Maintenance Task
Fields" on page 51.

Set
Filter/Sort

View Enables you to filter and sort the tasks in the grid. Any currently
applied filters or sorting orders are displayed below the toolbar. For
more details, see theHP Application Lifecycle Management User
Guide.

Update
Selected

Edit and
<right-click
menu>

Opens the Update Selected dialog box, enabling you to update a
field value for amultiple selection in the grid. For more details, see
theHP Application Lifecycle Management User Guide.
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Lab Resources
This chapter includes:

Lab Resources Overview 55

How toManage Lab Resources 57

Lab Resources Modules User Interface 64

Troubleshooting and Limitations 104

Lab Resources Overview
The Lab Resources modules enable you tomanage your remote testing resources.

When using ALM without LabManagement, users are forced to control tests from their local
computer. Once testing hosts are set up in LabManagement, users can use ALM to schedule and
execute Functional and Performance tests that aremanaged by ALM, requiring no user
intervention.

The following table lists the available resources:
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Resource Description

Testing
Hosts /
Hosts

Testing hosts are used to run tests and process the data collected from those tests.
You can create hosts with Functional purposes, Performance purposes, or both.

Functional hosts
Functional hosts can have the following purposes:

l Business Process Testing. A testing host on which business process tests
are run.

l Quick Test Professional. A testing host on which Quick Test Professional is
run.

l Service TestA testing host on which Service Test is run.

l System Test. A testing host on which System Test is run.

l Unified Functional Testing. A testing host on United Functional Testing is run.

l VAPI-XP. A testing host on which VAPI-XP is run.

Note: Remote hosts must be registered with ALM in order to be available for
functional testing. See "Using HP ALM Lab Service" on page 226.

ALM Editions: Functional testing host management is available only for the ALM
Edition.

Performance hosts
Performance hosts can have the following purposes:

l Controller. A testing host used tomanage a performance test. During a test run,
the Controller issues instructions to the load generators, including which scripts
to run, how many Vusers to run per script, and when to start and stop running
them. There is only one Controller per test.

l Load generator. A testing host on which Vusers run during a test. There can be
any number of load generators for a given test.

l Data processor. A testing host used for processing and publishing data
gathered during a test run.

Note:

l To provide greater flexibility (especially where resources are scarce), you
can allocate a Performance host with dual purposes as a Controller and load
generator. In general, this is not a recommended practice and is only
appropriate for tests that have a very small number of Vusers. When
allocating hosts, the system tries to use single function hosts before dual-
purpose Controller and load generator hosts.

l Although it is possible to set a host as both a Controller and a data
processor, it is recommended to set up a separate host for data processing.

l A host that is located over a firewall or is a UNIX host can be used as a load
generator only.
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Resource Description

Host
Pools

A host pool is a group of testing hosts. Each project has one host pool. When
managing a host pool, it is important to understand the total available resources.
The pool must contain at least one Controller, one load generator, and one data
processor. Because hosts can have dual functionality, it is recommended that a
pool contains, among the other hosts, at least one host that can be dedicated fully
for Controller functionality.

Available from: LabManagement only.

Host
Locations

When selecting hosts for testing, host locationmight be taken into consideration
because hosts in a pool can be located across a wide physical area. Hosts located
over a firewall can be designated as load generators only.

Available from: LabManagement only.

MI
Listeners

MI Listeners serve as routers between the Controller and a Performance Agent,
thus enabling you to run Vusers over a firewall, and collect server monitor data and
application diagnostics data over a firewall. TheMI Listener receives data from the
Performance Agent at regular intervals. During the course of the test run, the
Controller takes the data from theMI Listener to process as runtime data. The
MI Listeners are only available for load generators.

For detailed information about configuring LabManagement to work with firewalls,
refer to the section about working with firewalls in theHP ALM Performance Center
Installation Guide.

Available from: LabManagement only.

For details about managing lab resources, see "How toManage Lab Resources" below.

How to Manage Lab Resources
This section describes how tomanage lab resources needed for designing and running performance
tests.

Notes:

l Testing hosts for a particular project can also be viewed in the ALM project itself.

l Product Feature Movie.To view amovie that demonstrates how to set up the lab
resources required for running a performance test, select Help > Product Feature Movies
in the ALMmain window.

l ALM Editions: Functional testing host management is available only for ALM Edition.

This task describes how to:

l "Add lab resources" on next page

l "Import host data from Excel " on page 59

l "Modify/View lab resource details" on page 62
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l "Check host connections to testing hosts" on page 62

l "Reboot hosts" on page 62

l "Install patches on hosts" on page 63

l "Reconfigure hosts" on page 63

l "End processes on a Performance host" on page 63

l "Link hosts to host pools" on page 63

Add lab resources
Before you design and run tests, youmust add the required resources to ALM. These include the
hosts, the host pools to which the hosts belong, the location of the hosts, andMI Listeners for load
generators that are located over a firewall. For an overview of lab resources, see "Lab Resources
Overview" on page 55.

Before adding testing hosts, ensure the following:

l Testing hosts were installed according to the instructions provided in theHP Application
Lifecycle Management Administrator Guide.

l If a host you are adding is in a remote location, make sure that the location was added in the Lab
Resources > Locationsmodule.

l If a host you are adding is over a firewall, the host must communicate with a Performance host
through anMI Listener. Make sure that theMI Listener was added in the Lab Resources > MI
Listenersmodule.

l HP ALM Lab Service has been installed on testing hosts you are adding. For task details, see
"Installing HP ALM Lab Service" on page 226.

Tip: You can use the Import Hosts feature to import a list of hosts from an Excel file into ALM.
For details, see "Import host data from Excel" below.

To add a lab resource:

1. Create a new resource.

n In LabManagement, under Lab Resources, select the relevant resourcemodule, and click

theNew <Resource> button. See "New Testing Host Dialog Box" on page 75.

n In ALM, under Lab Resources, select theHostsmodule, and click theNew Host
button. See "New Testing Host Dialog Box" on page 75. Hosts created in ALM are private
hosts and can only exist in one host pool at a time.

2. Register the testing host. For security reasons, a testing host must be registered using
HP ALM Lab Service before it can be used. After the testing host has been registered, the
testing host registrationmust be approved from within LabManagement.
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To download and install HP ALM Lab Service, select Help > Add-ins Page to open the Add-
ins page, and click the appropriate link. For task details, see "Using HP ALM Lab Service" on
page 226.

Note: Fields marked with an asterisk (*) aremandatory.

Import host data from Excel
You can import a list of hosts from an Excel file (.xls or .csv) into ALM.

1. Ensure that the Excel file is set up so that the columns can be recognized andmapped by the
Import feature.

n The first row of the Excel file must contain the field names, or corresponding logical names,
that appear in the table below. (Logical names are not case sensitive.)

Some fields aremandatory, others are required or optional.

o Mandatory indicates a field thatmust appear in the Excel file. If you omit this field, the
import fails. If you omit a value in one of the rows of this field's column, the import of that
specific row fails.

o Required indicates a field that should appear in the Excel file. If you omit this field, the
code adds the field with the default value for all rows. If you include the field, but omit a
value in one of the rows of this column, the code adds the default value for that row.

o Optional indicates a field does not have to appear in the Excel file. Omitting this field has
no effect on the import procedure.

n Fields representing virtual, reference, and invalid fields are ignored.

n Empty columns are allowed.

Set up the columns and values in the file as follows:

Field name
Logical
Name Value Field for

HOST_NAME

Mandatory

Name Any string The valid name of the host machine.

HOST_
PURPOSE

Mandatory

Purpose Controller,
Load
Generator,
QTP, Sprinter,
etc.

The purpose of the testing host.

Note: This can be any
combination of the options.
Options should be separated with
a semicolon and be without
spaces.

Example: Controller; Data Processor;
QTP
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Field name
Logical
Name Value Field for

HOST_STATE

Required

Status o Operational

o Non-
Operational

o Unavailable

Default:
Operational

The host state.

HOST_
INSTALLATION

Required

Installation o Unix  Load
Generator

o Windows
Host

o Windows
Standalone
LG

Default:
Windows  Host

The type of host installation.

Note: There is a double space in:

o "Windows<space>
<space>Host"

o "Unix<space><space>Load
Generator"

HOST_
PRIORITY

Required

Priority o 1-Lowest
Priority

o 2, 3 ... 8

o 9-Highest
Priority

Default: 5

The priority of the host.

HOST_SSL_
ENABLED

Required

Enable
SSL

o Y

o N

Default:N

SSL-enabled

HOST_
USERNAME

Optional

Username Any string The user name for logging in to the
host.

HOST_
PASSWORD

Optional

Password Any string The user password for logging in to the
host.
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Field name
Logical
Name Value Field for

HOST_
DOMAIN

Optional

Domain Any string The host domain.

HOST_
DESCRIPTION

Optional

Description Any string The host description.

The fields specified in the table below must not be included in the Excel file. During the import
of each host, these fields are assigned default values.

Field name Default value assigned

Belongs to pools General

Location Default

MI Listener None

Note: If data for these fields is included in the Excel file, the data is ignored. Default
values that are not relevant for a particular host must bemodifiedmanually in the Hosts
module.

Example:

The following image illustrates an Excel file set up with the following AUT hosts:
[test]abc, [test]host, and a third host whose namewas not provided.

2. Import the hosts:

a. Under Lab Resources, select Hosts.

b. In the Hosts module, select Hosts > Import.

c. Browse to the Excel file containing the hosts, and click Open.
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At the end of the import process, a report displays the import results, and the imported hosts
are listed in the Hosts module. Hosts that are not imported successfully must be added
manually.

Modify/View lab resource details
Tomodify or view a lab resource's details, in the relevant Lab Resources module, right-click the
resource in the grid and select <Resource>Details. See "Lab Resources Modules User Interface"
on page 64.

Check host connections to testing hosts
Under Lab Resources, select Hosts. Right-click a host in the grid, and select Check Host.

The Task Manager opens, and the overall result of each check performed on the host, Passed or
Failed, is displayed.

You can view the progress of the host check in the Hosts module's Check Host Status tab.

Note: The only test which can be run on a Functional host is Ping to Host.

Based on the purpose and location of the host, the following checks are performed on the host:

Check
Performed

Load Generator Host
Controller
Host

Data
Processor
Host

Functional
HostRegular UNIX Standalone OFW

Ping to Host Yes Yes Yes N/A Yes Yes Yes

Installed
Patches

Yes N/A N/A N/A Yes Yes N/A

Services Yes N/A N/A N/A Yes Yes N/A

Performance Yes N/A N/A N/A Yes Yes N/A

Over Firewall
Status

N/A N/A N/A Yes N/A N/A N/A

Alternatively, you can perform the above checks, together with an additional connectivity check
from the host to a particular URL. Right-click a host in the grid, select Check Connectivity to
URL, and enter the URL.

Examples:

l Regular URL: http://www.website.com

l Machine name: machine22 or http://machine22

Reboot hosts
Under Lab Resources, select Hosts. Right-click the host in the grid that you want to reboot, and
select Reboot Host.
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Install patches on hosts

Notes:

l To install patches on a host, you first need to have uploaded the patches to ALM. For
details, see "How to Upload Patches to ALM" on page 167.

l Patches can be installed on a host only when the host state is idle.

l You can only install patches on Performance hosts.

Under Lab Resources, select Hosts. Right-click the host in the grid on which to install the patch
and select Install Patch.

For user interface details, see "Select Patch to Install Dialog Box" on page 87.

Reconfigure hosts

Note: You can only reconfigure Performance hosts.

Reconfiguring a host resets the host license, the Performance Center system user (IUSR_
METRO), and the Communication Security passphrase on the host machine.

To reconfigure a host, under Lab Resources, select Hosts. Right-click the host in the grid that you
want to reconfigure, and select Reconfigure Host.

End processes on a Performance host
To end a process on a Performance host, under Lab Resources, select Hosts. Select a host, and

in theProcesses tab, select the process and click .

Link hosts to host pools

Note: Host pool management is only available in LabManagement. It is not available in ALM.

You can populate host pools with hosts in one of the following ways:

l Hosts module. You can link a host to one or more host pools.

l Pools module. You can link one or more hosts to a particular host pool.

To link a host to one or more host pools from theHostsmodule:

1. Under Lab Resources, select Hosts:

2. Right-click a host in the grid, and select Host Details.

3. Click the down arrow adjacent toBelongs to Pools, and select pools in which to include the
host, and click OK.
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To link one or more hosts to a host pool from thePoolsmodule:

1. On the LabManagement sidebar, under Lab Resources, select Host Pools.

2. Select a host pool in the grid.

3. In the Linked Hosts tab, click Add Hosts to Pool . Select hosts from the grid and click
Add.

Lab Resources Modules User Interface
This section includes:

Lab Resources ModuleMenus and Buttons 65

Hosts Module 68

Pools Module 88

Locations Module 95

MI Listeners Module 99
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Lab Resources Module Menus and Buttons
The Lab Resources modules enable you tomanage the lab resources used for test execution.

Important
information

l Some resources are available only in LabManagement. Only a user with
administrator privileges canmanage those resources.

l Non-administrator users in LabManagement can view host details and host
pool details belonging to their projects, and can reconfigure, reboot, and check
host connectivity on hosts.

l This help page relates to all of the Lab Resources modules:

n Hosts

n Pools

n Locations

n MI Listeners

All lab resources are generically referred to as <Resource>.

Relevant
tasks

"How toManage Lab Resources" on page 57

Commonmenus and toolbars of the Lab Resources modules are described below:

UI Elements (A - Z) Where Description

Add to Favorites Favorites Opens the Add Favorite dialog box, enabling you to
add a favorite view to your private or the public folder.
For details, see theHP Application Lifecycle
Management User Guide.

Hosts/Testing
Hosts module

Enables you to approve the registration of a testing
host, making it available for test execution.

Hosts/Testing
Hosts module

Refreshes the grid automatically every 5 seconds.

Hosts/Testing
Hosts module

Performs the same checks as theCheck Host
button, as well as connectivity to any given URL.

Hosts/Testing
Hosts module

Checks connectivity between the selected host and
other machines in the system.

Hosts/Testing
Hosts module

Opens the Data Processor Queue window, enabling
you to view the pending data processing requests.

Note: Available only for hosts with Performance
purposes.
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UI Elements (A - Z) Where Description

Delete Edit and
<right-click
menu>

Deletes the resource selected in the grid.

Note: You cannot delete anMI Listener that is
being used by a host.

<Resource> Details Toolbar and
right-click
menu

Opens the <Resource> Details dialog box, enabling
you to view and edit details of the selected resource.

Export Toolbar and
<right-click
menu>

Opens the Export All Grid Data dialog box, enabling
you to export the resources in the grid as a text file,
Microsoft Excel worksheet, Microsoft Word
document, or HTML document.

Select one of the following options:

l All. Exports all resources in the grid.

l Selected. Exports selected resources in the grid.

Find View Opens the Find dialog box, enabling you to search for
a resource in themodule. For details about search
options, see theHP Application Lifecycle
Management User Guide.

Go to <Resource> Toolbar Opens theGo To <Resource> dialog box, enabling
you to find a specific resource by its ID number. You
can only go to resources that are in the current filter.

Grid Filters View and
<right-click
menu>

Enables you to filter the data according to an entry in
the filter box. For details about filtering options, see
theHP Application Lifecycle Management User
Guide.

Import Hosts/Testing
Hosts module

Enables you to import a list of lab hosts from an
Excel file (.xls or .csv) into ALM (.xls or .csv format).

Information Panel View and
<right-click
menu>

Shows/Hides the Information Panel in the lower area
of themodule.
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UI Elements (A - Z) Where Description

Hosts module Opens the Install Patch dialog box, enabling you to
select patches to install on the selected hosts. For
details, see "Select Patch to Install Dialog Box" on
page 87.

Note:

l You cannot use the Install Patch feature on
Controller and Load generator hosts if they
are in theRunning state. You can only install
patches when these hosts are idle.

l You should use this feature to install ALM
certified patches only.

l Available only for hosts with Performance
purposes.

Available from: LabManagement only.

New <Resource> Toolbar Enables you to add a resource.

Organize Favorites Favorites Organizes your favorite views. For details, see the
HP Application Lifecycle Management User Guide

Private Favorites Lists the favorite views that are accessible only to
the user who created them.

Public Favorites Lists the favorite views that are accessible to all
users.

Hosts/Testing
Hosts module

Enables you to remotely reboot host machines.

Note:

l You cannot reboot Controller and Load
generator hosts while they are in the
Running state. You can only reboot these
hosts when they are idle.

l You cannot reboot a UNIX load generator
host.

l Available only for hosts with Performance
purposes.
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UI Elements (A - Z) Where Description

Hosts/Testing
Hosts module

Resets the following on the selected host machine:

l Host license

l System user (IUSR_METRO)

l Communication Security passphrase

Note:

l You can reconfigure only one host at a time.

l Available only for hosts with Performance
purposes.

Refresh All View Refreshes the grid so that it displays themost up-to-
date information.

Replace Edit and
<right-click
menu>

In the <Resource> grid, opens the Replace dialog
box, enabling you to replace a field value in the grid.
For more details, see theHP Application Lifecycle
Management User Guide.

Select Columns View Opens the Select Columns dialog box, enabling you
to determine which fields to display in the grid and
their order. For details, see theHP Application
Lifecycle Management User Guide.

Set Filter/Sort View Enables you to filter and sort the resources in the
grid. Any currently applied filters or sorting orders are
displayed below the toolbar. For more details, see the
HP Application Lifecycle Management User Guide.

Hosts/Testing
Hosts module

Enables you to unregister a testing host, making it
unavailable for test execution.

Update Selected Edit and
<right-click
menu>

Opens the Update Selected dialog box, enabling you
to update a field value for amultiple selection in the
grid. For more details, see theHP Application
Lifecycle Management User Guide.

Hosts Module

Hosts/Testing Hosts ModuleWindow 69

Hosts Fields 71

New Testing Host Dialog Box 75

Testing Host Details Dialog Box 76

Event Log 79
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Processes Page 81

Services Page 82

Check Host Status Page 83

Over Firewall Page 85

Select Patch to Install Dialog Box 87

Hosts/Testing Hosts Module Window
This module enables you to view andmanage the hosts used for test execution.

To access Lab Management: On the sidebar, under Lab Resources, select Hosts.

ALM: On the sidebar, under Lab Resources, select Testing Hosts.

Important
information

Some elements are visible only for Performance hosts.

Lab Management: The Hosts module displays a list of all of the hosts
available.

ALM: The Testing Hosts module displays a list of all of the hosts in the
project's host pool.

ALM Editions: Some functionality related to Functional testing host
management is available only for ALM Edition.

Relevant tasks "How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Elements Description

<Hosts
module
common UI
elements>

l Host module fields. For field definitions, see "Hosts Fields" on next page.

l Host module menus and buttons. For command and button descriptions,
see "Lab Resources ModuleMenus and Buttons" on page 65.

<Hosts
grid>

Displays a list of the hosts in ALM.

Description
tab

Describes the currently selected host.

Tip: Right-click in this area to display a toolbar for formatting and spell-
checking the text.

Event Log
tab

Displays detailed information about the tasks performed on the selected host,
the action status, and a description of any errors. For details, see the "Event
Log" on page 79.

Installed PC
Components
tab

Displays a list of the PC components installed on the host machine, including
versions and patches.

Note: Available only for hosts with Performance purposes.

To refresh the grid, click .

Installed
Programs
tab

Displays a list of all of the programs installed on the host machine. Details
include the version, the publisher of the software, and the date it was installed in
the host machine.

Note: Available only for hosts with Performance purposes.

To refresh the grid, click .

Processes
tab

Displays detailed information about the processes and resource usage of the
selected host.

Note: Available only for hosts with Performance purposes.

For details, see "Processes Page" on page 81.

Services tab Displays the services running on the host machine.

Note: Available only for hosts with Performance purposes.

For details, see " Services Page" on page 82.
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UI Elements Description

Check Host
Status tab

Displays the status of each step of the host checks. To see host check status
details, right click a line in the Check Host Status tab, and select Check Hosts
Status Details. For details, see " Check Host Status Fields" on page 84.

Over
Firewall tab

For hosts over a firewall, enables you to configure advanced over-firewall
settings. For details, see " Over Firewall Page" on page 85.

Note: Available only for hosts with Performance purposes.

History tab Lists changes made to the currently selected host. For more details, see theHP
Application Lifecycle Management User Guide.

Hosts Fields
This section describes the host fields. In LabManagement, you canmodify the fields of private and
public hosts. In ALM, only the fields of private hosts can bemodified.

Field (A - Z) Description

Active
Timeslot ID

The ID of the timeslot for which this host is reserved, and which is now open.

Belongs to
Pools

The host pools to which the host is assigned.

Host pools enable you to control which hosts are allocated to which projects.
When allocating hosts for a test, the system allocates hosts from the project's
host pool. Hosts must be assigned to at least one pool.

Note: Private hosts can be assigned to only one pool.

Available from: LabManagement only.

Description A description of the host.

Enable SSL Indicates whether the load generator host will communicate with the Controller
via SSL (Secure Socket Layer) or not.

Note: The load generator uses SSL to communicate with the Controller
during runtime only. For non runtime functionality, such as including
collating results, the load generator does not use SSL as the
communication protocol.

Relevant only for load generator hosts located over a firewall .

HP ALM LabManagement (11.50)Page 71 of 231



HP ALM Lab Management Guide
Chapter 5: Lab Resources

Field (A - Z) Description

Host
Attributes

The system attributes of the host.

Example:Memory, strength, installed components

Tip: You can customize the host attributes in LabManagement. For details,
refer to theHP Application Lifecycle Management Administrator Guide.

Host ID The ID of the host.

Host State The current activity on the host.

l Idle. Indicates that the host is not being used.

l Installing. Indicates that a patch is being installed on the host.

l Rebooting. Indicates that the host is rebooting.

l <Run states>. Indicates the host state during a performance test run.

l <Data processing states>. Indicates the state of the host during a data
processing task.

Installation Indicates the type of host installation.

For a standalone installation of the load generator, selectWindows Standalone
LG.

Note: You cannot modify this field for an existing host.

Last
Configuration
Check

The last configuration check performed.

Last
Connectivity
Check

The last connectivity check performed.

Last
Installation
Check

The last installation check performed.

Last
Performance
Check

The last performance check performed.

Last Poll
Time

The last poll performed.

Last Run
Timeslot ID

The ID of the timeslot during which a performance test ran or data processing
occurred on the host.
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Field (A - Z) Description

Location The location of the host. For example, locations can be defined according to
physical areas.

The location also determines whether the host is located over a firewall. If so,
you need to select anMI Listener that will enable data collection.

MI Listener The IP address or name of theMI Listener that enables data collection.

Relevant only for hosts located over a firewall.

Name The name of the host.

Password The password of the Performance Center system user on the host machine.

Default:P3rfoRm@1nce

Note:

l The Performance Center system user name and password are displayed
only for UNIX hosts and for any hosts that weremigrated from earlier
versions of Performance Center.

l The system user name and password of newly addedWindows hosts
(details are not displayed here) are the same as the system user name
and password of the rest of the Performance Center system.

Priority A rank assigned to the host. The higher the priority you give the host, themore
likely the host will be allocated to a test. There are a number of criteria to
consider when assigning priority. Themain considerations are whether the host
is a dedicatedmachine or a shared resource, and the type of hardware installed
on themachine.

Privacy Type The privacy type of the host. You canmodify all hosts in LabManagement,
including private hosts. In ALM, you can only create andmodify private hosts
within the project's pool.

Note: Available only in LabManagement.

Purpose The functionality that the host can provide. For example: Controller, Load
generator, Data processor, QTP, Sprinter, etc.

Note:

l If the host machine is located over a firewall or is a UNIX machine, it
cannot function as a Controller or Data processor.

l If you selectedWindows Standalone LG orUnix Load Generator as
the installation option, Load Generator is automatically selected as the
purpose for the host and the other options are disabled.
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Field (A - Z) Description

Registration
Auto
Approve

Indicates whether the testing host will be automatically approved after it is
registered by HP ALM Lab Service.

For more details, see "Using HP ALM Lab Service" on page 226.

Registration
Status

The status of the host's registration. To be able to use the host for testing, you
must first register the host using HP ALM Lab Service and the host must be
approved by a Lab Administrator in LabManagement.

For more details, see "Using HP ALM Lab Service" on page 226.

Note: You cannot change theStatus of the host to "Operational" if the
Registration Status is "Not registered".

Status The status of the host. An indicator is displayed next to the host name,
indicating its current status.

The possible statuses are:

l Operational. The host machine is up and running.

l Non-operational. The host machine is down.

l Unavailable. There is no information available about the status of the host.

Username The name of the system user on the host machine.

Default: IUSR_METRO

Note:

l The system user name and password are displayed only for UNIX hosts
and for any hosts that weremigrated from earlier versions of Lab
Management.

l The system user name and password for newly addedWindows hosts
(details are not displayed here) are the same as the system user name
and password of the rest of the LabManagement system.
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New Testing Host Dialog Box
This dialog box enables you to create a testing host.

To access l Lab Management: Under Lab Resources, select Hosts. Then click theNew

Testing Host button.

l ALM:Under Lab Resources, select Testing Hosts. Then click theNew

Testing Host button

Important
information

l You can create new public hosts in LabManagement only. Hosts created in
ALM are considered private hosts and are added directly to the project's host
pool. You canmodify private hosts in ALM.

l You can only create a host over a firewall if it is given the Load generator
purpose.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.
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UI
Elements

Description

Spelling Options. Enables you to configure how to check the spelling.

Name The name of the new host.

Tip: Give the host ameaningful name. This can be derived from the location,
purpose, type, identity, or operating system of the host. Themore information
provided with the name, the easier it is to use andmaintain the system. Make
sure that the name is easy to remember and not too long.

Caution: For remote hosts being used for functional tests,this must be the name
of the computer without the domain name. If the name entered does not match
the name of the host you are trying to register, registration will fail.

Details Required fields aremarked with an asterisk (*) and are displayed in red. For details on
the available host fields, see "Hosts Fields" on page 71.

Testing Host Details Dialog Box
This dialog box displays details about a selected host.

To access l Lab Management: Under Lab Resources, select Hosts. Right-click on a
host in the grid and select Testing Host Details.

l ALM:Under Lab Resources, select Testing Hosts. Right-click on a host in
the grid and select Testing Host Details.

Important
information

l This dialog box is available both in LabManagement and in ALM.

l Some elements are available only forPerformance hosts.
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Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse through the list of
hosts.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure how to check the spelling.

Host ID The ID of the host.

Name The name of the host.

Details Lists the details of the currently selected host. For details on the available
fields, see "Hosts Fields" on page 71.

Installed PC
Components

Displays a list of the Performance Center components installed on the host,
including version and patches.

Note:

l Use the navigation bar at the bottom of the page to view all the
entries.

l Available only for hosts with Performance purposes.

Event Log Displays detailed information about the tasks performed on the selected
host, the event status, and a description of any errors. For details, see
"Event Log" on page 79.

Installed
Programs

Displays a list of all of the programs installed on the host machine. Details
include the version, the publisher of the software, and the date it was
installed in the host machine.

Note:

l Use the navigation bar at the bottom of the page to view all the
entries.

l Available only for hosts with Performance purposes.
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UI Elements Description

Processes Displays detailed information about the processes and resource usage of the
selected host. For details, see "Processes Page" on page 81.

Note:

l Use the navigation bar at the bottom of the page to view all the
entries.

l Available only for hosts with Performance purposes.

Services Displays the services running on the host machine. For details, see "
Services Page" on page 82.

Note:

l Use the navigation bar at the bottom of the page to view all the
entries.

l Available only for hosts with Performance purposes.

Check Hosts
Status

Displays the status of each step of the host checks. To see host check
status details, right click a line in the Check Host Status tab, and select
Check Host Status Details. For details, see " Check Host Status Fields"
on page 84.

Runs Displays detailed information about test runs performed on the selected
host. For details, see "PC Test Runs ModuleWindow" on page 106.

Note: Use the navigation bar at the bottom of the page to view all the
entries.

Over Firewall For hosts over a firewall, enables you configure advanced over-firewall
settings. For details, see " Over Firewall Page" on page 85.

Note: Available only for hosts with Performance purposes.

History Lists changes made to the currently selected host. For more details, see the
HP Application Lifecycle Management User Guide.
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Event Log
The Event Log displays the events that occur in a project, reporting the source and severity of each
event.

To access Use one of the following:

l Select Tools > Event Log.

l Select theEvent Log tab.

Available from the followingmodules:

n In Lab Management. Hosts, PC Test Runs, Timeslots, PC Servers.

n In the ALM project. Timeslots (Grid view only), Hosts, Test Runs.

Important
information

l The Event Log is only available in the Grid view.

l The Event Log displays information for the relevant selection. That is, it
displays events for an entire project, timeslot, host, server, and so on.

l The time interval in days that deletable events remain in the EVENT_LOG
database table is determined by the EVENT_LOG_PURGE_PERIOD_DAYS
parameter. For details, see theHP Application Lifecycle Management
Administrator Guide.

User interface elements are described below:

UI Elements
(A - Z)

Description

Set Filter. Enables you to filter and sort the resources in the event log. Any
currently applied filters or sorting orders are displayed below the toolbar. For more
details, see theHP Application Lifecycle Management User Guide.
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UI Elements
(A - Z)

Description

Select Columns. Opens the Select Columns dialog box, enabling you to
determine which fields to display in the event log, and their order. For more
details, see theHP Application Lifecycle Management User Guide.

Refresh. Refreshes the event log so it displays themost up-to-date information.

Export. Opens the Export All Grid Data dialog box, enabling you to export the
resources in the grid as a text file, Microsoft Excel worksheet, Microsoft Word
document, or HTML document.

Action The category of action where the event occurred.

Example. Create Server

Context The specific entity where the event occurred.

Example. PC Server: VM05

Creation
Date

The date and time the event was logged.

Description A description of the event.

Event Log
ID

The event ID.

Event Name The name of the event.

Event Type An indication of the event's severity. Frommost to least severe: error, warning, or
info.

Flow
Context ID

A GUID that indicates a unique action which relates to several events. For
example, running a test.

Module The ALMmodule where the event originated.

Example. Testing

Project
Name

The project in which the event occurred.

Responsible The user, or automated system process responsible for the event.

Source The system element where the event originated.

Sub Module The ALM submodule where the event occurred.

Example. Test Lab
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Processes Page
This page displays detailed information about the processes and resource usage of the selected
host.

To access l From the Hosts module: On the sidebar, under Lab Resources, select
Hosts. In the information panel, select Processes.

l From the Host Details dialog box: On the sidebar, under Lab Resources,
select Hosts. Right-click a host and select Host Details. In the Host Details
dialog box, select Processes.

Important
information

l ALM is unable to display processes and resource usage information for UNIX
machines orWindows Standalone LoadGenerators.

l The Processes page is available only for Performance hosts.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Refresh. Refreshes the grid so it displays themost up-to-date information.

Kill Process. Ends the process selected in the grid.

l Hosts module. Kill Process permissions are required to end the selected
process.

l Lab Management Servers module. A user with Viewer permissions has the
ability to end the selected process.

Auto
Refresh

Refreshes the grid automatically after the selected time interval has passed.
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UI Elements Description

<Processes
grid>

Displays the following details about the processes:

l Name. The name of the process.

l PID. The process ID.

l Processor Time (%). The percentage of processor time used by the process.

l Memory Usage (KBytes). The amount of memory (in kilobytes) used by the
process.

l Elapsed Time (d.hh:mm:ss). The amount of elapsed time since the start of
the process, where d is the number of days and hh:mm:ss is the number of
hours, minutes, and seconds that have elapsed.

<Navigation
area>

Enables you to navigate through the pages of entries in the grid. The total number
of entries is displayed on the right of the navigation area.

Located at the bottom of the page.

Services Page
This page displays the services on the selected host.

To access l Hosts module: On the sidebar, under Lab Resources, select Hosts. In the
information panel, select Services.

l Host Details dialog box:On the sidebar, under Lab Resources, select
Hosts. Right-click a host and select Host Details. In the Host Details dialog
box, select Services.

Important
information

The Services page is available only for Performance hosts.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Refresh. Refreshes the grid so it displays themost up-to-date information.

Name The name of the service.

Display
Name

The full name of the service.

Status The status of the service: Running orStopped.

Startup
Type

The way the service is set to start up:

l Auto. Service starts up automatically.

l Disabled. Service is disabled.

l Manual. Servicemust be startedmanually.

<Navigation
area>

Located at the bottom of the page, enables you to navigate through the pages of
entries in the grid. The total number of entries is displayed on the right of the
navigation area.

Check Host Status Page
This page displays the status of checks on the selected host.

To
access

l From theHostsmodule: On the sidebar, under Lab Resources, select Hosts.
Select a host, and in the information panel, select Check Host Status.

l From the Host Details dialog box:On the sidebar, under Lab Resources,
select Hosts. Right-click a host and select Host Details. In the Host Details
dialog box, select Check Host Status.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Elements

Description

Check Host Status Details. Opens the Check Host Status Details dialog box,
enabling you to view each check's details. For field details, see " Check Host Status
Fields" below.

Refresh. Refreshes the grid so it displays themost up-to-date information.

Set Filter/Sort. Enables you to filter and sort the grid. Any currently applied filters or
sorting orders are displayed below the toolbar. For details, see theHP Application
Lifecycle Management User Guide.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For details, see theHP Application
Lifecycle Management User Guide.

Find. Opens the Find dialog box, enabling you to search for a check. For details, see
theHP Application Lifecycle Management User Guide.

<Check
Host
Status
grid>

Displays the status of the host checks. Click to select columns to display in
the grid. For details about the fields, see " Check Host Status Fields" below.

Check Host Status Fields

The following fields are displayed in the Check Host Status page:

Field
(A - Z)

Description

Actual
Value

Actual value resulting from the host connectivity check.

Category The areas in which the Check Host feature checks the host:

l Configuration

l Connectivity

l Installation

l Performance

Check The sub-areas in which the Check Host feature checks the hosts. For example, sub-
areas in the Performance check areProcessor,Memory, System,

Check
Date

The date the host was checked.
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Field
(A - Z)

Description

Check
Result
ID

The ID of each step of the host check.

Error If an error occurred during the check, displays the error.

Expected
Value

Value expected to result from the host check.

Status Indicates whether the host check passed or failed.

Over Firewall Page
This page displays communication settings between the Performance Center load generator host
and theMI Listener, and enables you to configure advanced over-firewall settings for the selected
load generator host.

To access l From the Hosts module:On the sidebar, under Lab Resources, select
Hosts. In the information panel, select Over Firewall.

l From the Host Details dialog box:On the sidebar, under Lab Resources,
select Hosts. Right-click a host and select Host Details. In the Host Details
dialog box, select Over Firewall.

Important
information

l This page displays information if the location of the host is defined to be over a
firewall.

l A host over a firewall can be used only as a load generator host.

l TheOver Firewall page is available only for Performance hosts.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below:

UI
Elements
(A - Z)

Description

Connection
Timeout
(seconds)

The length of time that the agent waits before retrying to connect to theMI Listener
machine. If zero, the connection is kept open from the time the agent is run.

Default: 20 seconds.

Note: This is a required field.
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UI
Elements
(A - Z)

Description

Connection
Type -
TCP/HTTP

Select either TCP orHTTP, depending on the configuration you are using.

Default: TCP

HTTP HTTP settings for the HTTP connection type:

l Proxy Name. The name of the proxy server. This field is mandatory if the
Connection Type option is set toHTTP.

l Proxy Port. The proxy server connection port. This field is mandatory if the
Connection Type option is set toHTTP.

l Proxy Username. The user name of a user with connection rights to the proxy
server.

l Proxy password. The password of the user with connection rights to the proxy
server.

l Proxy domain. The user's domain, if defined in the proxy server configuration.
This option is required only if NTLM is used.

MI Listener
Password

The password required to connect to theMI Listener machine.

MI Listener
User Name

The user name required to connect to theMI Listener machine.

Polling
Timeout
(seconds)

To verify the state of the load generator located over a firewall, ALM checks when
last the load generator connected to theMI Listener.

If the load generator has not connected to theMI Listener machine for a period of
time longer than the amount of time set in thePolling Timeout, LabManagement
changes the state of the load generator toResource Failure.

Default: 60 seconds

Note:

l This is a required field.

l Polling Timeout is an ALM setting. It is not set in the Performance Center
agent.

l Polling Timeout needs to be longer than the Connection Timeout,
described below.
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UI
Elements
(A - Z)

Description

Use secure
connection

Enables connection using the Secure Sockets Layer (SSL) protocol.

Default: Disabled

l Check server certificates. Authenticates the SSL certificates that are sent by
the server. SelectMedium to verify that the server certificate is signed by a
trusted Certification Authority. Select High to verify that the sender IP matches
the certificate information. This setting is available only if Use Secure
Connection is set to True.

l Private Key password. The password that may be required during the SSL
certificate authentication process. This option is relevant only if theClient
Certificate Owner option is enabled.

l Use client certificate. Enable to load the SSL certificate (if required by the
server to allow the connection to bemade). This option is relevant only if the
Use Secure Connection option is enabled.

Default:Disabled

Select Patch to Install Dialog Box
This dialog box enables you to install patches on Performance hosts.

To access 1. On the LabManagement sidebar, under Lab Resources, select Hosts.

2. Right-click the host grid and select Install Patch.

Tip: You can install a patch onmultiple hosts simultaneously. To select
multiple hosts, hold down the CTRL key on your keyboard while selecting the
hosts.
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Important
information

l You can install patches in LabManagement only.

l To install patches on a host, the patches first need to have been uploaded to
ALM. For details, see "How to Upload Patches to ALM" on page 167.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Patches grid> Displays the patches available in ALM to install on the selected host.

Pools Module

Pools ModuleWindow 88

Pools Fields 90

New Host Pool Dialog Box 90

Host Pool Details Dialog Box 91

Add Hosts to Pool Dialog Box 93

Linked Hosts Page 94

Pools Module Window
This module enables you to view andmanage host pools.
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To access On the LabManagement sidebar, under Lab Resources, select Pools.

Important
information

A host pool is a groups of hosts. Each project has one host pool.

HP ALM Performance Center Edition:Whenmanaging a host pool with
performance hosts, it is important to understand the total available resources. The
host pool must contain at least one Controller, one load generator, and one data
processor. Because hosts can have dual functionality, it is recommended that a
pool contains, among the other hosts, at least one host that can be dedicated fully
for Controller functionality.

A private host can only exist in one pool at a time.

You can add hosts to a host pool in a few different ways. See "How toManage Lab
Resources" on page 57.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Host Pools module
common UI
elements>

l Pools module fields. For field definitions, see "Pools Fields" on
next page.

l Pools module menus and buttons. For command and button
descriptions, see "Lab Resources ModuleMenus and Buttons" on
page 65.

<Host Pools grid> Displays a list of the host pools defined in ALM.

Description tab Describes the currently selected host pool.

Tip: Right-clicking in this area displays a toolbar for formatting
and spell checking the text.

Linked Hosts tab Enables you to add hosts to the selected pool and remove hosts from
the pool. For details, see "Linked Hosts Page" on page 94.

History tab Lists changes made to the currently selected host pool. For more
details, see theHP Application Lifecycle Management User Guide.
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Pools Fields
This section describes the host pool fields:

Field (A - Z) Description

C+LG
Hosts

The number of hosts with both Controller and LoadGenerator purposes in the host
pool.

Controller
Hosts

The number of Controller hosts in the host pool.

Description A description of the host pool.

DP Hosts The number of Data processor hosts in the host pool.

LG Hosts The number of Load generator hosts in the host pool.

Pool ID The ID of the host pool.

Pool Name The name of the host pool.

Note: The namemay contain up to 255 characters, excluding spaces,
periods, and any of the following characters:

: ; * \ / " ~ & ? { } $% | < > + = ^ [ ] ( )

Total Hosts The total number of hosts in the host pool.

New Host Pool Dialog Box
This dialog box enables you to add a host pool to ALM.
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To access 1. On the LabManagement sidebar, under Lab Resources, select Pools.

2. In the Pools module, click theNew Host Pool button.

Important
information

Each project has one host pool, whichmust contain at least one Controller, one
load generator, and one data processor host.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure how to check the spelling.

Pool
Name

The name for the new host pool.

Details Required fields aremarked with an asterisk (*) and are displayed in red. For details on
the available host pool fields, see "Pools Fields" on previous page.

Host Pool Details Dialog Box
This dialog box displays details about a selected host pool.
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To access 1. On the LabManagement sidebar, under Lab Resources, select Pools.

2. Right-click a host pool in the grid and select Host Pool Details.

Important
information

l A host pool is a groups of hosts. Each project has one host pool.

l Whenmanaging a host pool, it is important to understand the total available
resources. The pool must contain at least one Controller, one load generator,
and one data processor. Because hosts can have dual functionality, it is
recommended that a pool contains, among the other hosts, at least one host
that can be dedicated fully for Controller functionality.

l A private host can only exist in one pool at a time.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below:

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse through the list of
host pools.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure how to check the spelling.

Pool Name The name of the host pool.

Details Lists the details of the selected host pool. For details on the available fields,
see "Pools Fields" on page 90.

Linked Hosts Enables you to add hosts to the selected pool and remove hosts from the
pool. For details, see "Linked Hosts Page" on page 94.

History Lists changes made to the currently selected host pool. For more details,
see theHP Application Lifecycle Management User Guide.
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Add Hosts to Pool Dialog Box
This page enables you to select hosts to add to a host pool.

To access l From the Pools module:

On the LabManagement sidebar, under Lab Resources, select Pools. In the

information panel, select Linked Hosts and click theAdd Hosts to Pool
button.

l From the Host Pool Details dialog box:

On the LabManagement sidebar, under Lab Resources, select Pools. Right-
click a host pool and select Host Pool Details. In the Host Pool Details dialog

box, select Linked Hosts and click theAdd Hosts to Pool button.

Important
information

Alternatively, you can link a single host to multiple host pools from theBelongs
To Pools field in the host's details. For details, see "Hosts Fields" on page 71.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Refresh All. Refreshes the grid so it displays themost up-to-date information.
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UI
Elements

Description

Select Columns. Opens the Select Columns dialog box, enabling you to
determine which fields to display in the grid and their order. For details, see theHP
Application Lifecycle Management User Guide.

Set Filter/Sort. Enables you to filter and sort the grid. Any currently applied filters
or sorting orders are displayed below the toolbar. For details, see theHP
Application Lifecycle Management User Guide.

Adds the selected hosts to the host pool.

<Hosts
grid>

Lists the hosts available to add to the host pool.

Selected Displays the hosts selected to add to the pool.

Linked Hosts Page
This page enables you to add hosts to a host pool, and remove hosts from a pool.

To access l From the Pools module:On the LabManagement sidebar, under Lab
Resources, select Pools. In the information panel, select Linked Hosts.

l From the Host Pool Details dialog box:On the LabManagement sidebar,
under Lab Resources, select Pools. Right-click a host pool and select Host
Pool Details. In the Host Pool Details dialog box, select Linked Hosts.

Important
information

The Linked Hosts page enables you to link multiple hosts to a host pool.

Alternatively, you can link a single host to multiple host pools from theBelongs
To Pools field in the host's details. For details, see "Hosts Fields" on page 71.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Elements

Description

Add Hosts to Pool. Opens the Add Hosts to Pool dialog box, enabling you to select
hosts to add to the host pool. For details, see " Add Hosts to Pool Dialog Box" on
page 93.

Remove Host. Removes the selected hosts from the host pool.

Go to Host. Displays the selected linked host in the Hosts module.

Host Details. Opens the Host Details dialog box, enabling you to view details about
the selected linked host. For details, see " Testing Host Details Dialog Box" on page
76.

Refresh All. Refreshes the grid so it displays themost up-to-date information.

Set Filter/Sort. Enables you to filter and sort the grid. Any currently applied filters or
sorting orders are displayed below the toolbar. For details, see theHP Application
Lifecycle Management User Guide.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For details, see theHP Application
Lifecycle Management User Guide.

Find. Opens the Find dialog box, enabling you to search for a host. For details, see
theHP Application Lifecycle Management User Guide.

<Linked
Hosts
grid>

Lists the hosts that belong to the host pool.

Locations Module

Locations ModuleWindow 95

Locations Fields 97

New Host Location Dialog Box 97

Host Location Details Dialog Box 98

Locations Module Window
This module enables you to view andmanage host locations.
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To access On the LabManagement sidebar, under Lab Resources, select Locations.

The Locations module is only available from LabManagement.

Relevant tasks "How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Locations module
common UI
elements>

l Locations module fields. For field definitions, see "Locations
Fields" on next page.

l Locations module menus and buttons. For command and button
descriptions, see "Lab Resources ModuleMenus and Buttons" on
page 65.

<Host Locations
grid>

Displays a list of the host locations defined in ALM.

Description tab Describes the currently selected host location.

Tip: Right-clicking in this area displays a toolbar for formatting and
spell checking the text.

History tab Lists changes made to the currently selected host location. For more
details, see theHP Application Lifecycle Management User Guide.
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Locations Fields
This section describes the host location fields:

Field (A - Z) Description

Description A description of the host location.

Location ID The ID of the host location.

Location
Name

The name of the host location. The name should have a logical connection to the
host location.

Over
Firewall

Indicates whether the host location is over a firewall.

New Host Location Dialog Box
This dialog box enables you to add a host location to ALM.

To access 1. On the LabManagement sidebar, under Lab Resources, select
Locations.

2. In the Locations module, click theNew Host Location button.

Relevant tasks "How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below:
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UI
Elements

Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure how to check the spelling.

Location
Name

The name for the new host location.

Details Required fields aremarked with an asterisk (*) and are displayed in red. For details on
the available host location fields, see "Locations Fields" on previous page.

Host Location Details Dialog Box
This dialog box displays details about a selected host location.

To access 1. On the LabManagement sidebar, under Lab Resources, select
Locations.

2. Right-click a location in the grid and select Host Location Details.

Important
information

Host locations must be defined before you can select them in a host's
details.

Relevant tasks "How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55
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User interface elements are described below:

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse through the list of
host locations.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure how to check the spelling.

Location ID The ID of the host location.

Location Name The name of the host location.

Details Lists the details of the currently selected host location. For details on the
available fields, see "Locations Fields" on page 97.

History Lists changes made to the currently selected host location. For more details,
see theHP Application Lifecycle Management User Guide.

MI Listeners Module

MI Listeners ModuleWindow 100

MI Listener Fields 101

New MI Listener Dialog Box 102

MI Listener Details Dialog Box 103
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MI Listeners Module Window
This module enables you to view andmanageMI Listeners. MI Listeners enable running
performance tests on hosts over a firewall and collecting server monitor data and application
diagnostics data over a firewall.

To access On the LabManagement sidebar, underPerformance Center, select
MI Listeners.

TheMI Listeners module is only available from LabManagement.

Important
information

l For detailed information about configuring ALM to work with firewalls, see the
section about working with firewalls in theHP ALM Performance Center
Installation Guide.

l If anMI Listener is being used by a host, it cannot be deleted.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A - Z) Description

<MI Listeners
module common UI
elements>

l MI Listeners module fields. For field definitions, see "MI Listener
Fields" on next page.

l MI Listeners module menus and buttons. For command and
button descriptions, see "Lab Resources ModuleMenus and
Buttons" on page 65.

<MI Listeners grid> Displays a list of theMI Listeners in ALM.
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UI Elements (A - Z) Description

Description tab Describes the currently selectedMI Listener.

Tip: Right-clicking in this area displays a toolbar for formatting and
spell checking the text.

History tab Lists changes made to the currently selectedMI Listener. For more
details, see theHP Application Lifecycle Management User Guide.

MI Listener Fields
This section describes theMI Listener fields:

Field (A - Z) Description

Description A description of theMI Listener.

MI Listener
ID

The ID of theMI Listener.

MI Listener
IP

The IP address of theMI Listener.

Note: If you have two different IP addresses for the sameMI Listener—one
for internal communication with the Controller and a second for public
communication with a Load generator located over a firewall—enter the
internal IP address here. Enter the public IP address in theMI Listener
Name field (see below).

MI Listener
Name

The name of theMI Listener.

Note: If you have two different IP addresses for the sameMI Listener—one
for internal communication with the Controller and a second for public
communication with a load generator located over a firewall—enter the public
IP address here. Enter the internal IP address in theMI Listener IP field (see
above).

Purpose The role designated to theMI Listener:

l Diagnostics data collection over a firewall

l Monitoring over a firewall

l Running hosts over a firewall
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New MI Listener Dialog Box
This dialog box enables you to add anMI Listener to ALM.

To access 1. On the LabManagement sidebar, underPerformance Center, select
MI Listeners.

2. In theMI Listeners module, click theNew MI Listener button.

Important
information

MI Listeners enable running Vusers over a firewall and collecting server monitor
data and application diagnostics data over a firewall.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below:

UI
Elements

Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure how to check the spelling.
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UI
Elements

Description

MI Listener
Name

The name for the new MI Listener.

Details Required fields aremarked with an asterisk (*) and are displayed in red. For details
on the available MI Listener fields, see "MI Listener Fields" on page 101.

MI Listener Details Dialog Box
This dialog box displays details about the selectedMI Listener.

To access 1. On the LabManagement sidebar, underPerformance Center, select
MI Listeners.

2. Right-click anMI Listener in the grid and select MI Listener Details.

Important
information

MI Listeners enable running tests on hosts over a firewall and collecting server
monitor data and application diagnostics data over a firewall.

Relevant
tasks

"How toManage Lab Resources" on page 57

See also "Lab Resources Overview" on page 55

User interface elements are described below:

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse through the list of
MI Listeners.

Spell Check. Checks the spelling for the selected word or text box.
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UI Elements Description

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure how to check the spelling.

MI Listener ID The ID of theMI Listener.

MI Listener Name The name of theMI Listener.

Details Details the currently selectedMI Listener. For details on the available fields,
see "MI Listener Fields" on page 101.

History Lists changes made to the currently selectedMI Listener. For more details,
see theHP Application Lifecycle Management User Guide.

Troubleshooting and Limitations
This section describes troubleshooting and limitations for lab resources.

Resource Failure
When running a test on the set of allocated hosts, if any of the hosts fail, the status of the hosts
changes fromOperational toNon-operational, and an error log describing the problem is sent to
the Event Log.

You can try to fix the problem according to the description in the error log, then change the status
back toOperational. If the host is still not operational, the status automatically returns toNon-
operational in the next test run.

If the Resource Recovery task and theOFW Status Update task (for hosts over a firewall) are
enabled in the Lab Management > Lab Settings > Maintenance Tasks tab, ALM automatically
detects host resource failure and attempts to restore the host toOperational status.
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PC Test Runs
This chapter includes:

PC Test Runs Module Overview 105

PC Test Runs User Interface 105

PC Test Runs Module Overview
The PC Test Runs module displays information for all test runs across all projects in the system. It
enables you to view detailed information relating to the run state of the test, the Vusers involved, as
well as host and timeslot information. You can also drilldown and view details of specific events for
each test via the Event Log.

PC Test Runs User Interface
This section includes:

PC Test Runs ModuleWindow 106

PC Test Runs Module Fields 106

PC Test Runs ModuleMenus and Buttons 108

Run Details Dialog Box 110
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PC Test Runs Module Window
This module displays information for individual test runs across all projects in the system.

To
access

On the LabManagement sidebar, underPerformance Center, select PC Test
Runs.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<PC Test Runs
module common UI
elements>

l PC Test Runs module fields. For field definitions, see "PC Test
Runs Module Fields" below.

l PC Test Runs module menus and buttons. For command and
button descriptions, see "PC Test Runs ModuleMenus and
Buttons" on page 108.

l ALM main menu and sidebar. For details on the Tools menu,
Helpmenu and sidebar, see theHP Application Lifecycle
Management User Guide.

<PC Test Runs grid> Displays a list of test runs across all projects, displaying detailed
information for each test run.

<Information panel> Located in the lower area of themodule. Displays the Event Log tab.
For more information, refer to theHP ALM Performance Center Guide.

PC Test Runs Module Fields
The following fields are available in the PC Test Runs module:

Field Description

Average Vusers The average number of concurrently running Vusers during the run.

Controller The Controller involved in the test run.

HP ALM LabManagement (11.50)Page 106 of 231



HP ALM Lab Management Guide
Chapter 6: PC Test Runs

Field Description

Domain/Project The test's domain and project

Duration The time, in minutes, that the test took to run.

Note: You should not manually edit this field.

End Date The end date of the run.

Note: You should not manually edit this field.

Involved Vusers The number of Vusers that were initialized at least once during the run.

Load Generators The load generators involved in the test run.

Max Vusers Themaximum number of concurrently running Vusers during the run.

Project ID The test's project ID.

Run ID The identification number of the test run. This number is automatically
generated by the system when the load test starts running

Run Name The test run name.

Run State The state of the test run. If a test is stuck in a particular state, you can
change it.

Start date The start date of the run.

Note: You should not manually edit this field.

Start time The start time of the run.

Note: You should not manually edit this field.

Temp Results
Directory Path

The path of the directory where the test results are temporarily stored.

Test Name The name given to the test when it was created.

Tester The name of the user running the test.

Consume VUDs The number of VUDs used in the test run.

Timeslot ID The ID of the test run timeslot.

HP ALM LabManagement (11.50)Page 107 of 231



HP ALM Lab Management Guide
Chapter 6: PC Test Runs

PC Test Runs Module Menus and Buttons
This section describes themenus and buttons available in the PC Test Runs module.

To
access

On the LabManagement sidebar, underPerformance Center, select PC Test
Runs.

Commonmenus and toolbars of the PC Test Runs module are described below:

UI Elements (A - Z) Where Description

Stop Run

<right-
click
menu>

Stops a currently running test.

Note: Only enabled when the selected test run is in the
Initializing, Running orStopping states.

Add to Favorites Favorites Opens the Add Favorite dialog box, enabling you to add a
favorite view to your private or the public folder. For details,
see theHP Application Lifecycle Management User Guide.

Copy URL

Runs
and
<right-
click
menu>

Copies a selected test run and pastes its URL as a link.
The test run itself is not copied. Instead, you can paste the
address into another location, such as an email or a
document. Clicking the link opens up ALM and takes you to
the test run file or folder. If you are not already logged in,
ALM first prompts for login details.

Delete

Edit and
<right-
click
menu>

Deletes the selected test run.

Note: Only enables when the selected test run is not in
one of the active states.

<right-
click
menu>

If you analyze a test run after it has run, or recalculate the
SLA, or add the test run to a trend report, then the action is
added to a data processing queue, enabling you to see
when the action will be performed.

Export Runs
and
<right-
click
menu>

Opens the Export All Grid Data dialog box, enabling you to
export the test runs in the grid as a text file, Microsoft Excel
worksheet, Microsoft Word document, or HTML document.

Choose one of the following options:

l All. Exports all test runs in the grid.

l Selected. Exports selected test runs in the grid.

Find

View Opens the Find dialog box, enabling you to search for test
runs in themodule. For details about search options, see
theHP Application Lifecycle Management User Guide.
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UI Elements (A - Z) Where Description

Go to Run

Runs Opens theGo ToRun dialog box, enabling you to find a
specific test run by its ID number. You can only go to test
runs that are in the current filter.

Go to Timeslot

<right-
click
menu>

Opens the Timeslots module, displaying the timeslot for the
selected test run.

Grid Filters View and
<right-
click
menu>

Enables you to filter the data according to an entry in the
filter box. For details about filtering options, see theHP
Application Lifecycle Management User Guide.

Information Panel View and
<right-
click
menu>

Shows/Hides the Information Panel in the lower area of the
module.

Organize Favorites Favorites Opens theOrganize Favorites dialog box, enabling you to
organize the list of favorite views by changing properties or
deleting views. For details, see theHP Application
Lifecycle Management User Guide.

Private Favorites Lists the favorite views that are accessible only to the user
who created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All

View Refreshes the grid so that it displays themost up-to-date
information.

Run Details

Runs
and
<right-
click
menu>

Opens the Run Details dialog box, enabling you to view and
edit details of the selected test run.

Run Screen

<right-
click
menu>

Opens the Performance Test Run screen, enabling you to
view andmanage the test run. For more information, refer to
theHP ALM Performance Center Guide.

Note: Only enabled when test run is in theRunning
state.
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UI Elements (A - Z) Where Description

Select Columns

View Opens the Select Columns dialog box, enabling you to
determine which fields to display in the grid and their order.
For more details, see theHP Application Lifecycle
Management User Guide.

For details about the test run fields, see "PC Test Runs
Module Fields" on page 106.

Set Filter/Sort

View Enables you to filter and sort the test runs in the grid. Any
currently applied filters or sorting orders are displayed
below the toolbar. For more details, see theHP Application
Lifecycle Management User Guide.

Run Details Dialog Box
This dialog box displays test run details.

To
access

1. On the LabManagement sidebar, under Performance Center, select PC Test
Runs.

2. Right-click a test run in the grid, and select Run Details.

User interface elements are described below:

UI Elements
(A - Z)

Description

First/Previous/Next/Last Entity. Enables you to browse through the list of
projects.
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UI Elements
(A - Z)

Description

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure how to check the spelling.

Details Displays the details of the selected test run. For more details, see "PC Test
Runs Module Fields" on page 106.

Event Log Lists the events that occurred during the selected test run. For more details,
see "Event Log" on page 79.

History Lists changes made to the selected test run. For more details, see theHP
Application Lifecycle Management User Guide.

HP ALM LabManagement (11.50)Page 111 of 231



HP ALM Lab Management Guide
Chapter 6: PC Test Runs

HP ALM LabManagement (11.50)Page 112 of 231



Chapter 7

Usage Reports
This chapter includes:

Usage Reports Overview 113

How to View Reports and Set Report Filter Criteria 114

How to Export Reports to PDF or Excel Formats 115

Usage Report Time Frames 115

Usage Reports User Interface 115

Troubleshooting and Limitations 135

Usage Reports Overview
The ALM Performance Center Usage Reports provide you with an overall analysis of Performance
Center site users, resource usage, concurrent resource usage vs. license limitations, timeslot
usage, as well as resource usage by duration and runs.

The following table provides a description of each report:

Report Description

Resource
Summary

Provides aggregate data regarding the way projects used the various resources
of the system.

Concurrency
vs. License

Provides details of concurrent resource usage per project, as well as information
regarding how system resources were used within license limitations.

Timeslot
Usage

Provides information about the reservation and usage of resources associated
with timeslots.

Resource by
Duration

Provides general information about the usage of your system resources over the
selected time frame. You can view statistics for total usage by project, or per
user within a project.

Resource by
Runs

Provides general information about the test runs. You can view statistics for total
usage by project, or per user within a project.

VUDs
License
Usage per
Project

Provides information about VUD usage per day for each selected project.

Daily VUDs
License
Usage

Provides information about VUD usage per day, aggregated across all projects.
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For information about how to view the reports, see "How to View Reports and Set Report Filter
Criteria" below.

How to View Reports and Set Report Filter
Criteria

This task describes how to view the Usage Reports and how to set their filter criteria. The filter
criteria defines which projects are to be included in the reports and over which time frame to display
results.

Note: This task is part of a higher-level task. For details, see "How toWork with Lab
Management Administration" on page 22.

To learnmore about ALM Performance Center reports, see "Usage Reports Overview" on previous
page.

1. Select the desired report to view
In LabManagement, underPerformance Center select Usage Reports to view the ALM
Performance Center reports tree. From the tree, select the desired report to view.

For a description of each report's user interface elements, see "Usage Reports User Interface"
on next page.

2. Filter the projects to include in the report
Perform the following steps:

a. Click theSelect Projects button

adjacent to the Projects box.

b. In the Project Selection dialog box, use the arrow buttons to select single or multiple
projects from theAvailable projects list.

Note: Youmust select at least one project to generate a report.

3. Select the desired time range for the report
Select the desired time frame for the report from the Time Frame drop down list. In addition to
the given options, you can set a custom time frame.

For an explanation of the given time frames, see "Usage Report Time Frames" on next page.

4. Update the report to reflect the new filter settings
Click Generate. The report displays the information for the selected projects and time frame.
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How to Export Reports to PDF or Excel
Formats

The following task describes how to export a Performance Center report to either PDF or Excel
format.

Note: This task is part of a higher-level task. For details, see "How toWork with Lab
Management Administration" on page 22.

Export a report to PDF

To export a report to a PDF file, click the Export to PDF icon in the upper right corner of the
report.

Export a report to an editable Excel file

To export a report to an editable Excel file, click the Export to Excel icon in the upper right
corner of the report.

Usage Report Time Frames
The following table provides an explanation of the time frames available for report selection.

Time Frame Explanation

Today From 00.00 to 23.59 of the current day

Yesterday From 00.00 to 23.59 of the previous day

This week FromMonday to Sunday of the current week

Previous week FromMonday to Sunday of the previous week

This month From beginning to end of the current calendar month

Previous month From beginning to end of the previous calendar month

This quarter The current quarter

Previous quarter The previous quarter

This year From January to December of the current year

Previous year From January to December of the previous year

Usage Reports User Interface
This section includes:

Project Selection Dialog Box 116
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Concurrency vs. License Report 117

Resource Summary Report 123

Timeslot Usage Report 125

Resource by Duration Report 128

Resource Usage by Runs Report 130

VUDs License Usage per Project Report 132

Daily VUDs License Usage Report 134

Project Selection Dialog Box
This dialog box enables you to select projects to be included in the reports.

To access In any of the reports, click theSelect Projects button adjacent to the
Projects box.

Important
information

At least one project must be selected in order to generate a report.

Relevant tasks "How to View Reports and Set Report Filter Criteria" on page 114

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A - Z) Description

Filters theAvailable projects list. The filter supports partial text
entries.

Click to select or deselect individual projects respectively.

Click to select or deselect all projects respectively.

Available projects
list

Projects that are available for selection.

Selected projects list The projects that have already been selected.

Default:All the available projects are automatically selected.
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Concurrency vs. License Report
The Concurrency vs. License Report provides details of concurrent resource usage per project, as
well as information regarding how system resources were used within license limitations.

To access 1. Select Performance Center> Usage Reports

2. In the list of Usage Reports, select
Concurrency vs. License

Relevant tasks "How to View Reports and Set Report Filter Criteria" on page 114

User interface elements are described below:

UI Elements
(A - Z) Description

Export to PDF/Excel. Click to export the report to PDF or Excel format.

Generates the report.

Concurrency
by Project
tab

Contains a table that displays concurrent resource usage information for each
selected project.

For more information, see "Concurrency by Project Table" on next page below.

Filter by:
Projects

Click the browse button by this field to select which project to include in the
report.

Filter by:
Time Frame

Select the desired time frame for the report. For an explanation of the given time
frames, see "Usage Report Time Frames" on page 115.

Overall
Concurrency
tab

Contains a table that displays concurrent resource usage information aggregated
over all selected projects, as well as aggregated over all projects in the system.

For more information, see "Overall Concurrency Table" on page 119 below.
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UI Elements
(A - Z) Description

Overall
License
Usage tab

Contains a graph that displays maximum and average Runs and Vuser usage as
a percentage of the Performance Center license limitations, allowing the
administrator to determine the percentage of the Performance Center license
that is actually used.

The usage is aggregated over all selected projects, as well as aggregated over
all projects in the system.

For more information, see "Overall License UsageGraph" on page 120 below.

Top Projects
by Runs tab

Contains a graph that displays themaximum and average number of concurrent
runs per project as a percentage of the project limit, which is defined in the
project settings (Lab Settings > Project Settings). This helps the administrator
identify those projects that runmost efficiently within their given limitations.

For more information, see "Top Projects by Runs Graph" on page 121 below.

Top Projects
by Vusers
tab

Contains a graph that displays themaximum and average number of concurrent
running Vusers per project as a percentage of the project limit, which is defined
in the project settings (Lab Settings > Project Settings). This helps the
administrator identify those projects that runmost efficiently within their given
limitations.

For more information, see "Top Projects by Vusers Graph" on page 122 below.

Concurrency by Project Table

Important
Information

You can sort the table according to the values of any column. The arrow in the
heading displays whether the column is sorted in ascending or descending order.
Click the column heading to reverse the order.

User interface elements are described below:

UI
Elements
(A - Z) Description

Concurrent
Machines
Avg

The average number of concurrent runningmachines (controllers and load
generators) in all of the project's concurrent test runs.

Concurrent
Machines
Limit

Themaximum number of concurrent runningmachines allowed for this project as
defined in the project settings (Lab Settings > Project Settings).

Concurrent
Machines
Max

Themaximum number of concurrent runningmachines (controllers and load
generators) in all of the project's concurrent test runs.
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UI
Elements
(A - Z) Description

Concurrent
Runs Avg

The average number of concurrent test runs for the project. For the purposes of this
report, a single test run is considered a concurrent run.

Concurrent
Runs Limit

Themaximum number of concurrent runs allowed for this project as defined in the
project settings (Lab Settings > Project Settings). For the purposes of this
report, a single test run is considered a concurrent run.

Concurrent
Runs Max

Themaximum number of concurrent test runs for the project. For the purposes of
this report, a single test run is considered a concurrent run.

Concurrent
Vusers
Avg

The average number of concurrent running Vusers in all of the project's concurrent
test runs.

Concurrent
Vusers
Limit

Themaximum number of concurrent running Vusers allowed for this project as
defined in the project settings (Lab Settings > Project Settings).

Concurrent
Vusers
Max

Themaximum number of concurrent running Vusers in all of the project's
concurrent test runs.

Overall
Duration

The total time tests were run in the project. This value shows the actual amount of
time the system was used to run load tests, and not concurrent duration.

Project The project name. Deleted projects are also included in the report and are indicated
with a red x.

Overall Concurrency Table

Important
Information

You can sort the table according to the values of any column. The arrow in the
heading displays whether the column is sorted in ascending or descending order.
Click the column heading to reverse the order.

User interface elements are described below:

UI
Elements(A - Z) Description

Concurrent
Machines Avg

The average number of concurrent runningmachines.

Concurrent
Machines Max

Themaximum number of concurrent runningmachines.
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UI
Elements(A - Z) Description

Concurrent
Runs Avg
(License %)

The average number of concurrent runs. The value in brackets is the average
number of concurrent runs as a percentage of the Performance Center license.

Concurrent
Runs Max
(License %)

Themaximum number of concurrent runs. The value in brackets is the
maximum number of concurrent runs as a percentage of the Performance
Center license.

Concurrent
Runs PC
License

Themaximum number of concurrent runs allowed by the Performance Center
license.

Concurrent
Vusers Avg
(License %)

The average number of concurrent running Vusers. The value in brackets is
the average number of concurrent running Vusers as a percentage of the
project Performance Center license.

Concurrent
Vusers Max
(License %)

Themaximum number of concurrent running Vusers. The value in brackets is
themaximum number of concurrent running Vusers as a percentage of the
Performance Center license.

Concurrent
Vusers PC
License

Themaximum number of concurrent running Vusers allowed by the
Performance Center license.

Overall
Duration

The total time tests were run aggregated over all the projects.

Project All Projects orSelected Projects.

Overall License Usage Graph

X-axis Maximum and average percentage of Performance Center license being used.

Y-axis Vuser and runs usage aggregated over all projects as well as only selected projects.

Example

In the following example themaximum number of Vusers for all projects in the system used
just 30.1% of the Performance Center license, while the average number of Vusers for all
projects used just 3.6% of the license. This tells the administrator that a significant portion of
the Performance Center license is not being used.
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Top Projects by Runs Graph
Top Projects by Runs Graph

Important
Information

In most circumstances, the graph displays information for up to ten selected
projects. If there is more than one selected project with the same number of
maximum concurrent runs, all these projects are displayed. In that case, more
than ten projects might be displayed.

X-axis Maximum and average percentage of allowed concurrent runs being used

Y-axis Projects displayed in descending order according to themaximum number of
concurrent runs.

Example

In the following example theMax - Runs value for the project LR_pro is 30%. This means that
themaximum number of concurrent runs for this project reached 30% of its limit. The Avg -
Runs value for this project shows that the average number of concurrent runs reached 12.7%
of its limit. These values tell the administrator that a significant portion of the project's defined
limit of concurrent runs is not being utilized.
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Top Projects by Vusers Graph

Important
Information

In most circumstances, the graph displays information for up to ten selected
projects. If there is more than one selected project with the same number of
maximum concurrent runs, all these projects are displayed. In that case, more
than ten projects might be displayed.

X-axis Maximum and average percentage of allowed concurrent running Vusers being
used

Y-axis Projects displayed in descending order according to themaximum number of
concurrent running Vusers.

Example

In the following example, theMax - Vusers value for the project proj1 is 10%. This means that
themaximum number of concurrent running Vusers for this project reached 10% of its limit.
The Avg - Vusers value for this project shows that the average number of concurrent running
Vusers reached 8.4% of its limit. These values tell the administrator that a significant portion of
the project's defined limit of concurrent running Vusers is not being utilized.
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Resource Summary Report
The Resource Summary Report provides aggregate data regarding the way projects used the
various resources of the system.

To access 1. Select Performance Center> Usage Reports

2. In the list of Usage Reports, select Resource Summary

Relevant tasks "How to View Reports and Set Report Filter Criteria" on page 114

User interface elements are described below:

UI Elements
(A - Z)

Description

Export to PDF/Excel. Click to export the report to PDF or Excel format.

Generates the report.
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UI Elements
(A - Z)

Description

Filter by:
Projects

Click the browse button by this field to select which project to include in the
report.

Filter by:
Time Frame

Select the desired time frame for the report. For an explanation of the given time
frames, see "Usage Report Time Frames" on page 115.

Resource
Usage by
Project tab

Contains a table that provides resource usage information for each selected
project.

For more information, see "Resource Usage by Project Table" below.

Top Projects
by Machines
tab

Contains a graph which displays the number of machines used per project,
aggregated over all the runs.

X-axis. The number of machines used per project.

Y-axis. Projects displayed in descending order according to the number of
machines used.

Note: In most circumstances, the graph displays information for up to ten
selected projects. If there is more than one selected project with the same
number of maximum concurrent runs, all these projects are displayed. In
that case, more than ten projects might be displayed.

Top Projects
by Runs tab

Contains a graph that displays the number of test runs per project.

X-axis. The number of test runs per project.

Y-axis. Projects displayed in descending order according to the number of test
runs.

Note: In most circumstances, the graph displays information for up to ten
selected projects. If there is more than one selected project with the same
number of maximum concurrent runs, all these projects are displayed. In
that case, more than ten projects might be displayed.

Top Projects
by Vusers
tab

Contains a graph that displays the number of Vusers per project, aggregated
over all the runs.

X-axis. The number of Vusers per project.

Y-axis. Projects displayed in descending order according to the number of
Vusers.

Resource Usage by Project Table

Important
information

You can sort the table according to the values of any column. The arrow in the
heading displays whether the column is sorted in ascending or descending order.
Click the column heading to reverse the order.
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User interface elements are described below:

UI Elements
(A - Z)

Description

Duration The total time tests were run in the project.

Machines The total number of machines that were used in the project, aggregated over
all the runs.

Project The project name. Deleted projects are also included in the report and are
indicated by a red x.

Runs The total number of test runs in the project, aggregated over all the tests.

Tests The number of load tests in the project.

Vusers The total number of Vusers in the project, aggregated over all the runs.

Timeslot Usage Report
The Timeslot Usage Report provides information about the reservation and usage of resources
associated with timeslots.

To access 1. Select Performance Center> Usage Reports

2. In the list of Usage Reports, select Timeslot Usage

Relevant tasks "How to View Reports and Set Report Filter Criteria" on page 114

User interface elements are described below:
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UI Elements
(A - Z)

Description

Export to PDF/Excel. Click to export the report to PDF or Excel format.

Generates the report.

Filter by:
Projects

Click the browse button by this field to select which project to include in the
report.

Filter by:
Time Frame

Select the desired time frame for the report. For an explanation of the given time
frames, see "Usage Report Time Frames" on page 115.

Timeslot
Usage by
Project tab

Contains a table that displays reservation and usage information for duration,
machines, and Vusers per project.

For more information, see the "Timeslot Usage by Project Table" below.

Top Projects
by Duration
Usage tab

Contains a graph that displays reservation and usage information for timeslot
duration per project. It allows the administrator to see which projects most
efficiently use their reserved duration.

X-axis. The total amount of reserved and used duration for each project.

Y-axis. Projects displayed in descending order according to their duration usage.

Note: In most circumstances, the graph displays information for up to ten
selected projects. If there is more than one selected project with the same
number of maximum concurrent runs, all these projects are displayed. In
that case, more than ten projects might be displayed.

Top Projects
by Machines
Usage tab

Contains a graph that displays reservation and usage information for timeslot
machines per project. It allows the administrator to see which projects most
efficiently use their reserved number of machines.

X-axis. The total amount of reserved and usedmachines for each project.

Y-axis. Projects displayed in descending order according to their Vusers usage.

Note: In most circumstances, the graph displays information for up to ten
selected projects. If there is more than one selected project with the same
number of maximum concurrent runs, all these projects are displayed. In
that case, more than ten projects might be displayed.
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UI Elements
(A - Z)

Description

Top Projects
by Vusers
Usage tab

Contains a graph that displays reservation and usage information for timeslot
Vusers per project. It allows the administrator to see which projects most
efficiently use their reserved number of Vusers.

X-axis. The total amount of reserved and used Vusers for each project.

Y-axis. Projects displayed in descending order according to their machines
usage.

Note: In most circumstances, the graph displays information for up to ten
selected projects. If there is more than one selected project with the same
number of maximum concurrent runs, all these projects are displayed. In
that case, more than ten projects might be displayed.

Timeslot Usage by Project Table

Important
information

You can sort the table according to the values of any column. The arrow in the
heading displays whether the column is sorted in ascending or descending order.
Click the column heading to reverse the order.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements
(A - Z)

Description

Duration
Reserved

The amount of time reserved for the project.

Duration Used The amount of time used within the project.

Machines
Reserved

The number of machines reserved for the project.

Machines Used The number of machines used in the project.

Project The project name. Deleted projects are also included in the report and are
indicated by a red x.

Vusers
Reserved

The number of Vusers reserved for the project.

Vusers Used The number of Vusers used in the project.
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Resource by Duration Report
The Resource by Duration Report provides general information about the usage of your system
resources over the selected time frame. You can view statistics for total usage by project, or per
user within a project.

To access 1. Select Performance Center > Usage Reports

2. In the list of Usage Reports, select
Resource Usage by Duration

Relevant tasks "How to View Reports and Set Report Filter Criteria" on page 114

User interface elements are described below:

UI Elements
(A - Z)

Description

Export to PDF/Excel. Click to export the report to PDF or Excel format.

Generates the report.

Filter by:
Projects

Click the browse button by this field to select which project to include in the
report.

Filter by: Time
Frame

Select the desired time frame for the report. For an explanation of the given
time frames, see "Usage Report Time Frames" on page 115.
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UI Elements
(A - Z)

Description

Resource Usage
by Project tab

Contains a table that displays resource usage per project over the selected
time frame.

For more information, see "Resource Usage by Project Table" below.

Resource Usage
by User tab

Contains a table that displays resource usage per user.

For more information, see "Resource Usage by User Table" below.

Resource Usage by Project Table

Important
information

You can sort the table according to the values of any column. The arrow in the
heading displays whether the column is sorted in ascending or descending order.
Click the column heading to reverse the order.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A - Z) Description

Avg Machines per
Active Hour

The average number of machines used per active hour.

Note: An active hour refers to the actual running time of your tests
within the selected time frame.

Avg Vusers per
Active Hour

The average number of running Vusers per active hour.

Note: An active hour refers to the actual running time of your tests
within the selected time frame.

Project The project name. Deleted projects are also included in the report and
are indicated by a red x.

Total Active Duration The total time tests were run during reserved timeslots.

Note: Active Duration refers to the actual running time of your
tests within the selected time frame.

Total Reserved
Duration

The total time reserved in the Timeslots page, by the project.

Resource Usage by User Table

Important
information

l Only users with privileges in the selected projects are shown.

l You can sort the table according to the values of any column. The arrow in the
heading displays whether the column is sorted in ascending or descending
order. Click the column heading to reverse the order.
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A - Z) Description

Avg Hosts per
Active Hour

The average number of hosts used per active hour.

Note: An active hour refers to the actual running time of your tests
within the selected time frame.

Avg Vusers per
Active Hour

The average number of running Vusers per active hour.

Note: An active hour refers to the actual running time of your tests
within the selected time frame.

Full Name The name of the user. Deleted users are also included in the report.

Total Active
Duration

The total time tests were run during reserved timeslots.

Note: Active Duration refers to the actual running time of your tests
within the selected time frame.

Total Reserved
Duration

The total time reserved in the Timeslots page, by the user.

Resource Usage by Runs Report
The Resource Usage by Runs Report provides general information about the test runs. You can
view statistics for total usage by project, or per user within a project.

To access 1. Select Performance Center > Usage Reports

2. In the list of Usage Reports, select
Resource Usage by Runs

Relevant tasks "How to View Reports and Set Report Filter Criteria" on page 114

User interface elements are described below:
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UI Elements
(A - Z)

Description

Export to PDF/Excel. Click to export the report to PDF or Excel format.

Generates the report.

Filter by:
Projects

Click the browse button by this field to select which project to include in the
report.

Filter by: Time
Frame

Select the desired time frame for the report. For an explanation of the given
time frames, see "Usage Report Time Frames" on page 115.

Resource Usage
by Project tab

Contains a table that displays test run statistics per project over the
selected time frame.

For more information, see "Resource Usage by Project Table" below.

Resource Usage
by User tab

Contains a table that displays test run statistics per user.

For more information, see "Resource Usage by User Table" on next page.

Resource Usage by Project Table

Important
information

l Details of all runs with any amount of duration, even retries of a single run, are
included in the table.

l You can sort the table according to the values of any column. The arrow in the
heading displays whether the column is sorted in ascending or descending
order. Click the column heading to reverse the order.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements
(A - Z)

Description

Avg Duration per
Run

The average time used for the listed runs.

Avg Machines per
Run

The average number of machines used per run.

Avg Vusers per
Run

The average number of Vusers used per run.

Project The project name. Deleted projects are also included in the report and are
indicated by a red x.

Total Duration The total time used by the listed runs.

Total Runs The total number of runs in the project.
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UI Elements
(A - Z)

Description

Total Vusers
Involved

The total number of Vusers in the project.

Resource Usage by User Table

Important
information

l Runs of users that have been deleted from the system, or who no longer have
any privileges, are also included in the table.

l Details of all runs with any amount of duration, even retries of a single run, are
included in the table.

l You can sort the table according to the values of any column. The arrow in the
heading displays whether the column is sorted in ascending or descending
order. Click the column heading to reverse the order.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A - Z) Description

Avg Duration per Run The average time used for the listed runs.

Avg Machines per Run The average number of machines used per run.

Avg Vusers per Run The average number of Vusers used per run.

Full Name The name of the user. Deleted users are also included in the report.

Total Duration The total time used by the listed runs.

Total Runs The total number of runs associated with the user.

Total Vusers Involved The total number of Vusers associated with the user.

VUDs License Usage per Project Report
The VUDs License Usage per Project Report provides information about VUD usage per day for
each selected project.

To access 1. Select Performance Center > Usage Reports

2. In the list of Usage Reports, select
VUDs License Project Usage

Relevant tasks "How to View Reports and Set Report Filter Criteria" on page 114

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Elements
(A - Z)

Description

Export to PDF/Excel. Click to export the report to PDF or Excel format.

Generates the report.

Filter by:
Projects

Click the browse button by this field to select which project to include in the
report.

Filter by:
Time Frame

Select the desired time frame for the report. For an explanation of the given time
frames, see "Usage Report Time Frames" on page 115.

VUDs per
Project tab

Contains a table that provides information about daily VUD usage per selected
project. For more information see "VUDs per Project Table" below.

VUDs
Transactions
tab

Contains a table that provides information about VUDs per transactions. For
more information, see "VUDs Transactions Table" on next page.

VUDs per Project Table

Important
information

l Details of all runs with any amount of duration, even retries of a single run, are
included in the table.

l You can sort the table according to the values of any column. The arrow in the
heading displays whether the column is sorted in ascending or descending
order. Click the column heading to reverse the order.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements
(A - Z)

Description

Allocated The amount of VUDs that were allocated to the project at the start of the
day.

Consumed The amount of VUDs that were consumed during the day.

Date The date for which VUD usage information is shown.

New Value The amount of VUDs that were remaining at the end of the day.

Project The name of the project.
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VUDs Transactions Table

Important
information

l Details of all runs with any amount of duration, even retries of a single run, are
included in the table.

l You can sort the table according to the values of any column. The arrow in the
heading displays whether the column is sorted in ascending or descending
order. Click the column heading to reverse the order.

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements
(A - Z)

Description

Action The current state of the VUDs.

Date The date for which VUD information is displayed.

In Use The number of VUDs that are currently running.

New Limit The number of VUDs that are currently available to the project.

Pending The number of VUDs that are available for running.

Project The project name. Deleted projects are also included in the report and are
indicated by a red x.

Run ID The run ID.

Test Name The performance test name.

Unique ID A unique ID that identifies VUDs from their issue to their expiration.

User The user that performed the transaction.

Value The amount of VUDs that are in the state indicated in theAction column.

Daily VUDs License Usage Report
The Daily VUDs License Usage Report provides overall VUD usage information aggregated for all
projects for a specific day.

To access 1. Select Performance Center > Usage Reports

2. In the list of Usage Reports, select
Daily VUDs License Site Usage

Relevant tasks "How to View Reports and Set Report Filter Criteria" on page 114

User interface elements are described below:
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UI Elements
(A - Z)

Description

Export to PDF/Excel. Click to export the report to PDF or Excel format.

Generates the report.

Daily VUDs
Usage tab

Contains a table that displays daily VUD usage information. For more
information, see "Daily VUDs Usage Table" below.

Filter by:
Time Frame

Select the desired time frame for the report. For an explanation of the given time
frames, see "Usage Report Time Frames" on page 115.

Daily VUDs Usage Table

Important
information

l Details of all runs with any amount of duration, even retries of a single run, are
included in the table.

l You can sort the table according to the values of any column. The arrow in the
heading displays whether the column is sorted in ascending or descending
order. Click the column heading to reverse the order.

User interface elements are described below:

UI Elements (A - Z) Description

Added The amount of VUDs that were added on the day.

Consumed The amount of VUDs that were used on the day.

Date The date for which VUD usage information is shown.

New Value The amount of VUDs that were remaining at the end of the day.

Troubleshooting and Limitations
When viewing the Usage reports in a resolution of 1024x768, to see all user interface controls,
collapse the ALMmodules and/or the reports selection tree.
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System Health
This chapter includes:

System Health Overview 137

System Health User Interface 137

System Health Overview
To design and run performance tests in ALM, the systemmust be up and running. Verifying the
health of the system includes validating that the components of the system are indeed up and
running and communicating with each other, as well as maintaining the system in a healthy state.

System Health User Interface
This section includes:

System Health ModuleWindow 138

Configure System Check Dialog Box 139
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System Health Module Window
This module displays information about the ALM Performance Center system health maintenance
tasks and overall system checks, and enables you to run a full validation on your ALM
Performance Center system.

To
access

On the LabManagement sidebar, underPerformance Center, select System
Health.

See also "System Health Overview" on previous page

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Opens the configure system check dialog box, enabling you to select
servers and hosts in the ALM-Performance Center system to include in
the system check. For details, see "Configure System Check Dialog
Box" on next page.

Refresh All. Refreshes the grid so that it displays themost up-to-date
information.

If Auto Refresh is enabled, this button is disabled.

Set Auto Refresh On/Off.When enabled, automatically refreshes the
grid every 5 seconds so that it displays themost up-to-date task
information.

Displays the system check results that have a failed status only.
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UI Elements Description

Opens the Export Grid Data dialog box, enabling you to export the
results of the system check as aMicrosoft Excel worksheet.

Choose one of the following options:

l All. Exports all tasks in the grid.

l Selected. Exports selected tasks in the grid.

<Results grid> Displays the progress and results of the system check.

Configure System Check Dialog Box
This dialog box enables you to select which ALM-Performance Center system components
(servers and hosts) to include when doing a system check.

To access 1. On the LabManagement sidebar, underPerformance Center, select
System Health.

2. Click the System Check tab, and click .

Important
information

l The system check is performed on Performance Center Servers and hosts
that are in an operational state only.

l The system check is performed on hosts with the Controller purpose only.

See also "System Health Overview" on page 137
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User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Check ALM Server Includes the ALM server in the system check.

Check
Performance Center
Servers

Includes operational Performance Center Servers in the system check.

l All. Includes all of the operational Performance Center Servers in the
system check.

l Specific. Enables you to select operational Performance Center
Servers to include in the system check.

Check Hosts Includes operational Performance Center hosts with the Controller
purpose in the system check.

l All. Includes all of the operational Performance Center hosts with the
Controller purpose in the system check.

l Specific. Enables you to select operational Performance Center
hosts with the Controller purpose to include in the system check.

<Performance
Center Server grid>

Lists the Performance Center Servers that you selected to include in the
system check, and displays their details.

<Performance
Center host grid>

Lists the Performance Center hosts that you selected to include in the
system check, and displays their details.
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PC Licenses
This chapter includes:

HP ALM Performance Center PC Licenses Overview 141

Host License Types 143

Host License Vuser Types 143

PC Licenses User Interface 143

HP ALM Performance Center PC Licenses
Overview

Licenses Definition Process
Towork with HP ALM Performance Center, each of the following licenses must be defined:

License Description

ALM
License

The ALM license defines the number of concurrent users in ALM. The ALM
license is configured as part of the ALM installation process and is managed in
Site Administration. For more information about the ALM license, see theHP
Application Lifecycle Management Administrator Guide.

Performance
Center and
Host
Licenses

There are two licenses that are specific to ALM Performance Center:

l Performance Center license. Defines the number of concurrent runs per
performance test, as well as Vuser limits. For more information about the
Performance Center license, see "Performance Center Licenses" below.

l Host license. A license which is automatically installed on the host as you
add the host to ALM. It defines the limits of Vuser use per protocol on the host.

The Performance Center and Host licenses are configured directly after
installation of the Performance Center Server. For configuration details, see the
HP ALM Performance Center Installation Guide.

If this configuration was skipped, you can configure the Performance Center and
Host licenses manually. For more information, see "PC Licenses Module
Window" on page 144.

Performance Center Licenses
There are two types of Performance Center licenses: Performance Center and VUD.

HP ALM LabManagement (11.50)Page 141 of 231



HP ALM Lab Management Guide
Chapter 9: PC Licenses

License Definition

Performance
Center

This license is limited by the total number of concurrent runs or Vusers, andmay
have an expiration date.

VUD A Virtual User Day (VUD) license provides you with a specified number of Vusers
(VUDs) that you can run an unlimited number of times within a 24 hour period (the
Virtual User Day).

At the end of a Virtual User Day, the remaining number of licensed VUDs is
calculated by subtracting the number of used VUDs, or in the case of concurrent
usage, themaximum number of concurrent running VUDs, from the total number
of licensed VUDs.

For example, a user has a license that allows him to run 1,000 VUDs. He creates
a performance test that requires 200 Vusers and runs for 45minutes. He runs the
test at 8:00am, 10:00am, 2:00pm, and at 4:00pm. In each case, the test finishes
before the next one begins. Because there is no concurrent Vuser usage, he can
re-use the same 200 VUDs for each test run, meaning that at the end of the 24-
hour period, only 200 VUDs are deducted from the license, leaving 800 for future
use.

However, if the user starts the second run at 8:30am, the first test is still running
before the second test initializes. This overlap requires 400 Vusers to run
concurrently (200 for each test). At the end of the day, 400 VUDs are deducted
from the license, because that is the highest number of concurrent Vusers. The
total left for future use is 600 VUDs.

Notes:

l You can run VUDs on HP developed protocols, with the exception of:
COM/DCOM, VB Com, VB Vuser, VB Script Vuser, VB.NET Vuser, and
VB.NET Template.

l You cannot run VUDs on SDK protocols.

l You cannot run VUDs on aGUI Vuser script, such as UFT Professional
scripts.

l When using a VUD based Performance Center license, a Host license is not
relevant.
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Host License Types
The following table displays a list of available host license types. To learnmore about host
licenses, see "HP ALM Performance Center PC Licenses Overview" on page 141.

License
Type Description

Permanent The license never expires.

Time
Limited

The license is limited by an expiration date.

Temporary A Time Limited license that is granted for a predefined number of days after
product installation.

Host License Vuser Types
The following table displays a list of the available host license Vuser types.

Vuser
Type Description

<bundle
type>
Bundle

Each bundle contains a collection of protocols. When you select a protocol bundle,
this dialog box displays a list of included protocols.

Global The global license lets you run all Vuser types, provided you stay within the total
limit. The number following "Global" indicates the total number of Vusers
purchased.

PC Licenses User Interface
This section includes:

PC Licenses ModuleWindow 144

Add Licenses from File Dialog Box 146
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PC Licenses Module Window
This page enables you to view summaries of your Performance Center and VUD-based licenses,
as well as host license information.

To access On the LabManagement sidebar, underPerformance Center, select PC
Licenses.

Relevant
tasks

"How toWork with LabManagement Administration" on page 22

See also "HP ALM Performance Center PC Licenses Overview" on page 141

Performance Center Licenses Area
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Enables you to install a single license key at a time.

Click to open the Add New License dialog box and type the new
license key.

Note: You can only add a Performance Center license if you
have the required permissions.

Opens the Add Licenses for File dialog box enabling you to install
multiple license keys simultaneously. For user interface details, see
"Add Licenses from File Dialog Box" on page 146.
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UI Elements Description

Show All Licenses/Hide All Expired Licenses. Click to display all
Performance Center licenses or to remove expired licenses in the left
pane.

Licenses Details. Click to open the Licenses Details dialog box
which displays the following information:

l Date Assigned. The date the license was added to the system.

l License Key. The license key.

l Type. The license type.

To export details to an Excel file, click Export to Excel.

Note: You can only view license details if you have the required
permissions.

PC Licenses Select to display the following information in the adjacent pane on the
right:

l PC License Summary. Displays summary information for all
Performance Center licenses.

l VUDs License Summary. Displays summary information for all
VUD-based licenses.

<Available licenses list> A list in the left-hand pane that lists all current licenses. Select a
license to view specific details on the right.

Hosts License Area
User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Enables you to install a single host license key at a time.

Click to open the Add New License dialog box and type the new
license key.

Note: You can only add a Performance Center license if you
have the required permissions.

Opens the Add Licenses for File dialog box enabling you to install
multiple host license keys simultaneously. For user interface details,
see "Add Licenses from File Dialog Box" on next page.
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UI Elements Description

Licenses Details. Click to open the Licenses Details dialog box
which displays the following information:

l Date Assigned. The date the license was added.

l License Key. The license key.

l Type. The license type.

Note: You can only view host license details if you have the
required permissions.

Host Licenses Select to display theHost License Summary in the adjacent pane
on the right. This summary shows all licenses , including both active
and expired licenses.

<Available licenses list> A list in the left-hand pane that lists all current host licenses. Select a
license to view the License Key Information pane on the right. The
following information is displayed:

l License Type. The type of license available for the license key
you selected. For a list of the available license types, see "Host
License Types" on page 143.

l License Validity. The time limitation of the selected license key.

l Vuser Types. A list of Vuser protocols available for the selected
license key, or a list of protocol bundles for the new licensing
implementation. For a list of the available host license Vuser
types, see "Host License Vuser Types" on page 143.

l Monitors and Modules. The onlinemonitors available for the
selected license key, and themodules included in the license. For
example, Diagnostics for J2EE/.NET. If All Monitors is
displayed in the list, it means that your license enables you to
work with all the Controller onlinemonitors. When you select
All Monitors, the unlabelled box at the bottom of the License Key
Information pane displays a list of includedmonitors.

Add Licenses from File Dialog Box
This dialog box enables you to install multiple Performance Center license keys simultaneously.
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To
access

On the LabManagement sidebar, underPerformance Center, select PC

Licenses. Click .

Important You can only add a Performance Center license if you have the required
permissions.

Relevant
tasks

"How toWork with LabManagement Administration" on page 22

See also "HP ALM Performance Center PC Licenses Overview" on page 141

User interface elements are described below:

UI
Elements

Description

License
File

Click Select and then select the license file.

View
License
File
Content

Displays the content of the license file in the table below.

Select the
licenses to
install

Select the check boxes for the licenses to install.

ID Indicates the license ID.
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UI
Elements

Description

Type Indicates the type of license.

For Performance Center licenses: Time Limited, Unlimited, and VUDS based.

For Host licenses: Permanent, Time Limited, and Temporary.

License
Bundle

Indicates the name of the Vuser protocol bundle to which the license applies. The
license enables the Controller to run Vusers of any protocol that is included in the
protocol bundle.

Available in:Host Licenses

License
Type

The Performance Center or LoadRunner license type.

For a list of the available jost license types, see "Host License Types" on page
143.

Expiration
Date

Indicates the date and time the license expires.

VUsers The number of VUsers.

Available in:PC Licenses

Concurrent
Runs

Themaximum number of Vusers that can ran simultaneously.

Available in:PC Licenses

Capacity Indicates themaximum number of Vusers that can be run simultaneously from the
LoadRunner Controller.

Available in:Host Licenses

Add Installs the selected licenses.
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Diagnostics Management
This chapter includes:

J2EE/.NET Diagnostics Overview 149

ERP/CRMDiagnostics Overview 150

How to Add ERP/CRMMediators 152

How to Add HP Diagnostics Servers 152

How to Pre-Configure Siebel/Siebel DB Diagnostics 153

How to Pre-Configure Oracle 11i Diagnostics 156

How to Pre-Configure SAP Diagnostics 158

How to Enable and Disable Logging on the Siebel Server 158

How to Enable Logging on theOracle Server 159

How to Set and Disable the Oracle Server Diagnostics Password 160

Diagnostics User Interface 161

J2EE/.NET Diagnostics Overview
The HP Diagnostics integration with HP Application Lifecycle Management (ALM) allows you to
monitor and analyze the performance of Java 2 Enterprise Edition (J2EE), .NET-connected, SAP,
Oracle, and other complex environments.

During a performance test, you can drill down into HP Diagnostics data for the whole test or for a
particular transaction. After the test, you can use HP LoadRunner Analysis to analyze offline
diagnostics data generated during the test.

Monitoring Server Requests
When configuring a performance test to use J2EE/.NET Diagnostics, you can instruct ALM to
capture a percentage of server requests which occur outside the context of any Vuser transaction.

The benefit of enabling this functionality is that calls into a back-end VM can be captured even in
the case where:

l The probe is not capturing RMI calls

l RMI calls cannot be captured (perhaps because an unsupported application container is being
used)

l The application uses some other mechanism for communications betweenmultiple VMs
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For more information about working with diagnostics for J2EE and .NET, see theHP Diagnostics
User Guide.

ERP/CRM Diagnostics Overview
The following sections provide an overview of ERP/CRM diagnostics.

Understanding ERP/CRM Diagnostics
During a performance test, the ALM diagnostics modules trace, time, and troubleshoot individual
transactions across theWeb, application, and database servers. You can drill down from a slow
end-user transaction all the way to the bottleneckedmethod or SQL statement. The ALM
Performance Center diagnostics modules enable organizations to:

l Rapidly isolate application components that have a significant impact on end-user experience.

l Provide developers with precise data on how tomake performance improvements.

ERP/CRM Diagnostics Modules Architecture
ERP/CRMDiagnostics architecture, as shown in the diagram below, is comprised of the following
components:

l ERP/CRM Mediator. The ERP/CRMMediator ("Mediator") gathers and correlates offline
transaction data from theWeb, database, and application servers. For information on installing
theMediator, see theHP ALM Performance Center Installation Guide.

l Controller. Before test execution, the Controller transfers all server information to theMediator
and distributes the percentage of users that will participate in themonitoring. After test
execution, the Controller collects the aggregated transaction data files from theMediators and
collates the results. Results are transferred to the Siebel diagnostics, SAP diagnostics, or
Oracle DB results directory.

If you do not want to collate the information right after the load test, you can perform collation at
a later time.

The files are then transferred to the results directory per diagnostics type as follows:
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n Siebel results are transferred to the \sbl_bd directory.

n Oracle 11i results are transferred to the \ora_bd directory.

n SAP results are transferred to the \sap_bd directory.

l Load Generator.When you execute a load test, the Controller distributes each Vuser to a load
generator, and the load generator executes the Vuser script.

l Analysis. Displays detailed diagnostics graphs and reports. For more information about the
diagnostics graphs, see theHP LoadRunner Analysis User Guide.

Connecting the Mediator to a Remote Server
When you set up the ERP/CRMDiagnostics modules, you define a server to monitor by entering
the user name of the server where trace/log files are stored. This section explains how theMediator
connects to the server when it is a remoteWindows or UNIX server.

l Whenmonitoring a remoteWindows server, theMediator attempts to connect to the server
using the configuration details which you enter in the <diagnostics type> Server Configuration
Dialog Box during the diagnostics configuration process. This configuration should give
administrator permissions to the remotemachine.

l Whenmonitoring a remote UNIX server, theMediator supports the remote shell connection
type. For more information on remote shell connections, see the section that describes verifying
the UNIX load generator installation in theHP Application Lifecycle Management Installation
Guide.

Siebel and Siebel DB Diagnostics Overview
Siebel Diagnostics are split into the followingmodules:

l Siebel Diagnostics Module. Enables you to break down Siebel transactions into layers, areas,
sub-areas, servers, and scripts. You can also view the transaction chain of calls and call stack
statistics to track the percentage of time spent on each part of the transaction. Siebel-Web
Vusers support Siebel Diagnostics.

l Siebel DB Diagnostics Module. Helps you rapidly identify and resolve database performance
problems. You can view the SQLs for each transaction, identify the problematic SQL queries of
each script, and identify at which point problems occurred. Siebel-Web Vusers support Siebel
DB Diagnostics.

Note: Siebel Diagnostics (Siebel Application ResponseMeasurements) supports Siebel
application servers versions 7.53 and 7.7.

For information on how to pre-configure the Siebel/Siebel DB Diagnostics modules, see "How to
Pre-Configure Siebel/Siebel DB Diagnostics" on page 153.

Oracle 11i Diagnostics Overview
Oracle 11i Diagnostics helps pinpoint performance problems onOracle NCA systems. The
diagnostics information drills down from the transaction to the SQL statements, and to the SQL
stages of each statement. Oracle NCA Vusers support Oracle 11i Diagnostics.

For information on how to pre-configure the Oracle 11i Diagnostics module, see "How to Pre-
Configure Oracle 11i Diagnostics" on page 156.
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SAP Diagnostics Overview
SAP Diagnostics enables you to pinpoint the root cause of a certain problem (i.e. DBA, Network,
WAS, Application, OS/HW) quickly and easily, and engage with the relevant expert only, without
having to present the problem to a whole team of people.

The following table outlines the supported versions and required Kernel patches for the SAP
Application Server and the SAPGUI Client:

For information on how to configure the SAP Diagnostics module, see "How to Pre-Configure SAP
Diagnostics" on page 158.

l Server-side Data Collection. SAP Diagnostics is based on SAP Distributed Statistical
Records (DSR). For each dialog step performed on application server, a statistical record is
generated, which includes information such as response time components, database statistics,
RFC times, and so on.

The Diagnostics Mediator is responsible for collecting diagnostics data from the server during a
performance test.

l Vuser Coloring. SAP Diagnostics allows replaying the SAPGUI protocol. You set the
percentage of colored Vusers in the Configuration dialog (up to 100% allowed). Coloring of
SAPGUI users creates no overhead on the Application server.

How to Add ERP/CRM Mediators
This task describes how to add diagnostics servers andmediators in order to work with J2EE/.NET
and ERP/CRM diagnostics.

Note: This task is part of a higher-level task. For details, see "How toWork with Lab
Management Administration" on page 22.

1. Prerequisite
Make sure that themediator is installed in the same LAN as themonitored server. For
information on installing the ERP/CRMMediator, see theHP ALM Performance Center
Installation Guide.

2. Add and configure the mediator
a. On the LabManagement sidebar, under Lab Settings, select Diagnostics.

b. Select theERP/CRM Diagnostics tab.

c. Click theNew Diagnostics Mediator button , and enter the required information. For
user interface details, see "Diagnostics Module Fields" on page 163.

How to Add HP Diagnostics Servers
This task describes how to add an HP Diagnostics server to allow you tomonitor and analyze
J2EE/.NET environments.

Note: This task is part of a higher-level task. For details, see "How toWork with Lab
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Management Administration" on page 22.

1. On the LabManagement sidebar, under Lab Settings, select Diagnostics.

2. Select the J2EE/.NET Diagnostics tab.

3. Click theNew Diagnostics Server button , and enter the required information. For user
interface details, see "Diagnostics Module Fields" on page 163.

4. Under Lab Settings, select Project Settings. Right-click the relevant project and select
Project Settings Details. Add the relevant server information in theDiagnostics Server field.

Note: To ensure that diagnostics data is available online, make sure that the time on the
diagnostics server is synchronized with its probes.

How to Pre-Configure Siebel/Siebel DB
Diagnostics

This task describes the pre-configuration steps to be performed by the ALM administrator which
allow the performance tester to enable and run Siebel diagnostics.

Note: This task is part of a higher-level task. For details, see "How toWork with Lab
Management Administration" on page 22.

This task includes the following steps:

l "Prerequisite" below

l "If connecting to a UNIX server with a remote shell (RSH/RCP) connection" below

l "Configure the server machine to enable diagnostics" on next page

l "Copy files from the Siebel Application Server to theMediator" on page 155

l "Synchronize clocks" on page 156

l "(Siebel DB) Enable logging on the Siebel Server" on page 156

1. Prerequisite
Make sure that the ERP/CRMmediator is installed and configured. For more information, see
"How to Add ERP/CRMMediators" on previous page.

2. If connecting to a UNIX server with a remote shell (RSH/RCP)
connection
n Verify that the RSH andRCP daemons are running on the UNIX server.

n Verify that the UNIX user has permission to run remote shell commands. To check this,
type the following at the DOS command prompt:

rsh <server machine name> -l <UNIX user login name> -n <command>
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Example:

rsh my_unix -l my_name -n "cd ~;pwd"

Note: You can use only RSH commands that work from the DOS command prompt
window.

n Verify that no output is generated after executing the RSH command.

Note: You should not generate output from the .login, .profile, and .cshrc files (for
example, by echo, or in any other way, including commands that generate output
indirectly, such as biff). Where an existing user generates output in the RSH step that
cannot be deleted, you should create a new user that does not generate output, and who
has permissions to run RSH andRCP commands on the server machine.

3. Configure the server machine to enable diagnostics
To configure Siebel application andWeb servers for diagnostics data collection:

a. Enable Siebel Diagnostics on all Siebel application and Web servers involved in
the test.

Set the environment variable on the Siebel server to:

SIEBEL_SarmEnabled=true

Then restart the server.

b. Optimize the server performance settings.

You change themaximummemory caching and file size using the following variables:

SIEBEL_SarmMaxMemory= <bytes>SIEBEL_SarmMaxFileSize = <bytes>

TheSIEBEL_SarmMaxMemory value controls the size of the buffer that Siebel keeps in
thememory before writing the information to the Siebel log files. You can improve server
performance by increasing the parameter value. However, information from the end of the
run will bemissing from the Analysis graphs.

We recommend the following settings:

o SIEBEL_SarmMaxMemory
Value Number of Vusers

5000 Less than 20 (low loads)

1000000 More than 100 (high loads)

o SIEBEL_SarmMaxFileSize

HP ALM LabManagement (11.50)Page 154 of 231



HP ALM Lab Management Guide
Chapter 10: Diagnostics Management

Value Number of Vusers

5000000 Less than 20 (low loads)

25000000 More than 100 (high loads)

If more than one Siebel log file is generated on the server every 10 seconds, you should
increase theSIEBEL_SarmMaxFileSize.

c. Generate a list of Siebel Server IDs.

On the Siebel server, open a commandwindow and run the following command:

<Siebel bin directory>\srvrmgr /u <username> /p <password> /g

<gateway server> /e <entrpr server> /c "list servers show

SBLSRVR_NAME, SV_SRVRID"

where:

/u <username> is the server administrator username.

/p <password> is the server administrator password.

/g <gateway server> is the gateway server address.

/e <entrpr server> is the enterprise server name.

/c <command> is the execute a single command.

This command generates a list of all the Siebel application servers and their IDs. Keep a
record of the server IDs, since this information is required in the Siebel Server Configuration
dialog box.

4. Copy files from the Siebel Application Server to the Mediator
After configuring the application server, copy the files listed below from the Siebel Application
server \bin directory to either the <Mediator Root>\bin directory,
<Windows>\System32 directory, or any other directory in PATH on theMediator machine:

For Siebel 7.53, copy the following files:

n sarmanalyzer.exe

n sslcver.dll

n sslcsym.dll

n sslcshar.dll

n sslcosa.dll

For Siebel 7.7, copy the following files:
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n sarmanalyzer.exe

n libarm.dll

n msvcp70.dll

n msvcr70.dll

n sslcacln.dll

n sslccore.dll

n sslcevt.dll

n sslcos.dll

n sslcosa.dll

n sslcosd.dll

n sslcrsa.dll

n sslcscr.dll

n sslcshar.dll

n sslcsrd.dll

n sslcsym.dll

n sslcver.dll

5. Synchronize clocks
n On Windows Siebel Servers:Ensure that all themachines' clocks in the Siebel system

are synchronized. This ensures that the correlation of SQLs to transactions is correct.

Synchronize the Siebel Gateway and load generators' clocks by running the following
command from the load generator:

net time \ <Gateway name> /set /y

Replace <Gateway name> with the name of the Siebel Gateway.

n On Unix Siebel Servers:Ensure that all themachines' clocks in the Siebel system are
synchronized. This ensures that the correlation of SQLs to transactions is correct.

You can synchronize the clocks on a UNIX system in one of the following ways:

o Use the date command on the UNIX Siebel Gateway server to change the time
manually, so it will be synchronized with the LoadGenerator's clock.

o Change the time on the load generator so that it will be synchronized with the UNIX
Siebel Gateway server.

o Configure the time difference in Analysis. For more information, see the chapter about
Siebel DB Diagnostics Graphs in theHP LoadRunner Analysis User Guide.

6. (Siebel DB) Enable logging on the Siebel Server
For task details, see "How to Enable and Disable Logging on the Siebel Server" on page 158.

How to Pre-Configure Oracle 11i Diagnostics
This task describes the pre-configuration steps to be performed by the ALM administrator which
allow the performance tester to enable and runOracle 11i diagnostics.

Note: This task is part of a higher-level task. For details, see "How toWork with Lab
Management Administration" on page 22.

This task includes the following steps:
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l "Prerequisite" below

l "Consider this before connecting to a UNIX server with a remote shell (RSH/RCP) connection"
below

l "Enable logging on theOracle server" below

l "Set or disable the Oracle server diagnostics password - optional" below

1. Prerequisite
Make sure that the ERP/CRMmediator is installed and configured. For more information, see
"How to Add ERP/CRMMediators" on page 152.

2. Consider this before connecting to a UNIX server with a remote shell
(RSH/RCP) connection
n Verify that the RSH andRCP daemons are running on the UNIX server.

n Verify that the UNIX user has permission to run remote shell commands. To check this,
type the following at the DOS command prompt:

rsh <server machine name> -l <UNIX user login name> -n <command>

Example:

rsh my_unix -l my_name -n "cd ~;pwd"

Note: You can only use RSH commands that work from the DOS command prompt
window.

n Verify that no output is generated after executing the RSH command.

Note: You should not generate output from the .login, .profile, and .cshrc files (for
example, by echo, or in any other way, including commands that generate output
indirectly, such as biff). Where an existing user generates output in the RSH step that
cannot be deleted, you should create a new user that does not generate output, and
who has permissions to run RSH andRCP commands on the server machine.

3. Enable logging on the Oracle server
For task details, see "How to Enable Logging on theOracle Server" on page 159.

4. Set or disable the Oracle server diagnostics password - optional
To help ALM deal with the Oracle server diagnostics password, you can either set the
password in the Vuser script, or you can disable the password request on the server itself. For
task details, see "How to Set and Disable the Oracle Server Diagnostics Password" on page
160.
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How to Pre-Configure SAP Diagnostics
This task describes the pre-configuration steps to be performed by the ALM administrator that
allows the performance tester to enable and run SAP diagnostics.

Note: This task is part of a higher-level task. For details, see "How toWork with Lab
Management Administration" on page 22.

Install the ERP/CRMMediator
Make sure that the ERP/CRMmediator is installed and configured. For more information, see "How
to Add ERP/CRMMediators" on page 152.

Note:When using SAP Diagnostics, ensure that a SAPGUI client is installed on the same
machine as the ERP/CRMMediator.

How to Enable and Disable Logging on the
Siebel Server

This task describes how to enable and disable logging on the Siebel server.

Note:

l This task is part of a higher-level task. For details, see "How toWork with LabManagement
Administration" on page 22.

l Enabling logging on the Siebel server can negatively impact server performance. We
recommend that you disable logging and restore the default logging settings at the
conclusion of the performance test.

To enable logging on the Siebel server
Perform the following steps:

1. Open a commandwindow and run the following command:
<Siebel bin directory>\srvrmgr /g <gateway server> /s <Siebel

server> /e <enterprise server name> /u <username> /p <password>

where:

/u <username> is the server administrator username.

/p <password> is the server administrator password.

/g <gateway server> is the gateway server address.

/e <entrpr server> is the enterprise server name.

/s <siebel server > is the siebel server (the default server).
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2. Enter the following commands:

change evtloglvl ObjMgrsqllog=4 for comp <component name>

evtloglvl EventContext=3 for comp <component name>

evtloglvl ObjMgrSessionInfo =3 for comp <component name>

Example:

For the Call Center component, enter sccobjmgr_enu as the component name, as
follows:

change evtloglvl ObjMgrsqllog=4 for comp sccobjmgr_enu

To disable logging on the Siebel server
Perform the following steps:

1. Open a commandwindow and run the following command:

<Siebel bin directory>\srvrmgr /g <gateway server> /s <Siebel

server> /e <enterprise server name> /u <username> /p <password>

where:

/u <username> is the server administrator username.

/p <password> is the server administrator password.

/g <gateway server> is the gateway server address.

/e <entrpr server> is the enterprise server name.

/s <siebel server> is the siebel server name (the default server).

2. Enter the following commands:

change evtloglvl ObjMgrsqllog=0 for comp <component name>

change evtloglvl EventContext=0 for comp <component name>

change evtloglvl ObjMgrSessionInfo =0 for comp <component name>

How to Enable Logging on the Oracle Server
This task describes how to enable logging on theOracle server.

Note: This task is part of a higher-level task. For details, see "How toWork with Lab
Management Administration" on page 22.

This task includes the following steps:
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l "Verify that the trace diagnostics are enabled" below

l "Set the trace file size to unlimited" below

1. Verify that the trace diagnostics are enabled
Perform the following steps:

a. Log on to the Oracle application server with administrator privileges, and select the desired
module in the Oracle application. The Responsibilities dialog box opens.

b. Select System Administrator and click OK.

c. In the Functions tab, select Profile > System and click Open. The System Profile Values
dialog box opens.

d. In theDisplay section, select Site andProfiles with No Values, enter %Diagnostics%
in theProfiles field, and then click Find.

e. If any diagnostics profiles are disabled (denoted by a "Yes" in theSite column), change the
setting to "No".

f. Save your settings.

2. Set the trace file size to unlimited
For Oracle 9i:

On theOracle server, run the following command in the SQL editor:

Alter system set max_dump_file_size=UNLIMITED scope=both;

For Oracle 8i:

a. On theOracle server, run the following command in the SQL editor:

Alter system set max_dump_file_size=2048000;

b. Edit the init*.ora file on $ORACLE_HOME\admin\<sid>\pfile\init<sid>.ora. Find the
line of the parameter, change its value, and then save the file.

Note: Verify that you have enough disk space on the database server since these
trace files can be very large.

How to Set and Disable the Oracle Server
Diagnostics Password

To help ALM deal with the Oracle server diagnostics password, you can either set the password in
the Vuser script, or you can disable the password request on the server itself.

Note: This task is part of a higher-level task. For details, see "How toWork with Lab
Management Administration" on page 22.
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l "Set the diagnostics password in the Vuser script" below

l "Disable the diagnostics password request on the Oracle server" below

Set the diagnostics password in the Vuser script
In VuGen, add the nca_set_diagnostics_password(<password>) function to your script and
select a password.

Note: The nca_set_diagnostics_password functionmust come after the nca_connect_
server function.

Disable the diagnostics password request on the Oracle server
Perform the following steps:

1. Log on to the Oracle server with administrator privileges, and select the desiredmodule in the
Oracle application. The Responsibilities dialog box opens.

2. Select System Administrator and click OK.

3. In the Functions tab, select Profile > System and click Open. The System Profile Values
dialog box opens.

4. In theDisplay section, select User, and enter the required user name. In theProfile field,
enter %Utilities:Diagnostics% and click Find. The Utilities:Diagnostics profile values
are displayed.

5. In theUser column of the Utilities:Diagnostics profile, set the value toYes.

6. Save your settings.

Diagnostics User Interface
This section includes:

Diagnostics ModuleWindow 162

Diagnostics Module Fields 163

Diagnostics ModuleMenus and Buttons 164
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Diagnostics Module Window
The Diagnostics ModuleWindow enables you to add andmanage ERP/CRMmediators and
J2EE/.NET servers.

To access On the LabManagement sidebar, underPerformance Center, select
Diagnostics.

Relevant
tasks

l "How to Add ERP/CRMMediators" on page 152

l "How to Add HP Diagnostics Servers" on page 152

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<ALM common
areas>

For details on the ALM common areas, see theHP Application Lifecycle
Management User Guide.

<Diagnostics
module fields>

For details on the fields that are available in the Diagnostics module, see
"Diagnostics Module Fields" on next page.

<Diagnostics
module menus
and buttons>

For details on the icons that are available in the Diagnostics module, see
"Diagnostics ModuleMenus and Buttons" on page 164.

ERP/CRM
Diagnostics tab

Enables you to add andmanage ERP/CRMDiagnostics mediators.

J2EE/.NET
Diagnostics tab

Enables you to add andmanage J2EE/.NET Diagnostics servers.

History tab Displays a history of the changes made to the selected server/mediator,
including the date and time of the change and the name of the user who
made the change.

For details, see theHP Application Lifecycle Management User Guide.
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Diagnostics Module Fields
This section describes the Diagnostics module fields.

Field Description

Description A description of themediator/server.

Enable
SSL

Select Enable if ALM is communicating with Diagnostics through SSL.

Logical
Name

The logical name given to themediator/server.

Machine
Name / IP

The name or IP address of themediator/server.

Over
Firewall

Denotes if monitoring over a firewall is enabled or not. Select Y for enabled andN
for not enabled.

Note: Available for ERP/CRM diagnostice only.

Password Enter the password you use to log in to HP Diagnostics.

Default:Admin

Note: Available for J2EE/.NET diagnostics only.

Port Enter the port number used by the diagnostics server.

Default: 2006

Note: Available for J2EE/.NET diagnostics only.

Type The ERP/CRMmediator type.

Note: Available for ERP/CRM diagnostics only.

Username Enter the user namewith which you log on to HP Diagnostics.

Note: The user name that you specify should have view, change, and
execute privileges. For more information about user privileges, see theHP
Diagnostics Installation and Configuration Guide.

HP ALM LabManagement (11.50)Page 163 of 231



HP ALM Lab Management Guide
Chapter 10: Diagnostics Management

Diagnostics Module Menus and Buttons
This section describes themenus and buttons in the Diagnostics module.

UI Elements
(A - Z)

Menu Description

Edit and <right-
click menu>

Deletes the selected server/mediator from the grid.

Check
Server/Mediator

Diagnostics
Server/Mediator
and <right-click
menu>

Click to check if the server/mediator is up and running.

Copy URL

Diagnostics
Server/Mediator

Copies a selected server/mediator and pastes its URL as a
link. The server/mediator itself is not copied. Instead, you can
paste the address into another location, such as an email or a
document. Clicking the link opens up ALM and takes you to
the server/mediator. If you are not already logged in, ALM first
prompts for login details.

Diagnostics
Server/Mediator
Details

Diagnostics
Server/Mediator
and <right-click
menu>

Click to view server/mediator details.

Export Diagnostics
Server/Mediator
and <right-click
menu>

Opens the Export Grid Data dialog box, enabling you to
export the servers/mediators in the grid as a text file,
Microsoft Excel worksheet, Microsoft Word document, or
HTML document.

Choose one of the following options:

l All. Exports all servers/mediators in the grid.

l Selected. Exports selected servers/mediators in the grid.

Find View Opens the Find dialog box, enabling you to search for field
details in themodule. For details, see theHP Application
Lifecycle Management User Guide.

Go to
Diagnostics
Server/Mediator

Diagnostics
Server/Mediator

Opens a dialog box which prompts you for the
server/mediator ID. Click OK to open the server/mediator
details window.

Grid Filters View and
<right-click
menu>

Enables you filter the data according to an entry in the filter
box. For details about filtering options, see theHP
Application Lifecycle Management User Guide.
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UI Elements
(A - Z)

Menu Description

Information
Panel

View and
<right-click
menu>

Shows/Hides the Information Panel in the lower area of the
module.

New
Diagnostics
Server/Mediator

Diagnostics
Server/Mediator

Click to add a new ERP/CRMmediator or J2EE/.NET
server. For information on the relevant fields, see
"Diagnostics Module Fields" on page 163.

Refresh All View Refreshes the grid so that it displays themost up-to-date
information.

Replace Edit and <right-
click menu>

In the grid, opens the Replace dialog box, enabling you to
replace a field value in the grid. For more details, see theHP
Application Lifecycle Management User Guide.

Select
Columns

View Opens the Select Columns dialog box, enabling you to
determine which fields to display in the grid and their order.
For more details, see theHP Application Lifecycle
Management User Guide.

For details about the Diagnostics fields, see "Diagnostics
Module Fields" on page 163.

Set Filter/Sort View Enables you to filter and sort the resources in the grid. Any
currently applied filters or sorting orders are displayed below
the toolbar. For more details, see theHP Application
Lifecycle Management User Guide.

Update
Selected

Edit and <right-
click menu>

Opens the Update Selected dialog box, enabling you to
update a field value for amultiple selection in the grid. For
more details, see theHP Application Lifecycle Management
User Guide.
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Chapter 11

Patch Management
This chapter includes:

Patches Overview 167

How to Upload Patches to ALM 167

PatchManagement User Interface 167

Patches Overview
ALM Performance Center allows you to upload a patch to the system and to then install the patch
on the appropriate host or server.

How to Upload Patches to ALM
This task describes how to upload patches to ALM.

Note: This task is part of a higher-level task. For details, see "How toWork with Lab
Management Administration" on page 22.

To upload a patch:

1. On the LabManagement sidebar, underPerformance Center, select Patches.

2. Click theNew Patch button . The Select Patch dialog box opens, enabling you to select a
patch (.msp/.msi) to upload.

3. Click Open. The New Patch dialog box opens.

4. Enter the details for the new patch and click OK. The patch is added to the system and
appears in the Patches grid.

Patch Management User Interface
This section includes:

Patches ModuleWindow 168

Patches Module Fields 169

Patches ModuleMenus and Buttons 169

Patch Details Dialog Box 171

New Patch Dialog Box 172
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Patches Module Window
This module enables you to view and upload patches.

To access On the LabManagement sidebar, underPerformance Center, select
Patches.

Relevant tasks "How to Upload Patches to ALM" on previous page

See also l "How toManage Lab Resources" on page 57

l "How toManage Performance Center Servers" on page 199

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements (A - Z) Description

<Information
panel>

Located in the lower area of themodule. Displays a description about the
patch selected in the grid.

<Patches grid> Displays a list of the patches that have been uploaded to ALM
Performance Center.

<Patches module
common UI
elements>

l Patches module fields. For field definitions, see "Patches Module
Fields" on next page.

l Patches module menus and buttons. For command and button
descriptions, see "Patches ModuleMenus and Buttons" on next page.

l ALM main menu and sidebar. For details on the Tools menu, Help
menu and sidebar, see theHP Application Lifecycle Management
User Guide.
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Patches Module Fields
This section describes the Patches module fields:

Field Description

Description Displays a description of the selected patch.

ID The patch ID.

Name The patch name.

Path The patch path.

Patches Module Menus and Buttons
This section describes themenus and buttons available in the Patches module.

To access On the LabManagement sidebar, underPerformance Center, select Patches.

User interface elements are described below:

UI
Elements
(A - Z)

Where Description

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite view
to your private or the public folder. For details, see theHP Application
Lifecycle Management User Guide.

Copy URL Patches
and
<right-
click
menu>

Copies a selected patch and pastes its URL as a link. The patch itself
is not copied. Instead, you can paste the address into another location,
such as an email or a document. Clicking the link opens up ALM and
takes you to the patch file or folder. If you are not already logged in,
ALM first prompts for login details.

Export Patches
and
<right-
click
menu>

Opens the Export Grid Data dialog box, enabling you to export the
patches in the grid as a text file, Microsoft Excel worksheet, Microsoft
Word document, or HTML document.

Choose one of the following options:

l All. Exports all project settings in the grid.

l Selected. Exports selected project settings in the grid.

Find View Opens the Find dialog box, enabling you to search for patches in the
module. For details about search options, see theHP Application
Lifecycle Management User Guide.
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UI
Elements
(A - Z)

Where Description

Go to
Patch

Patches Opens theGo To Patch dialog box, enabling you to find a specific patch
by its ID number. You can only go to patches that are in the current
filter.

Grid Filters View and
<right-
click
menu>

Enables you filter the data according to an entry in the filter box. For
details about filtering options, see theHP Application Lifecycle
Management User Guide.

Information
Panel

View and
<right-
click
menu>

Shows/Hides the Information Panel in the lower area of themodule.

New Patch Patches Opens the Select Patch dialog box, which enables you to select a
patch to upload.

Organize
Favorites

Favorites Opens theOrganize Favorites dialog box, enabling you to organize the
list of favorite views by changing properties or deleting views. For
details, see theHP Application Lifecycle Management User Guide.

Patch
Details

Patches
and
<right-
click
menu>

Opens the Patch Details dialog box, enabling you to view and edit
details of the selected patch.

Private Favorites Lists the favorite views that are accessible only to the user who created
them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All View Refreshes the grid so that it displays themost up-to-date information.

Replace Edit and
<right-
click
menu>

In the Project Details grid, opens the Replace dialog box, enabling you
to replace a field value in the grid. For more details, see theHP
Application Lifecycle Management User Guide.
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UI
Elements
(A - Z)

Where Description

Select
Columns

View Opens the Select Columns dialog box, enabling you to determine which
fields to display in the grid and their order. For more details, see theHP
Application Lifecycle Management User Guide.

For details about the patches fields, see "Patches Module Fields" on
page 169.

Set
Filter/Sort

View Enables you to filter and sort the patches in the grid. Any currently
applied filters or sorting orders are displayed below the toolbar. For
more details, see theHP Application Lifecycle Management User
Guide.

Update
Selected

Edit and
<right-
click
menu>

Opens the Update Selected dialog box, enabling you to update a field
value for amultiple selection in the grid. For more details, see theHP
Application Lifecycle Management User Guide.

Patch Details Dialog Box
This dialog box enables you to view details of a patch in LabManagement.

To access On the LabManagement sidebar, underPerformance Center, select
Patches.

Relevant tasks "How to Upload Patches to ALM" on page 167

See also l "How toManage Lab Resources" on page 57

l "How toManage Performance Center Servers" on page 199

User interface elements are described below:
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UI Elements
(A - Z)

Description

First/Previous/Next/Last Entity. Enables you to browse through the list of
projects.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure how to check the spelling.

Details For field definitions, see "Patches Module Fields" on page 169.

New Patch Dialog Box
This dialog box enables you to add new Performance Center patches.

To access 1. On the LabManagement sidebar, underPerformance Center, select
Patches.

2. Click theNew Patch button . The Select Patch dialog box opens.

3. Navigate to the location of the patch, and click Open.

Relevant tasks "How to Upload Patches to ALM" on page 167

User interface elements are described below:
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UI
Elements
(A - Z)

Description

Clear All Fields. Clears all data in the dialog box.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure how to check the spelling.

Details Lists Patches fields. Required fields are displayed in red. For details on the
available fields, see "Patches Module Fields" on page 169.

Tip: Clicking in theDescription field on this page displays a toolbar for
formatting and spell checking the text.

Name Type a name for the new patch.

Syntax exceptions:A server name cannot include the following characters: \ / : "
? < > | * % '
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Chapter 12

AUT Host Management
This chapter includes:

AUT Resources Overview 175

How to Import AUT Host Data from Excel 175

AUT ResourceModules User Interface 179

AUT Resources Overview
Application Under Test (AUT) components such as Web/application servers or database servers
are hosted onmachines known as AUT hosts. The AUT hosts are grouped together in logical
containers, known as AUT Pools. The AUT hosts are a core element of the Topology and
SiteScope integration features.

How to Import AUT Host Data from Excel
This task describes how to import a list of AUT hosts from an Excel file (.xls or .csv) into ALM.

This task includes the following steps:

l "Prerequisites" below

l "Import the AUT hosts (only for Performance Center users)" on page 178

l "Results" on page 179

1. Prerequisites
The Excel file must be set up so that the columns can be recognized andmapped by the Import
feature.

n The first row of the Excel file must contain the field names, or corresponding logical names,
that appear in the table below. (Logical names are not case sensitive.)

Some fields aremandatory, others are required or optional.

o Mandatory indicates a field thatmust appear in the Excel file. If you omit this field, the
import fails. If you omit a value in one of the rows of this field's column, the import of that
specific row fails.

o Required indicates a field that should appear in the Excel file. If you omit this field, the
code adds the field with the default value for all rows. If you include the field, but omit a
value in one of the rows of this column, the code adds the default value for that row.
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o Optional indicates a field does not have to appear in the Excel file. Omitting this field has
no effect on the import procedure.

n Fields representing virtual, reference, and invalid fields are ignored.

n Empty columns are allowed.

Set up the columns and values in the file as follows:

Field name
Logical
name Value Field for

AUTHOST_
NAME

Required

Logical
Name

Any string AUT host logical name

Note: If this value is empty, this will be
given the same value as AUTHOST_
MACHINE_NAME

AUTHOST_
MACHINE_
NAME

Mandatory

Machine
Name / IP

Themachine
name/IP

AUT host physical machine name

AUTHOST_
USERNAME

Mandatory

Username The user name of
themachine

User name for logging on to the AUT
host machine

AUTHOST_
PASSWORD

Mandatory

Password The password of
the user name

Password for logging on to the AUT
host machine
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Field name
Logical
name Value Field for

AUTHOST_OS

Required for
UNIX platforms
only

OS Type n SUNOS
(default)

n Sun Solaris

n MacOSX

n Linux

n RedHat
Enterprise Linux

n AIX

n FreeBSD

n HP-UX

n HP/UX

n HP/UX 64-bit

n NonStopOS

n OPENSERVER

n SCO

n SGI Irix

n Tru64 5.x

n Tru64 pre 4.x
(Digital)

AUT host machine operating system

(For UNIX platform only)

AUTHOST_
PLATFORM

Required

Platform n Windows
(default)

n UNIX

AUT host platform
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Field name
Logical
name Value Field for

AUTHOST_
PROTOCOL

Required

Protocol Windows:

n NetBIOS
(default)

n SSH

n WMI

UNIX:

n rlogin

n Telnet (default)

n SSH

AUT host protocol

AUTHOST_
UNIX_
PROMPT    

Required for
UNIX platforms
only

UNIX
Prompt

# (default) UNIX prompt on the AUT host machine

AUTHOST_
DESCRIPTION

Optional

Description Any string AUT host description

Example:

The following image illustrates an Excel file set up with the following AUT hosts: 1.2.3.4,
5.6.7.8, and a third machine whose namewas not provided.

2. Import the AUT hosts (only for Performance Center users)
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a. Open the AUT Hosts module:

o In ALM:On the ALM sidebar, underPerformance Center AUT, select AUT Hosts.

o In Lab Management:On the LabManagement sidebar, underPerformance Center,
select AUT Hosts.

b. Select AUT Hosts > Import.

c. Browse to the Excel file containing the AUT hosts, and click Open.

3. Results
The progress of the import process is displayed. At the end of the process, a report displays
the import results. The imported AUT hosts are listed in the AUT Hosts module. AUT hosts
that are not imported successfully, must be addedmanually.

Example:

The results from importing the Excel file in step 1 above are illustrated in the following
image:

Note:

n No logical namewas provided in the Excel file for machine 1.2.3.4. Therefore, the
logical name given is equivalent to themachine name/IP.

n Machine 1's operating system was specified as SUNOS, whereas the platform was
specified as Windows. These values are inconsistent as SUNOS is relevant only for a
UNIX platform. The value SUNOS was replaced with NT.

n Nomachine namewas specified for the third machine listed in the Excel file. This
machine was not imported. It should be addedmanually.

n Required but non-mandatory values were automatically provided by the system during
the import process.

n Columns representing virtual, reference, non-valid fields were ignored.

AUT Resource Modules User Interface
This section includes:
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AUT Hosts Module 181

AUT Host Fields 182

New AUT Host Dialog Box 182

AUT Host Details Dialog Box 184

AUT Pools Module 185

Linked Hosts Page 186

Add AUT Hosts to Pool Dialog Box 187

AUT Pools Fields 189

New AUT Host Pool Dialog Box 189

AUT Host Pool Details Dialog Box 190

AUT ResourceModuleMenus and Buttons 191
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AUT Hosts Module
This module enables you to view andmanage AUT hosts.

To access Use one of the following:

l On the LabManagement sidebar, underPerformance Center, select
AUT Hosts.

l On the ALM sidebar, underPerformance Center AUT, select AUT
Hosts.

Important
information

The AUT Host module is available both in LabManagement and in ALM.

See also "AUT Resources Overview" on page 175

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Common Menus
and Toolbars>

For details on AUT Resourcemodules menus and toolbars, see "AUT
ResourceModuleMenus and Buttons" on page 191.

<AUT Hosts grid> Displays a list of AUT hosts defined in ALM.

Description tab Displays themain details and a description about the AUT host.

Tip: Right-click theDescription area for edit and format options.

History tab Lists changes made to the selected AUT host. For more details, see the
HP Application Lifecycle Management User Guide.
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AUT Host Fields
The following table describes the AUT host fields:

Field (A - Z) Description

Belongs to
Pools

The host pools to which the AUT host belongs.

Available from: LabManagement only

Description A description of the AUT host.

Logical
Name

The logical name given to the AUT host.

Machine
Name/IP

The name or IP address of the AUT host machine.

Modified The date on which the AUT host details were last modified.

OS Type The operating system of the AUT host machine.

Password The password for logging in to the AUT host machine.

Platform The base operating system of the AUT host machine: Window or UNIX.

Protocol The network protocol used for communication with the AUT host (for monitoring
purposes).

Default value:Windows: NetBIOS; UNIX: SSH

UNIX
Prompt

The prompt used by the operating system. Also used for communication with the
AUT host (for monitoring purposes).

Available for:UNIX AUT hosts only.

Username The user name for logging in to the AUT host machine.

New AUT Host Dialog Box
This dialog box enables you to create a new AUT host.
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To access Use one of the following:

l On the LabManagement sidebar, underPerformance Center, select AUT

Hosts. Click New AUT Host .

l On the ALM sidebar, underPerformance Center AUT, select AUT Hosts.

Click New AUT Host .

Important
information

When creating an AUT host in ALM, the AUT host is automatically added to the
project's AUT Pool.

Tip: You can import a list of AUT hosts from an Excel file. For details, see "How
to Import AUT Host Data from Excel" on page 175.

See also "AUT Resources Overview" on page 175

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure how to check the spelling.

Machine
Name/IP

The name or IP of the AUT host machine.

Details Enables you to enter the details of the new AUT host. For more details, see "AUT
Host Fields" on previous page.
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AUT Host Details Dialog Box
This dialog box enables you to view andmodify AUT host details.

To access Use one of the following:

l On the LabManagement sidebar, underPerformance Center,
select AUT Hosts. Right-click an AUT host in the grid and select
AUT Host Details.

l On the ALM sidebar, underPerformance Center AUT, select AUT
Hosts. Right-click an AUT host in the grid and select AUT Host
Details.

See also "AUT Resources Overview" on page 175

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse through the list of
AUT hosts.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure how to check the spelling.

Machine Name/IP The name or IP of the AUT host machine.

Details Displays the details of the selected AUT host. For more details, see "AUT
Host Fields" on page 182.

History Lists changes made to the selected AUT host. For more details, see theHP
Application Lifecycle Management User Guide.
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AUT Pools Module
This module enables you to view andmanage AUT Pools.

To
access

On the LabManagement sidebar, underPerformance Center, select AUT Pools.

Relevant
tasks

The AUT Pools module is available only in LabManagement.

See also "AUT Resources Overview" on page 175

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

<Common
Menus and
Toolbars>

For details on AUT Pools modulemenus and toolbars, see "AUT Resource
ModuleMenus and Buttons" on page 191.

<AUT Pools
grid>

Displays the AUT Pools defined in the system.

Description tab Displays themain details and a description about the AUT Pool.

Tip: Right-click theDescription area for edit and format options.

Linked Hosts tab Enables you to add AUT hosts to the selected pool and remove hosts from
the pool. For details, see "Linked Hosts Page" on next page.

History tab Lists changes made to the selected AUT Pool. For more details, see the
HP Application Lifecycle Management User Guide.
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Linked Hosts Page
This page enables you to add AUT hosts to an AUT Pool, and remove AUT hosts from an AUT
Pool.

To access l From the AUT Pools module:

On the LabManagement sidebar, underPerformance Center, select AUT
Pools. In the information panel, select Linked Hosts.

l From the AUT Pool Details dialog box:

On the LabManagement sidebar, underPerformance Center, select AUT
Pools. Right-click an AUT Pool and select AUT Pool Details. In the AUT
Pool Details dialog box, select Linked Hosts.

Note: Available in LabManagement only.

Important
information

The Linked Hosts page enables you to link multiple AUT hosts to an AUT Pool.

Alternatively, you can link a single AUT host to multiple AUT Pools from the
Belongs To Pools field in the AUT host's details. For details, see "AUT Host
Fields" on page 182.

See also "AUT Resources Overview" on page 175

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Elements

Description

Add Hosts to Pool. Opens the Add AUT Hosts to Pool dialog box, enabling you to
select AUT hosts to add to the AUT Pool.

Remove Host. Removes the selected AUT hosts from the AUT Pool.

Go to Host. Displays the selected linked AUT host in the AUT Hosts module.

AUT Host Details. Opens the AUT Host Details dialog box, enabling you to view
details about the selected linked AUT host. For details, see "AUT Host Fields" on
page 182.

Refresh All. Refreshes the grid so it displays themost up-to-date information.

Set Filter/Sort. Enables you to filter and sort the grid. Any currently applied filters or
sorting orders are displayed below the toolbar. For details, see theHP Application
Lifecycle Management User Guide.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For details, see theHP Application
Lifecycle Management User Guide.

Find. Opens the Find dialog box, enabling you to search for an AUT host. For details,
see theHP Application Lifecycle Management User Guide.

<Linked
Hosts
grid>

Lists the AUT hosts that belong to the AUT Pool. For details about the host fields,
see "AUT Host Fields" on page 182.

Add AUT Hosts to Pool Dialog Box
This page enables you to select AUT hosts to add to an AUT Pool.
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To access l From the AUT Pools module:

On the LabManagement sidebar, underPerformance Center select AUT
Pools. In the information panel, select Linked Hosts and click theAdd Hosts

to Pool button.

l From the AUT Pool Details dialog box:

On the LabManagement sidebar, underPerformance Center, select AUT
Pools. Right-click an AUT Pool and select AUT Pool Details. In the AUT
Pool Details dialog box, select Linked Hosts and click theAdd Hosts to

Pool button.

Note: Available in LabManagement only.

Important
information

Alternatively, you can link a single AUT host to multiple AUT Pools from the
Belongs To Pools field in the AUT host's details. For details, see "AUT Host
Fields" on page 182.

See also "AUT Resources Overview" on page 175

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements

Description

Refresh All. Refreshes the grid so it displays themost up-to-date information.

Select Columns. Opens the Select Columns dialog box, enabling you to
determine which fields to display in the grid and their order. For details, see theHP
Application Lifecycle Management User Guide.

Set Filter/Sort. Enables you to filter and sort the grid. Any currently applied filters
or sorting orders are displayed below the toolbar. For details, see theHP
Application Lifecycle Management User Guide.

Adds the selected AUT hosts to the AUT Pool.

<AUT
Hosts
grid>

Lists the AUT hosts available to add to the AUT Pool.

Selected Displays the AUT hosts selected to add to the pool.
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AUT Pools Fields
The following fields are available for AUT Pools:

Field Description

Description A description of the AUT Pool.

Modified The date on which the AUT Pool details were last modified.

Pool ID The ID of the AUT Pool.

Pool Name The name of the AUT Pool.

Note: The namemay contain up to 128 characters, excluding spaces,
periods, and any of the following characters:

: ; * \ / " ~ & ? { } $ % | < > + = ^ [ ] ( )

Total Hosts The total number of AUT hosts in the host pool.

New AUT Host Pool Dialog Box
This dialog box enables you to create a new AUT Pool.

To
access

On the LabManagement sidebar, underPerformance Center, select AUT Pools.

Click New AUT Pool .

See
also

"AUT Resources Overview" on page 175

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Elements

Description

Clear All Fields. Clears the data.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure how to check the spelling.

Pool
Name

The name of the AUT Pool.

Details Enables you to enter the details of the new AUT Pool. For more details, see "AUT
Pools Fields" on previous page.

AUT Host Pool Details Dialog Box
This dialog box enables you to view andmodify AUT Pool details.

To
access

On the LabManagement sidebar, underPerformance Center, select AUT Hosts.
Right-click an AUT host in the grid and select AUT Host Details.

See
also

"AUT Resources Overview" on page 175

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse through the list of
AUT Pools.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure how to check the spelling.

Pool Name The name of the AUT Pool.

Details Displays the details of the selected AUT Pool. For more details, see "AUT
Host Fields" on page 182.

Linked Hosts Enables you to add AUT hosts to the selected pool and remove hosts from
the pool. For details, see "Linked Hosts Page" on page 186.

History Lists changes made to the selected AUT Pool. For more details, see theHP
Application Lifecycle Management User Guide.

AUT Resource Module Menus and Buttons
Thesemodules enable you tomanage the AUT resources which host applications under test.

To access Use one of the following:

l In Lab Management: On the LabManagement sidebar, under
Performance Center, select <AUT Resource>.

l In ALM: on the ALM sidebar, underPerformance Center AUT, select
AUT Hosts.

Note: In LabManagement, you can define both AUT hosts and AUT
pools. In ALM, you can define only AUT hosts.

Important
Information

l AUT hosts can bemanaged both in LabManagement and in ALM.

l Only a user with administrator privileges canmanage AUT Pools (in Lab
Management).

See also "AUT Resources Overview" on page 175

User interface elements are described below (unlabeled elements are shown in angle brackets):
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UI
Elements
(A - Z)

Where Description

<AUT
resource>
Details

<AUT
resource>
and right-
click menu

Opens the <AUT resource> Details dialog box, enabling you to view
details of the selected AUT resource.

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite
view to your private or the public folder. For details, see theHP
Application Lifecycle Management User Guide.

Copy URL <AUT
resource>
and <right-
click
menu>

Copies a selected AUT resource URL and pastes it as a link. You
can paste the URL into another location, such as an email or a
document. Clicking the link opens up ALM and takes you to the
resource file or folder. If you are not already logged in, ALM first
prompts for login details.

Delete Edit and
<right-click
menu>

Deletes the AUT resource selected in the grid.

Export <AUT
Resource>
and <right-
click
menu>

Opens the Export All Grid Data dialog box, enabling you to export the
AUT resources in the grid as a text file, Microsoft Excel worksheet,
Microsoft Word document, or HTML document.

Choose one of the following options:

l All. Exports all resources in the grid.

l Selected. Exports selected resources in the grid.

Find View Opens the Find dialog box, enabling you to search for a resource in
themodule. For details about search options, see theHP Application
Lifecycle Management User Guide.

Go to
<AUT
Resource>

<AUT
Resource>

Opens theGo To <AUT Resource> dialog box, enabling you to find a
specific resource by its ID number. You can only go to resources that
are in the current filter.

Grid Filters View and
<right-click
menu>

Enables you filter the data according to an entry in the filter box. For
details about filtering options, see theHP Application Lifecycle
Management User Guide.
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UI
Elements
(A - Z)

Where Description

Import AUT
Hosts

Enables you to import a list of AUT hosts from an Excel file (.xls or
.csv) into ALM. For details, see "How to Import AUT Host Data from
Excel" on page 175.

Information
Panel

View and
<right-click
menu>

Shows/Hides the Information Panel in the lower area of themodule.

New <AUT
Resource>

<AUT
Resource>

Enables you to add an AUT resource.

Note: For AUT Pools, this is available in LabManagement only.

Organize
Favorites

Favorites Opens theOrganize Favorites dialog box, enabling you to organize
the list of favorite views by changing properties or deleting views. For
details, see theHP Application Lifecycle Management User Guide.

Private Favorites Lists the favorite views that are accessible only to the user who
created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All View Refreshes the grid so that it displays themost up-to-date information.

Replace Edit and
<right-click
menu>

Opens the Replace dialog box in the <AUT Resource> grid, enabling
you to replace a resource field value in the grid. For more details, see
theHP Application Lifecycle Management User Guide.

Select
Columns

View Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For details, see the
HP Application Lifecycle Management User Guide.

For details about the resource fields, see:

l "AUT Host Fields" on page 182

l "AUT Pools Fields" on page 189

Set
Filter/Sort

View Enables you to filter and sort the resources in the grid. Any currently
applied filters or sorting orders are displayed below the toolbar. For
details about filtering options, see theHP Application Lifecycle
Management User Guide.

Update
Selected

Edit and
<right-click
menu>

Opens the Update Selected dialog box, enabling you to update a field
value for amultiple selection in the <AUT resource> grid. For more
details, see theHP Application Lifecycle Management User Guide.
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Project Management
This chapter includes:

WorkingWith LabManagement Enabled Projects Overview 195

Working With Lab Management Enabled
Projects Overview

After you create a LabManagement enabled project, youmanage the project in Site Administration.
For information about managing projects in ALM, see theHP Application Lifecycle Management
Administrator Guide.

In addition to themanagement tasks in Site Administration, however, there are specific use-cases
where youmust be aware of additional procedures. These use-cases are:

Migrating a project from a staging to a production environment
Formore information, see "How toMigrate a LabManagement System from a Staging to a
Production Environment " on next page.

Creating a copy of a project
For information about how to create a copy of a project, see theHP Application Lifecycle
Management Administrator Guide.

When creating a copy of a LabManagement enabled project, youmust be aware of the following:

l The new project must also have the LabManagement extension enabled.

l Details about test runs will not be included in theUsage Reports.

l Timeslot and project settings are not copied.

l Result files associated with the original project are not copied.

Archiving a Lab Management project
Archiving a LabManagement enabled project means exporting or removing the project from the
server on which it is located, and in the future, importing the project back onto that same server.

For information about exporting, importing, and restoring access to projects, see theHP Application
Lifecycle Management Administrator Guide.

When archiving a LabManagement enabled project, youmust be aware of the following:

l You cannot import a project onto the original server, if a project with the same PUID exists on
that server.
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l When restoring access to the project:

n Details about test runs will not be included in theUsage Reports.

n Timeslot and project settings information is lost.

How to Migrate a Lab Management System from a
Staging to a Production Environment

The following task describes how to successfully move an LabManagement system from a staging
to a production environment.

Note: As a result of migrating the system, all information contained in LabManagement
originally created in the production environment will be lost.

The task includes the following steps:

l "Open Site Administration" below

l "Move LabManagement from the staging to the production environment" below

l "Activate LabManagement in the production environment"

l "Update the ALM license" below

l "Update Servers and Hosts" below

l "Move projects from the staging environment to the production environment" on next page

l "Activate the projects in the production environment" on next page

l "In the production environment, configure the project settings in LabManagement " on next page

1. Open Site Administration
For details, see theHP Application Lifecycle Management Administrator Guide.

2. Move Lab Management from the staging to the production environment
a. In the staging environment, in Site Administration, select the LabManagement tab.

b. Remove the LabManagement project from the staging and restore it in the production
environment. For details about removing and restoring LabManagement, see "Lab
Management Tab" on page 25.

3. Activate Lab Management in the production environment
For details about activating LabManagement, see "LabManagement Tab" on page 25.

4. Update the ALM license
In the production environment, in LabManagement, update the ALM license. For details, refer
to theHP Application Lifecycle Management Administrator Guide.

5. Update Servers and Hosts
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Note: Perform this step if the servers and hosts in the production environment are different
than those in the staging environment.

In LabManagement, remove the existing servers and hosts and replace them with new servers
and hosts.

n For details about how to add Performance Center Server, see "How toManage Performance
Center Servers" on page 199.

n For details about how to add hosts, see "How toManage Lab Resources" on page 57.

6. Move projects from the staging environment to the production
environment
Remove each project from the staging environment and restore them in the production
environment. For details about removing and restoring projects, seeHP Application Lifecycle
Management Administrator Guide.

7. Activate the projects in the production environment
For details about activating projects, seeHP Application Lifecycle Management Administrator
Guide.

8. In the production environment, configure the project settings in Lab
Management
Perform this step for each project youmoved to the production environment. For details about
configuring project settings, see "Project Settings" on page 29.
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Chapter 14

PC Servers
This chapter includes:

PC Servers Overview 199

How toManage Performance Center Servers 199

Performance Center Servers Module User Interface 201

PC Servers Overview
PC Servers contain information and resources needed for Performance Center functionality.
Managing servers involves monitoring the server status, editing server information, and checking
server performance.

PC Servers conduct labmanagement, test design, run operations, and the user interface services
for these operations. The onlineWeb pages create a heavy load on the Performance Center Server.
Using built-in load balancers, calls to and from ALM are balanced among the Performance Center
Servers in a round-robin fashion.

Note: Load balancing requires that at least two Performance Center Servers are installed in
your system.

For details onmanaging Performance Center servers, see "How toManage Performance Center
Servers" below.

How to Manage Performance Center Servers
This task describes the various options for managing the Performance Center Servers.

Note: This task is part of the following higher-level task: "How toWork with LabManagement
Administration" on page 22.

To learnmore about Performance Center Servers, see "PC Servers Overview" above.

This task includes the following steps:

l "Add a server" on next page

l "Check server connections to Performance Center servers" on next page

l "Reboot a server" on next page

l "Install a patch on a server" on next page
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Add a server
1. In LabManagement, select Servers > PC Servers.

2. Click theNew PC Server button .

3. In the New PC Server dialog box, enter the required information. For user interface details, see
"New PC Server Dialog Box" on page 209.

Check server connections to Performance Center servers
On the LabManagement sidebar, underServers, select PC Servers. Right-click a server in the
grid, and select Check Server > Check Server.

The Task Manager opens, and the overall result of each check performed on the server, Passed or
Failed, is displayed.

You can view the progress of the server check in the PC Servers module's Check Server Status
tab.

The following checks are performed:

l Ping to Server. The Performance Center server pings the selectedmachines.

l Ping URL. The selected server pings the listed URL.

Alternatively, you can perform the above checks, together with an additional connectivity check
from the server to a particular URL. Right-click a server in the grid, select Check Server > Check
Connectivity to URL, and enter the URL.

Examples:

l Regular URL: http://www.website.com

l Machine name: machine22 or http://machine22

Reboot a server
On the LabManagement sidebar, underServers select PC Servers. Right-click the server in the
grid that you want to reboot, and select Reboot Server.

Install a patch on a server

Note: To install patches on a server, patches first need to have been uploaded to the ALM. For
details, see "How to Upload Patches to ALM" on page 167.

On the LabManagement sidebar, underServers, select PC Servers. Right-click the server in the
grid on which to install the patch and select Install Patch.

Tip: You can install a patch onmultiple servers simultaneously. To select multiple servers,
hold down the CTRL key on your keyboard while selecting the servers.
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Performance Center Servers Module User
Interface

This section includes:

PC Servers ModuleWindow 202

PC Servers ModuleMenus and Buttons 203

PC Servers Module Fields 206

PC Server Details Dialog Box 207

New PC Server Dialog Box 209

Processes Page 210

Check Server Status Page 211
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PC Servers Module Window
The PC Servers Module window enables you tomanage Performance Center servers.

To access On the LabManagement sidebar, underServers, select PC Servers.

Relevant tasks "How toManage Performance Center Servers" on page 199

User interface elements are described below:

UI Elements
(A - Z)

Description

<PC Servers
Module
common UI
elements>

l PC Servers Fields. For field definitions, see "PC Servers Module Fields"
on page 206.

l PC Servers Menus and Buttons. For command and button descriptions,
see "PC Servers ModuleMenus and Buttons" on next page.

l ALM main menu and sidebar. For details on the Tools menu, Helpmenu
and sidebar, see theHP Application Lifecycle Management User Guide.

<grid filters> Located under each column name. Displays the filter that is currently applied
to a column. If the filter box is empty, no filter is currently applied to the
column.

Type directly into the box, or click the box to display the Browse button, which
opens the Select Filter Condition dialog box. For more details, see theHP
Application Lifecycle Management User Guide.

<servers grid> Displays a list of the Performance Center servers.

<Information
panel>

Located in the lower area of themodule. Displays information about the server
selected in the grid.
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UI Elements
(A - Z)

Description

Description
tab

Describes the currently selected server.

Click in the text box to display a toolbar for formatting and spell checking the
text.

Event Log tab Displays detailed information about the tasks performed on the selected
server, the action status, and a description of any errors. For details, refer to
theHP ALM Performance Center Guide.

Installed PC
Components
tab

Displays a list of the Performance Center components installed on the server
machine, including version and patches.

To refresh the grid, click .

Processes tab Displays detailed information about the processes and resource usage of the
selected server. For details, see "Processes Page" on page 210.

Check Server
Status tab

Displays the status of each step of the server checks. To see check server
status details, right click a line in the tab, and select Check Server Status
Details. For details, see "Check Server Status Page" on page 211.

History tab Lists changes made to the currently selected host. For more details, see the
HP Application Lifecycle Management User Guide.

PC Servers Module Menus and Buttons
This section describes themenus and buttons available in the PC Servers module.

To access On the LabManagement sidebar, underServers, select PC Servers.

Relevant tasks "How toManage Performance Center Servers" on page 199

User interface elements are described below:

UI Elements Menu Description

PC
Servers
and
<right-
click
menu>

Enables you to define the internal and external ALM URL.

The internal URL is used by all Performance Center
components to connect to ALM.

The URLmust be in the following format:
http://<alm>:<port>

Example: http://myalm:8080

Note: For SSL connectivity the ALM internal URLmust begin
with https, for example:
https://myalm:443
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UI Elements Menu Description

PC
Servers
and
<right-
click
menu>

Resets the system information on the selected server. For
example, internal/external URLs, user identity, and so on.

PC
Servers
and
<right-
click
menu>

Opens the Install Patch dialog box, enabling you to select
patches to install on the selected server.

PC
Servers

Checks connectivity between the selected server and other
machines in the system.

PC
Servers
and
<right-
click
menu>

Enables you to remotely reboot the selected server.

Add to Favorites Favorites Opens the Add Favorite dialog box, enabling you to add a
favorite view to your private or the public folder. For details,
see theHP Application Lifecycle Management User Guide.

Copy URL PC
Servers

Copies the selected server and pastes its URL as a link. The
server itself is not copied. Instead, you can paste the address
into another location, such as an email or a document. Clicking
the link opens up ALM and takes you to the resource file or
folder. If you are not already logged in, ALM first prompts for
login details.

Delete Edit and
<right-
click
menu>

Deletes the selected server in the grid.

Export PC
Servers
and
<right-
click
menu>

Opens the Export Grid Data dialog box, enabling you to export
the servers in the grid as a text file, Microsoft Excel
worksheet, Microsoft Word document, or HTML document.

Choose one of the following options:

l Export All. Exports all servers in the grid.

l Export Selected. Exports selected servers in the grid.
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UI Elements Menu Description

Find View Opens the Find dialog box, enabling you to search for a server
in themodule. For details, see theHP Application Lifecycle
Management User Guide.

Go to PC Server PC
Servers

Opens theGo To PC Servers dialog box, enabling you to find a
specific server by its ID number. You can only go to servers
that are in the current filter.

Grid Filters View Enables you filter the data according to an entry in the filter
box. For details about filtering options, see theHP Application
Lifecycle Management User Guide.

Information Panel View Shows/Hides the Information Panel in the lower area of the
module.

New PC Server PC
Servers

Enables you to add a PC Server.

Organize Favorites Favorites Organizes your favorite views. For details, see theHP
Application Lifecycle Management User Guide

PC Server Details PC
Servers
and
<right-
click
menu>

Opens the PC Servers Details dialog box, displaying details of
the selected server. For more information, see "PC Server
Details Dialog Box" on page 207.

Private Favorites Lists the favorite views that are accessible only to the user
who created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All View Refreshes the grid so that it displays themost up-to-date
information.

Replace Edit and
<right-
click
menu>

In the PC Servers grid, opens the Replace dialog box, enabling
you to replace a field value in the grid. For more details, see
theHP Application Lifecycle Management User Guide.
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UI Elements Menu Description

Select Columns View Opens the Select Columns dialog box, enabling you to
determine which fields to display in the grid and their order. For
more details, see theHP Application Lifecycle Management
User Guide.

For details about the PC Servers fields, see "PC Servers
Module Fields" below.

Set Filter/Sort View Enables you to filter and sort the servers in the grid. Any
currently applied filters or sorting orders are displayed below
the toolbar. For more details, see theHP Application Lifecycle
Management User Guide.

Update Selected Edit Opens the Update Selected dialog box, enabling you to update
a field value for amultiple selection in the grid. For more
details, see theHP Application Lifecycle Management User
Guide.

PC Servers Module Fields
This section describes the PC Servers module fields.

To access On the LabManagement sidebar, underServers, select PC Servers.

Relevant tasks "How toManage Performance Center Servers" on page 199

User interface elements are described below:

UI Elements
(A - Z)

Description

Configuration
Last Check

Displays whether the last configuration check passed or failed.

Connectivity
Last Check

Displays whether the last connectivity check passed or failed.

Description A description of the Performance Center Server.

External URL The URL used to connect to the Performance Center Server from an external
source.

Note: For SSL connectivity add a Performance Center server using the
following format for the external URL:

https://<pc_server>

Example: https://mypcs:443
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UI Elements
(A - Z)

Description

Installation
Last Check

Displays whether the last installation check passed or failed.

Internal URL The URL used for all internal communication between the Performance
Center Server and ALM, as well as for load balancing.

Name The server name that you assign when you configure a new server.

Performance
Last Check

Displays whether the last performance check passed or failed.

Server ID The server ID.

Server State The current state of the server. The possible states are:

l Idle. The server is idle.

l Installing patch. The installation patch is being installed on the server,
and the server is temporarily unavailable.

l Rebooting. The server is rebooting and is temporarily unavailable.

Default: Idle

Status The current server status. The possible statuses are:

l Operational.The server is working.

l Non-operational. The server is not working.

l Unavailable.The server is not available.

PC Server Details Dialog Box
The PC Servers Details dialog box enables you to view and update a single server.
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To access 1. On the LabManagement sidebar, underServers, select PC
Servers.

2. Right-click a server and select PC Server Details.

Relevant tasks "How toManage Performance Center Servers" on page 199

User interface elements are described below:

UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse through the list of
servers.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure how to check the spelling.

Server ID The ID of the server.

Name The name of the server.

Details Details the currently selected server. For details on the available fields, see
"PC Servers Module Fields" on page 206.

Event Log Displays detailed information about the tasks performed on the selected
server, the action status, and a description of any errors. For details, see
"Event Log" on page 79.

History Lists changes made to the currently selected server. For more details, see
theHP Application Lifecycle Management User Guide.

Installed PC
Components

Displays a list of the Performance Center components installed on the
server machine, including version and patches.

To refresh the grid, click .

Processes Displays detailed information about the processes and resource usage of the
selected server. For details, see "Processes Page" on page 210.

Server Check
Status

Displays the status of each step of the server checks. To see server check
status details, right click a line in the tab, and select Server Check Status
Details. For details, see "Check Server Status Page" on page 211.
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New PC Server Dialog Box
This dialog box enables you to add new Performance Center servers.

To access 1. On the LabManagement sidebar, underServers , select PC
Servers.

2. Click theNew PC Server button .

Relevant tasks "How toManage Performance Center Servers" on page 199

User interface elements are described below:

UI
Elements

Description

Clear All Fields. Clears all data in the dialog box.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure how to check the spelling.

Details Lists PC Server fields. Required fields are displayed in red. For details on the
available fields, see "PC Servers Module Fields" on page 206.

Tip: Clicking in theDescription field on this page displays a toolbar for
formatting and spell checking the text.

Name Type a name for the new server.

Syntax exceptions:A server name cannot include the following characters: \ / : " ?
< > | * % '
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Processes Page
This page displays detailed information about the processes and resource usage of the selected
server.

To
access

l From the PC Servers module:

On the LabManagement sidebar, underServers, select PC Servers. In the
information panel, select Processes.

l From the PC Servers Details dialog box:

On the LabManagement sidebar, underServers, select PC Servers. Right-click a
server and select Server Details. In the PC Server Details dialog box, select
Processes.

Relevant
tasks

"How toManage Performance Center Servers" on page 199

See also "PC Servers Overview" on page 199

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI Elements Description

Refresh. Refreshes the grid so it displays themost up-to-date information.
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UI Elements Description

Kill Process. Ends the process selected in the grid.

Note:

l Hosts module. Kill Process permissions are required to end the selected
process.

l Performance Center Servers module. A user with Viewer permissions
has the ability to end the selected process.

Auto
Refresh
every 5
second.

Refreshes the grid automatically after the selected time interval has passed.

<Processes
grid>

Displays the following details about the processes:

l Name. The name of the process.

l PID. The process ID.

l Processor Time (%). The percentage of processor time used by the process.

l Memory Usage (KBytes). The amount of memory (in kilobytes) used by the
process.

l Elapsed Time (d.hh:mm:ss). The amount of elapsed time since the start of
the process, where d is the number of days and hh:mm:ss is the number of
hours, minutes, and seconds that have elapsed.

<Navigation
area>

Located at the bottom of the page, enables you to navigate through the pages of
entries in the grid. The total number of entries is displayed on the right of the
navigation area.

Check Server Status Page
This page displays the status of each step of the server checks.
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To
access

l From the PC Servers module:

On the LabManagement sidebar, underServers , select PC Servers. In the
information panel, select Check Server Status.

l From the PC Servers Details dialog box:

On the LabManagement sidebar, underServers, select PC Servers. Right-click a
server and select PC Server Details. In the PC Server Details dialog box, select
Check Server Status.

Relevant
tasks

"How toManage Performance Center Servers" on page 199

See also "PC Servers Overview" on page 199

User interface elements are described below (unlabeled elements are shown in angle brackets):

UI
Elements
(A - Z)

Description

Check Server Status Details. The following fields are displayed:

l Actual Value. Actual value resulting from the server connectivity check.

l Check. The sub-areas in which the Check Server feature checks the servers.

l Check Result ID. The ID of each step of the server check.

l Expected Value. Value expected to result from the server check.

l Category. The areas in which the Check Server feature checks the server:
Configuration, Connectivity, Installation, and Performance.

l Check Date. The date the server was checked.

l Error. If an error occurred during the check, displays the error.

l Status. Indicates whether the server check passed or failed.

Refresh. Refreshes the page.

Set Filter/Sort. Enables you to filter and sort the grid. Any currently applied filters
or sorting orders are displayed below the toolbar. For details, see theHP
Application Lifecycle Management User Guide.

Select Columns. Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For details, see theHP Application
Lifecycle Management User Guide.

Find. Opens the Find dialog box, enabling you to search in the grid. For details, see
theHP Application Lifecycle Management User Guide.
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UI
Elements
(A - Z)

Description

<Check
Server
Status
grid>

Displays the status of the server checks. Click to select columns to display in
the grid.

Actual
Value

Actual value resulting from the server connectivity check.

Category The areas in which the Check Server feature checks the Server:

l Configuration

l Connectivity

l Installation

l Performance

Check The sub-areas the Check Server feature checks. For example, sub-areas in the
Performance check are Processor, Memory, and System.

Check
Date

The date the server was checked.

Check
Result ID

The ID of each step of the server check.

Error If an error occurred during the check, displays the error.

Expected
Value

Value expected to result from the server check.

Status Indicates whether the server check passed or failed.
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CDA Servers
This chapter includes:

CDA Servers Overview 215

How toManage CDA Servers 215

CDA Servers User Interface 216

CDA Servers Overview
The CDA Servers module is used to define HP Continuous Delivery Automation (CDA) servers
within LabManagement. CDA provides a datamodel that represents the artifacts and relationships
required to define how composite applications are delivered to a dynamic set of target
environments.

CDA integrates with ALM to provide dynamic provisioning and deployment of resources. When you
link an AUT environment configuration to CDA, ALM can then execute the run without requiring the
user to provide the specific values of the execution's environment parameters. Once CDA servers
are defined in LabManagement, they can be used in ALM to link AUT environment parameters to
CDA parameters.

How to Manage CDA Servers
This task describes how to create CDA servers in LabManagement. Youmanage CDA servers in
LabManagement and implement CDA linkages in ALM.

This task includes the following steps:

l "Update the Communication Security Passphrase" below

l "Create the CDA Server in LabManagement" below

l "Update Project Settings" on next page

1. Update the Communication Security Passphrase
a. In Site Administration, update theCOMMUNICATION_SECURITY_PASSPHRASE

default parameter. For details, seeHP Application Lifecycle Management Administrator
Guide.

b. Restart the HP Application Lifecycle Management service on the ALM server.

2. Create the CDA Server in Lab Management
a. In LabManagement, select Servers > CDA Servers.
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b. Click theNew CDA Server button .

Note: You can only have one CDA server per site.

c. In the New CDA Server dialog box, enter the required information. For user interface
details, see "New CDA Server Dialog Box" on page 220.

d. After you submit, the CDA server data will undergo a compatibility check. The internal
URL is used to check connectivity. If there are no problems with connectivity, your
CDA server will show up in the grid.

3. Update Project Settings
a. In LabManagement, select Lab Settings > Project Settings.

b. Select the relevant project from the grid and click theProject Settings Details
button.

c. In the Project Settings Details dialog box, update theCDA Server andCDA Domain
fields. Click OK.

Your CDA server is now ready to be linked with ALM.

CDA Servers User Interface
This section includes:

CDA Servers ModuleWindow 217

CDA Servers ModuleMenus and Buttons 218

CDA Servers Module Fields 219

New CDA Server Dialog Box 220

CDA Server Details Dialog Box 221
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CDA Servers Module Window

To access On the LabManagement sidebar, underServers, select CDA Servers.

Relevant tasks "How toManage CDA Servers" on page 215

User interface elements are described below:

UI Elements Description

<CDA Servers
Module
common UI
elements>

l CDA Servers Fields. For field definitions, see "CDA Servers Module
Fields" on page 219.

l CDA Servers Menus and Buttons. For command and button
descriptions, see "CDA Servers ModuleMenus and Buttons" on next
page.

l ALM main menu and sidebar. For details on the Tools menu, Help
menu and sidebar, see theHP Application Lifecycle Management User
Guide.

<grid filters> Located under each column name. Displays the filter that is currently applied
to a column. If the filter box is empty, no filter is currently applied to the
column.

Type directly into the box, or click the box to display the Browse button,
which opens the Select Filter Condition dialog box. For more details, see the
HP Application Lifecycle Management User Guide.

<servers grid> Displays a list of the CDA servers.

History tab Lists changes made to the currently selected CDA server. For more details,
see theHP Application Lifecycle Management User Guide.
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CDA Servers Module Menus and Buttons
This section describes themenus and buttons available in the CDA Servers module.

To access On the LabManagement sidebar, underServers, select CDA Servers.

Relevant tasks "How toManage CDA Servers" on page 215

User interface elements are described below:

UI
Elements
(A - Z)

Menu Description

Add to
Favorites

Favorites Opens the Add Favorite dialog box, enabling you to add a favorite
view to your private or the public folder. For details, see theHP
Application Lifecycle Management User Guide.

CDA
Server
Details

CDA
Servers
and <right-
click
menu>

Opens the CDA Servers Details dialog box, displaying details of the
selected server. For more information, see "CDA Server Details
Dialog Box" on page 221.

Delete Edit and
<right-click
menu>

Deletes the selected server in the grid.

Export CDA
Servers
and <right-
click
menu>

Opens the Export Grid Data dialog box, enabling you to export the
servers in the grid as a text file, Microsoft Excel worksheet,
Microsoft Word document, or HTML document.

Choose one of the following options:

l Export All. Exports all servers in the grid.

l Export Selected. Exports selected servers in the grid.

Find View Opens the Find dialog box, enabling you to search for a server in the
module. For details, see theHP Application Lifecycle Management
User Guide.

Go to CDA
Server

CDA
Servers

Opens theGo ToCDA Servers dialog box, enabling you to find a
specific server by its ID number. You can only go to servers that are
in the current filter.

Grid Filters View Enables you filter the data according to an entry in the filter box. For
details about filtering options, see theHP Application Lifecycle
Management User Guide.

Information
Panel

View Shows/hides the Information Panel in the lower area of themodule.
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UI
Elements
(A - Z)

Menu Description

New CDA
Server

CDA
Servers

Enables you to add a CDA Server.

Organize
Favorites

Favorites Organizes your favorite views. For details, see theHP Application
Lifecycle Management User Guide.

Private Favorites Lists the favorite views that are accessible only to the user who
created them.

Public Favorites Lists the favorite views that are accessible to all users.

Refresh All View Refreshes the grid so that it displays themost up-to-date
information.

Replace Edit and
<right-click
menu>

In the CDA Servers grid, opens the Replace dialog box, enabling you
to replace a field value in the grid. For more details, see theHP
Application Lifecycle Management User Guide.

Select
Columns

View Opens the Select Columns dialog box, enabling you to determine
which fields to display in the grid and their order. For more details,
see theHP Application Lifecycle Management User Guide.

For details about the PC Servers fields, see "PC Servers Module
Fields" on page 206.

Set
Filter/Sort

View Enables you to filter and sort the servers in the grid. Any currently
applied filters or sorting orders are displayed below the toolbar. For
more details, see theHP Application Lifecycle Management User
Guide.

Update
Selected

Edit Opens the Update Selected dialog box, enabling you to update a field
value for amultiple selection in the grid. For more details, see theHP
Application Lifecycle Management User Guide.

CDA Servers Module Fields
This section describes the CDA Servers module fields.

To access On the LabManagement sidebar, underServers, select CDA Servers.

Relevant tasks "How toManage CDA Servers" on page 215

User interface elements are described below:
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UI
Elements
(A - Z)

Description

External
URL

The URL used to connect to the CDA Server from an external source.

Note: For SSL connectivity add a CDA server using the following format for
the external URL:

https://<cda_server>

Example: https://mycdas:443

ID The server ID.

Internal
URL

The URL used for all internal communication between the Performance Center
Server and ALM, as well as for load balancing.

Name The server name that you assign when you configure a new server.

New CDA Server Dialog Box
This dialog box enables you to create a new CDA server.

To access 1. On the LabManagement sidebar, underServers , select CDA
Servers.

2. Click theNew CDA Server button .

Relevant tasks "How toManage CDA Servers" on page 215

User interface elements are described below:
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UI
Elements:

Description

Clear All Fields. Clears all data in the dialog box.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected word.

Spelling Options. Enables you to configure how to check the spelling.

Name Enter a name for the new server.

Syntax exceptions:A server name cannot include the following characters: \ / : "
? < > | * % '

CDA Server Details Dialog Box
The CDA Servers Details dialog box enables you to view and update a single server.

To access 1. On the LabManagement sidebar, underServers, select CDA
Servers.

2. Right-click a server and select CDA Server Details.

Relevant tasks "How toManage CDA Servers" on page 215

User interface elements are described below:
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UI Elements Description

First/Previous/Next/Last Entity. Enables you to browse through the list of
servers.

Spell Check. Checks the spelling for the selected word or text box.

Thesaurus. Displays a synonym, antonym, or related word for the selected
word.

Spelling Options. Enables you to configure how to check the spelling.

ID The ID of the server.

Name The name of the server.

Details Lists the details the currently selected server. For details on the available
fields, see "CDA Servers Module Fields" on page 219.

History Lists changes made to the currently selected server. For more details, see
theHP Application Lifecycle Management User Guide.
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HP ALM Lab Service
HP ALM Lab Service Overview 226

Installing HP ALM Lab Service 226

Using HP ALM Lab Service 226

HP ALM Lab Service Settings Page 228
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HP ALM Lab Service Overview
HP ALM Lab Service acts as an agent on the testing host, enabling ALM to remotely trigger
functional tests andmaintenance tasks on the host.

Lab Service runs in the background on the testing tool host. In order to integrate your testing host
with ALM LabManagement capabilities, you define the host in the Hosts/Testing Hosts module in
LabManagement or ALM and then point ALM Lab Service to the ALM server using the Lab Service
Settings page. For user interface details, see "HP ALM Lab Service Settings Page" on page 228.

A one-time registration process validates the identity of the agent and establishes a secure
communication channel between ALM and the host. After registration, use ALM to run functional
tests and perform maintenance tasks on the remote host.

Lab Service acts as a secure interface between ALM and your testing tool. Communications with
ALM, such as test requests, test results, andmaintenance tasks pass through Lab Service. The
Lab service communicates with ALM over the standard HTTP protocol and can traverse firewalls.
Stopping the ALM Lab service prevents ALM LabManagement from using the host for running
tests.

Installing HP ALM Lab Service
This task describes how to install HP ALM Lab Service.

1. Run the HP ALM Lab ServiceMSI installation file.

2. TheHP ALM Lab Service Setup Wizard launches on theWelcome page. Click Next.

3. TheSelect Installation Folder page opens.

Specify the location to which you want to deliver Lab Service installation files.

Tip: To browse possible locations, click theBrowse button, select a location, and click
OK.

4. Click Next.

5. TheConfirm Installation page opens.

To review or change any settings, click Back.

To accept the settings and start the installation process, click Next.

The HP ALM Lab Service files are installed on your machine.

6. When the installation process completes, the Installation Complete page opens. Click
Finish.

Using HP ALM Lab Service
This task describes how to use HP ALM Lab Service. To run tests from Functional test sets on your
testing hosts using ALM, youmust register your host with ALM using Lab Service.

To learnmore about HP ALM Lab Service, see "HP ALM Lab Service Overview" above.

This task includes the following steps:
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l "Create the Testing Host" below

l "Configure HP ALM Lab Service " below

l "Using HP ALM Lab Service" on previous page

l "Using HP ALM Lab Service" on previous page

1. Create the Testing Host
In ALM or LabManagement, under Lab Resources, select the Hosts/Testing Hosts module.
Click theNew Testing Host button and input your testing host information. The Registration
Status for the new testing host is set toNot Registered.

Note: You can arrange for ALM to automatically approve a testing host registration by
settingRegistration Auto Approve toY.

For task details, see "How toManage Lab Resources" on page 57.

For user interface details, see "New Testing Host Dialog Box" on page 75.

2. Configure HP ALM Lab Service
To configure Lab Service, you need:

n The ALM server URL.

n The dedicatedWindows user name to be used exclusively for running the test on your
testing host.

You can configure Lab Service to communicate with ALM by using the Settings page.

To register Lab Service using the Settings page:

a. Right-click the Lab Service icon in your system tray. Open the Settings page.

b. Provide the ALM server URL and your host user name. For user interface details about the
Settings page, see "HP ALM Lab Service Settings Page" on next page.

c. You can type in amessage to the Lab Administrator in the Host Registration section. Click
Register Host.

d. Refresh the host grid in LabManagement. TheRegistration Status for the new host is set
to Pending.

3. Approve the Host Registration in Lab Management
If you set Registration Auto Approval toY when you created the host, then the registration
will be automatically approved.

If the host is not set to be automatically approved, youmust approve it manually. The host
registration request can be approved from within LabManagement by a Lab Administrator. If
the host was created as a private host from within an ALM project, registration can be approved
from within that project.

Select your host from the grid in the Hosts module, and click theApprove Registration
button. TheRegistration Status changes from Pending toRegistered.
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Your new testing host is registered. You can now schedule and run Functional tests on this
host using ALM.

4. Stop/Start Lab Service
You can start and stop Lab Service using the icon in the taskbar. Right click on the icon and do
one of the following:

n To stop, click Stop ALM Lab Service.

n To start, click Start ALM Lab Service.

Caution:

n Stopping Lab Servicemakes the testing host appear as Non-Operational in Lab
Management. You are not able to run tests using server-side execution on your testing
host until you start it again.

n If you wait too long after stopping Lab Service, ALM stops polling to see if Lab Service
was restarted. Youmust manually set the testing host's Status toOperational in the
Hosts/Testing Hosts grid.

HP ALM Lab Service Settings Page

To access Right click the Lab Service icon on theWindows taskbar and select
Settings.
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Important
information

You can use the Settings page tomanage communication between Lab
Service and the ALM server.

Relevant tasks "Using HP ALM Lab Service" on page 226

See also "HP ALM Lab Service Overview" on page 226

User interface elements are described below:

UI
Elements

Description

ALM Server The URL of the ALM server for communicating with Lab Service.

Host user
name

The name of theWindows user to be used to run the test on this server.

Log
Settings

The directory to which the logs are written. The log records the progress of test
runs andmaintenance tasks.

Host name The host name of the testing host.

Message Themessage sent to the LabManagement administrator.

Register
Host

Registers the testing host with the ALM server.

For more information, see "Using HP ALM Lab Service" on page 226.
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